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Starting Setup
To install Digital Image, you must be running Windows 98, Windows Me, 
Windows 2000, or Windows XP or later. On Windows 2000 and Windows XP 
systems, you must have administrative privileges. For information regarding 
privileges, please refer to the operating system Help. 

On most computers, Digital Image setup will begin automatically when you 
insert the Digital Image CD into your disk drive.

To begin automatic setup:

 1 Turn off any antivirus software that you’re using, and close any programs 
that are running. 

 2 Insert the Digital Image CD into your disk drive. The Installation Wizard 
begins automatically. 

If the above procedure does not start the setup process, you can start it 
manually.

To begin setup manually:

 1 Turn off any antivirus software that you’re using, and close any programs 
that are running.

 2 Insert the Digital Image CD into your disk drive.
 3 Click Start, and then click Run.
 4 If your CD-ROM drive is listed as letter D, type d:\setup.exe.

If your CD-ROM drive has a letter other than D, replace D with the cor-
rect letter when you type the path.

 5 Click OK.
The Installation Wizard begins.
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Completing the Installation Wizard
The Installation Wizard will show you a series of dialog boxes that provide 
setup status and some installation preference options. For most users, the 
default preferences will be appropriate. Information about the different setup 
options is provided below.

Installation Folder Dialog Box
The Installation Folder dialog box allows you to choose where the program will 
be installed on your computer. To install the program to a folder other than the 
folder in the Installation folder box, do one of the following:

 Type a different path in the Installation folder box.
 Click Change, select a folder in the Change Installation Folder dialog 

box, and then click OK.

Note that some files will be installed to the Program Files drive even if you 
choose to install the program to a different drive. 

Installation Options Dialog Box
The Installation Options dialog box allows you to choose between Typical 
installation and Full installation. 

 Typical installation takes up less space on your hard drive, and is recom-
mended for most users. With Typical installation, you will have to insert 
the Digital Image CD in your CD-ROM drive to use some of the projects 
and clip art while you are using the program.

 Full installation copies all of the Digital Image projects and clip art to 
your hard drive, so you will not have to reinsert a Digital Image CD while 
you are using the program. Look under Description for the disk space 
required for this option.
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Special Circumstances

Upgrading from a Different Digital Image Product
If you already have a Digital Image product installed on your machine, any 
of several scenarios may occur when you try to install another Digital Image 
product: 

 Previous versions If you have a Digital Image product previous to 
version 9 already installed, installing a version 9 product will make both 
programs available on your computer.

 Upgrade from another version 9 product You can install a Digital 
Image version 9 product that has more features than a version 9 product 
already installed. The version of Digital Image with fewer features will 
be uninstalled automatically before the new installation begins. Your 
pictures and projects will not be deleted.

 Blocked downgrade If you have a Digital Image version 9 product 
installed, you will not be able to automatically install a version 9 product 
with fewer features. To install the version with fewer features, you must 
first uninstall the version with more features.

Reinstalling or Removing Digital Image 
If you are having problems running Digital Image, reinstalling the program 
may help it to run better on your computer.

Digital Image Suite is made of two separate programs: the image editor and 
the Digital Image Library. These programs must be reinstalled or removed 
separately. 

You should not attempt to remove Digital Image by deleting the program files 
from your hard disk. Instead, use the Digital Image Installation Wizard to 
properly uninstall the program.

Other Digital 
Image Products
The family of Digital 
Image products 
includes programs with 
the following brands:

 Digital Image 

 Greetings

 Greetings Workshop

 Home Publishing

 Picture It!

 Picture It! Express

 Picture It! Photo

 Picture It! Publishing
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To remove or reinstall Digital Image from Windows XP:

 1 Log on to the computer as an administrator.
 2 From the Windows Start menu, click Control Panel.
 3 Click Add or Remove Programs.
 4 From the list of installed programs, click the version of Digital Image you 

want to remove or reinstall. Digital Image and Digital Image Library will 
be listed as separate programs and must be removed separately. 

 5 Click Change/Remove.
The Installation Wizard opens.

 6 Follow the instructions on the screen.

To remove or reinstall Digital Image from Windows 98, Windows 
2000, or Windows Me:

 1 From the Windows Start menu, point to Settings, and then click Control 
Panel.

 2 Click Add/Remove Programs.
 3 From the list of installed programs, click the version of Digital Image you 

want to remove or reinstall.
 4 Click Add/Remove.

The Installation Wizard opens.
 5 Follow the instructions on the screen.
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Congratulations on your purchase of Microsoft Digital Image Suite. This suite 
of programs provides a unique combination of robust photo-editing tools with 
exciting organizing and archiving features. While easy to use, Digital Image 
Suite offers powerful imaging technology that puts you in control of organiz-
ing, editing, and enhancing your photos. 

Digital Image Suite includes both the Digital Image photo editor and the new 
Photo Library organizational and archiving program. Photo Library allows to 
you search by keywords, dates, ratings, and more to help you locate just the pic-
tures you want from your entire collection. Digital Image has advanced editing 
features such as selection tools, Smart Erase, and the blending brush to help you 
get professional editing results quickly and easily. When you’ve finished editing 
your photos, it’s a simple process to create prints or share photos through 
e-mail or the Web. You can even use your photos in one of the professionally 
designed templates for letterhead, business cards, Web photo albums, and more.

What You’ll Find in This Book
The Digital Image User’s Manual introduces you to some important features 
in Digital Image Suite: how to get images into the program, edit images, add 
effects and borders, create projects, and print. You’ll also learn the basics of 
using Digital Image Library: adding keywords to pictures, organizing pictures, 
and archiving. 

This book also provides an overview of some of the most important concepts of 
digital imaging. You’ll find practical information about using digital cameras 
and  scanners, and optimizing your monitor to work with photos.

The final section of this book offers a selection of articles from MSN Photos 
Tips & Tricks, where you’ll find plenty of sound advice from professional 
photographers. 

Other Helpful Resources
This User’s Manual is not an exhaustive resource for everything you can do in 
Digital Image Suite. For step-by-step instructions about all of the program’s 
features and projects, check out the online Help system, available from the 
Startup Window or the Help menu. Or, for a demonstration of some of Digital 
Image Suite’s key features, watch one of the Instructional Videos.

Digital photography is exciting and fun, and Digital Image Suite makes it easy 
to get professional results. We’re confident that Digital Image Suite will be an 
enjoyable part of your digital-imaging experience.
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Digital Image makes it easy to import and open your pictures quickly. To trans-
fer pictures from your camera or storage media to your computer, use the new 
Import Pictures Wizard. This wizard is designed to streamline the file transfer 
process, allowing you to name the destination folder, rename the picture files, 
and add the pictures to Digital Image Library. To open pictures for editing, use 
the file browser. The file browser displays thumbnails of all your pictures, so 
you can quickly choose the ones you want. 

Importing Pictures
The Import Pictures Wizard is a convenient way to transfer pictures and video 
clips from your digital camera or other storage location to your computer. The 
Import Pictures Wizard helps you rename the files so that they have recogniz-
able file names. Also, the Import Pictures Wizard automatically catalogs 
pictures in Digital Image Library.

Launching the Import Pictures Wizard automatically 
Windows Me and Windows XP can automatically detect compatible cameras 
and other photo media such as photo CDs. This detection should occur when 
you:

 Connect a compatible camera to the computer and turn on the camera.
 Connect a compatible card reader to the computer and insert media.
 Insert a photo CD, DVD, or other storage media into a drive on the 

computer.

This automatic detection feature is only available on Windows Me and Win-
dows XP and with WIA and USB Mass Storage class devices.

To set Windows to launch the Import Pictures Wizard automatically:

 1 Connect your compatible camera or device to the computer, and then turn 
on the camera or device.
- or -
Insert the storage media into a drive on the computer.

 2 When Windows detects the picture files, Windows will ask you what you 
want to do with the pictures.

 3 Click Import pictures using Microsoft Digital Image Import Wizard. 
 4 Check Always do the selected action.
 5 Click OK.
 6 Click the device you want to use, and then click OK.

Cataloging 
pictures in the 
Library
See the “Organizing 
and Archiving in Digital 
Image Library” chapter 
to learn more about 
cataloging your pictures 
as you import them.



14 Chapter 3: Opening and Importing Pictures

Microsoft Digital Image Suite User’s Manual

15Chapter 3: Opening and Importing Pictures

Microsoft Digital Image Suite User’s Manual

Starting the Import Pictures Wizard manually
If Windows does not automatically detect your device or other media, you can 
start the Import Pictures Wizard from Digital Image or Digital Image Library.

To start the Import Pictures Wizard manually:

 1 On the File menu, click Import Pictures.
 2 Click the device you want to use, and then click OK.

Opening Pictures for Editing
With Digital Image, you can open pictures for editing from a variety of sources, 
including your computer, storage media, and most cameras and scanners.

Using the file browser
You can use the file browser to locate your photos and open them for editing. 
The file browser can be used to open photos from:

 The hard drive on a computer.
 A digital camera that is a USB Mass Storage Class device. (A USB Mass 

Storage Class device works as a “virtual drive,” letting you browse and 
open photos from the device as you would from a hard disk or floppy 
disk.)

 A digital photo card reader.
 A photo CD or DVD.
 A floppy disk.
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This picture identifies the main features of the file browser:

1 2 3 4

7 8 9 10 11

5 6

 1 All Files tab  Click the All Files tab to view the folder structure on 
your computer. Click a folder to display its contents and subfolders. The 
folder structure includes internal and external drives on your computer, 
including disk drives, card readers, and USB Mass Storage Class digital 
cameras.

 2 Digital Image Library tab  Click the Digital Image Library tab to 
find any picture you have cataloged in the Library. You can also use 
the Library’s View By and Group By features to filter and group your 
pictures, making it easier to find the pictures you want.

 3 MSN Groups tab  Click the MSN Groups tab to open pictures that you 
have stored on MSN Groups.

 4 Look in box  Displays the name of the current folder selected on the All 
Files tab. 

 5 View menu  Use this menu to change the way the image files are 
displayed.

 6 Thumbnail size slider  Move the slider to change the size of the thumb-
nails.

 7 File name box  Displays the file name of a selected thumbnail.
 8 Files of type menu  Use this menu to change the types of image files to 

be displayed.
 9 Thumbnails  Small versions of your photos stored in the current folder.
 10 OK  Opens the selected thumbnails.
 11 Cancel  Closes the file browser without opening any photos.   



16 Chapter 3: Opening and Importing Pictures

Microsoft Digital Image Suite User’s Manual

17Chapter 3: Opening and Importing Pictures

Microsoft Digital Image Suite User’s Manual

To open pictures with the file browser:

 1 If opening pictures from a USB Mass Storage Class camera, read your 
camera’s documentation and make sure that you have installed the 
camera’s software and drivers properly. Make sure your camera is turned 
on and connected to your computer.

 2 On the File menu, click Open.
 3 Click the All Files tab.
 4 In the Look in list, click the drive, folder, or network location that 

contains the picture you want to open.
 5 In the folder list, locate and open the folder or location that contains the 

pictures.
Thumbnails of pictures in that folder appear in the right pane.

 6 Select the picture you want to open. To select multiple pictures, press 
CTRL as you click the thumbnails.

 7 Click Open.

File formats 
compatible with 
Digital Image
Digital Image can open 
photo files in any of the 
following formats:

 Adobe Photoshop 
(.psd)

 AutoCAD (.dxf)

 CorelDraw (.cdr)

 Enhanced Metafile 
(.emf)

 EPS (.eps)

 FlashPix (.fpx)

 GIF (.gif)

 Home Publishing 
(.php)

 JPEG (.jpg)

 Kodak Photo CD 
(.pcd)

 Macintosh PICT (.pct)

 Micrografx Designer 
(.drw)

 PC Paintbrush (.pcx)

 Picture It!/Digital 
Image (.png, .php, 
.mix, .fpx)

 PNG (.png)

 TIFF (.tif)

 Targa (.tga)

 Windows Bitmap 
(.bmp)

 Windows Metafile 
(.wmf)
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Opening pictures from other cameras
If your camera does not show up as a drive in the file browser, it is probably 
designed to work using TWAIN or WIA support. For many cameras, Digital 
Image works with TWAIN and WIA and your camera’s software so that you 
can open photos directly into Digital Image.

To open photos from a camera that uses WIA support:

 1 Make sure that you have installed all the drivers and software that came 
with your camera. 

 2 Connect your digital camera to your computer, and then turn on the 
camera. 

 3 On the File menu, point to Get Picture From, and then click Digital 
Camera. 

 4 Under Select a camera or drive, click a camera.  
 5 To launch the Mini Lab after opening the pictures, click Yes under After 

downloading your pictures, do you want to edit them in Mini Lab.  
 6 Click Automatic Download. 
 7 Click Download. 

The pictures stored on the camera appear in the workspace.
 8 Click Download all pictures.

- or -
To download an individual picture, drag the picture from the workspace 
to the Files palette.

 9 Click Done.

Using your 
camera’s software
Some digital 
cameras—especially 
older models—may not 
function as a virtual 
drive or be TWAIN or 
WIA compliant. For 
these cameras, use 
the software provided 
by the camera to 
download the photos to 
a folder your computer. 
Then open them with 
the file browser.
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To open photos from a camera that uses TWAIN support:

 1 Make sure that you have installed all the drivers and software that came 
with your camera. 

 2 Connect your digital camera to your computer, and then turn on the 
camera. 

 3 On the File menu, point to Get Picture From, and then click Digital 
Camera. 

 4 Under Select a camera or drive, click a camera. 
 5 Click Automatic Download. 
 6 Click Download. 

The pictures stored on the camera appear in the workspace.
 7 Click Download all pictures.

- or -
To download an individual picture, drag the picture from the workspace 
to the Files palette.

 8 Click Done. 

Troubleshooting tips for opening pictures from a camera
 Your camera must be connected and turned on before you start the digital 

camera task, or it will not appear in the list of cameras and drives. 
 If you’ve connected your digital camera to your computer, but can’t see 

your pictures, make sure the connections are secure, the camera is turned 
on, and the batteries are charged. The camera might not start download-
ing unless its batteries are fully charged. Some cameras are equipped 
with an A/C adapter that you can use instead of batteries. 

 If your camera does not appear in the list of cameras and drives, or if you 
receive an error message when you click Download, start your camera 
software from the operating system Start menu. 

 For more information about downloading photos using the software 
included with your camera, consult your camera’s manual. 
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Opening from a scanner
Digital Image supports two types of scanner formats: TWAIN  and WIA. If 
your scanner doesn’t use a TWAIN or WIA interface, you need to use the 
software designed specifically for the make and model of your scanner. Many 
scanner manufacturers provide free updates to their drivers on the Web.

Before you attempt to scan a picture, make sure your scanner is connected 
properly. The first time you connect your scanner, the Identify Scanner Type 
dialog box will open, asking you to identify the type of scanner. 

To connect your scanner

 1 Install the software that came with your scanner. 
 2 Turn off your scanner and computer. 
 3 Attach the connector cable from your scanner to your computer. 
 4 Turn on your scanner and computer. 

Once the scanner is connected and recognized by your computer, you’re ready 
to scan.

To scan a photo with a flatbed TWAIN or WIA scanner:

 1 Connect your scanner to your computer, and then turn on the scanner. 
 2 On the File menu, point to Get Picture From, and then click Scanner. 
 3 Under Select a scanner, select a scanner.  
 4 Place your picture on the scanner. 
 5 Select Automatic Scan.  
 6 To automatically correct brightness and contrast during the scanning 

process, select the Correct brightness and contrast check box. 
 7 Click Scan. 
 8 Click Done.

About TWAIN and 
WIA
TWAIN is interface 
software that allows 
communication 
between a camera and 
your computer. Many 
digital cameras come 
with a TWAIN driver. 

WIA is a newer interface 
that works similarly 
to TWAIN, but often 
provides more control 
over the device. WIA is 
compatible with TWAIN, 
but is only available 
on some computer 
operating systems.
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Opening a Photo Sent Through E-mail
Many friends and family members enjoy sending photos through e-mail. When 
you receive photos through e-mail, you can save them to your computer and 
then work on them with Digital Image. 

Many photos sent through e-mail are low-resolution photos, which are not suit-
able for large prints. But low-resolution photos may be fine for online viewing 
or printing at small sizes.

To open a photo sent through e-mail:

Use your e-mail program to save the photo to a folder on your computer. Save 
the photo to a folder that will be easy for you to locate later, such as the My 
Pictures folder.

 1 In Digital Image, click Open on the File menu.
 2 The File Browser dialog box opens.
 3 Click the All Files tab.
 4 On the All Files tab, browse to the folder containing the photo, and then 

click the folder. 
 5 Select the photo, and then click Open.
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Opening a Picture from a Web Page
When you surf the Internet, you may come across photos and other images that 
you would like to use in your photo projects. You might find photos of celebri-
ties, vacation spots that you want to visit, or graphics that would look good as 
part of one of your photo projects. Unless the Web site uses image protection, 
you can capture these images and use them for your own projects. Web images 
are usually low resolution, so they may not be suitable for printing. But you 
could still use the images in a project to be viewed online.

To capture an image from a Web page, you can drag it from the Web page to the 
Digital Image Files palette.

To open a photo from a Web page:

 1 Make sure that both Digital Image and your Web browser (either Micro-
soft Internet Explorer or MSN Explorer) are open and running on your 
computer. A button for each program appears in the taskbar at the edge of 
your screen.

 2 On the Digital Image File menu, click New.
 3 Select a canvas size, and then click Done.

A blank canvas opens in the workspace.
 4 On the taskbar, click the button for your Web browser program.
 5 In your Web browser, locate the Web page that contains the picture you 

want. 
 6 Right-click the picture, and then click Copy. 
 7 On the taskbar, click the button for Digital Image.
 8 On the Digital Image Edit menu, click Paste.

The new picture appears on the canvas. 

Once the photo is opened in Digital Image, you can edit it as you would any 
other photo and save it to your computer.

Watch for 
copyrights
Pictures you see 
on the Web may be 
copyrighted, so be sure 
to read the site’s legal 
information before you 
use an image.
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This chapter covers some of the fundamental aspects of Digital Image that 
you’ll need to get started. You’ll find information on the Startup Window, the 
work area, basic image manipulation, applying text, and Help resources.  

Startup Window
The Startup Window is a quick launching point to photos, Mini Lab, projects,  
the Library, recently opened files, and Help. 

By default, the Startup Window opens every time you start Digital Image. After 
closing the Startup Window, you can open it at any time from the main work 
area by clicking the Startup Window button in the Common Tasks list. This 
diagram points out the main features of the Startup Window.

1

7 9 108 11

2 3 4 5 6

 1 Open Click the Open button to open the file browser, where you can open 
photos from your hard drive, a network drive, a digital photo card reader, 
a CD or DVD, or a floppy disk.

 2 Open from Camera Click this button to launch the digital camera task, 
so you can open photos from a digital camera using Digital Image or your 
camera’s software.  

 3 Scan a Picture Click this button to launch the Scan Picture task, where 
you can scan a picture directly into Digital Image.

 4 Edit Multiple Pictures Click this button to open the Mini Lab. The Mini 
Lab helps you perform routine editing task—such as rotating, levels auto 
fix, cropping, and saving—on multiple pictures at the same time.  
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 5 Create a Project Click this button to pick a project design. You’ll find 
a variety of projects—such as calendars, greeting cards, and album 
pages—designed to work with your photos. Projects are organized by 
type and by theme. 

 6 Digital Image Library  Click this button to open the Library, where you 
can find and organize your pictures.  

 7 Show on startup Check this box to have the Startup Window open every 
time you start Digital Image. 

 8 Help links  Click these links to go directly to resources that can help you 
get the most out of Digital Image and digital imaging. 
 Take a Tour launches the product Tour. 
 Instructional Videos displays links to the different videos available.
 Help opens the online Help window.
 Online Photo Tips links you directly to the Tips & Tricks section of 

the MSN Photos Web site.
  Register Online links you to the registration page of the Microsoft 

 Web site.

 9 Recent Files See thumbnails of the last four pictures that you have edited. 
Click on one of the thumbnails to open that file.

 10 More Files Click More Files to open the file browser, where you can 
open photos from your hard drive, a network drive, a digital photo card 
reader, a CD or DVD, or a floppy disk. 

 11 Close Click to close the Startup Window and go to the main work area.
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Examining the Work Area 
Most of the photo-editing tasks you perform in Digital Image will be in the 
main work area. When you open Digital Image and close the Startup Window, 
you see the main work area. The picture below identifies the key elements of the 
Digital Image work area.

1
2

3

4

5 6 7 8 9

10

 1 Menus
Menus provide access to all of the Digital Image features. The Help menu 
gives you access to the Help window, the Instructional Videos, and the 
Digital Image Tour.

 2 Toolbar
The toolbar contains shortcut buttons for single-click access to some of 
the most common commands. To see the name of a toolbar button, hover 
the mouse pointer over the button.  

 3 Workspace Toolbar 
This toolbar contains buttons for the Tasks list, Stack, and Files palette. 
You can create more room in the workspace by hiding any of these tools.

 4 Common Tasks list
The Common Tasks list is an easy way to locate features. This list 
provides convenient access to some of the most common tasks, as well 
as single-click access to the Mini Lab, project selector, and the Startup 
Window. All of the features found in the Common Tasks list—as well as 
some additional features—are also available in the menus.
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 5 Workspace
The gray area represents the workspace, the area that the canvas sits 
within. You can use the zoom controls to magnify or reduce the canvas so 
that it covers more or less of the workspace.

 6 Selection Tools
The selection tools allow you to work on a very specific area of an object.

 7 The canvas
The white area is called the canvas, and it represents the printable area of 
the page. When you open a photo, the canvas is often not visible since it is 
covered entirely by the picture. You can use the zoom controls to magnify 
or reduce the canvas so that it covers more or less of the workspace.

 8 Zoom controls
The zoom controls magnify or reduce your photo so that you can see it in 
more or less detail.

 9 Stack
The Stack displays a thumbnail of each object in your picture. You can 
rearrange the order of the objects by dragging a thumbnail up or down 
within the Stack.

 10 Files palette
The Files palette displays a thumbnail of all of the currently open 
pictures. You can switch your active picture by clicking a thumbnail in 
the Files palette. You can also add a picture to the one you’re working on 
by dragging the thumbnail from the Files palette to the canvas.
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Image Formatting
When you have a picture open on the canvas, there are a number of ways to 
re-size it. 

Changing picture size
When you open an image onto the canvas, the image is automatically sized so 
that it fills the workspace. As a result, a high-resolution image, such as 1600 x 
1200 pixels, will look as large as a low-resolution image that’s only 640 x 480 
pixels. For this reason, viewing a picture on the canvas is not a reliable way of 
judging an image’s resolution.

Whenever you resize an image, consider these three factors: 

 Image size, which is the size of the printed image.
 Pixel dimensions, which is how many colored dots (pixels) make up the 

picture.
 Resolution, which is the density of the pixels in the picture.

The pixel dimensions are the product of the image size multiplied by the 
resolution. For example, if you have a picture that is 4" x 6", and its resolution 
is 300 pixels per inch, its pixel dimensions would be 1200 x 1800.  Given this 
relationship, if you change one of the three settings, one of the other settings 
will also have to change to keep the mathematical relationship equal. So if you 
enlarged the picture in the previous example from 4" x 6" to 8" x 12"—and you 
kept the pixel dimensions the same—then the resolution would decrease from 
300 pixels per inch to 150 pixels per inch.

When you resize a picture, it is generally not a good idea to try to increase or 
decrease the pixel dimensions since this reduces image quality. In most cases, 
it’s not necessary to adjust the image size, since that can be handled automati-
cally during printing. For high-quality prints, it’s generally good to keep the 
picture’s resolution at least 300 pixels per inch. But depending on your printer 
model and the image quality you desire, you may be satisfied with prints at 
only 150 pixels per inch. For Web use, 72 pixels per inch is usually considered 
sufficient. 
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To resize a picture:

 1 On the Format menu, click Resize Image.
 2 Click one of the following to lock the setting:

 Image size
 Pixel dimensions
 Resolution 

 3 Enter amounts for the settings you want to change. 
 4 Click Done.
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Applying Text
You can add text to any picture and easily change the text font, font color, font 
size, alignment, and emphasis. You start by adding a text box, and then you edit 
the text in the box. A text box is its own layer on the Stack.

To add text:

 1 On the Text menu, click Insert Text.
A text box appears.

 2 Type your text. As you add text, the text box will automatically expand 
vertically to fit all of your text.

 3 To change the width of the text box, select the text box and drag one of 
the side resize handles.

 4 To move the text box, select it, hover the mouse pointer over the edge 
of the text box until the move handle appears, and then drag the move 
handle.

Once you’ve added the text, you can select the text to edit it. You can also select 
the text and use the toolbar buttons to change formatting. When text is selected, 
the following tools are available on the toolbar for formatting:

 The font menu  lets you choose between 140 different 
fonts.

 The font size menu  lets you choose font sizes from 8 to 620 points.
 The font color button  lets you choose from a standard palette of colors 

or choose a custom color.
 The Bold button  adds bold formatting to the text.
 The Italic button  adds italic formatting to the text.
 The Underline button  underlines the text.
 The Alignment button  has menu choices for Left, Right, Center, and 

Justify.
 The Bullets and Numbers button  lets you apply or cancel formatting 

for bulleted or numbered lists.
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Help Resources
There are multiple ways that you can learn more about using Digital Image. 
In addition to this User’s Manual, there is the online Help system, the product 
Tour, and Instructional Videos. The following sections describe the types of 
information available.

Online Help
Digital Image online Help is the most comprehensive of the Help resources. 
It provides step-by-step instructions, overviews, troubleshooting topics, 
technical support, and the “What’s wrong with this picture” diagnostic tool. 
Help includes several ways to find information, including a table of contents, a 
keyword index, and a full-text search.

This diagram identifies the main features of the Help window.

 1 The Show/Hide button Click this button to expand or collapse the left 
pane of the Help window.

 2 The Back button Click this button to go back to the last Help topic.
 3 The Options menu This menu has options to print a topic or to set 

options such as Internet Options, where you can change the font size in 
the Help window.

 4 The content pane Displays the current Help topic.

Accessing Help 
from the keyboard
You can access the 
online Help system at 
any time by pressing F1 
on the keyboard.
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 5 The close button closes the Help window.
 6 The Contents tab displays the Help table of contents.
 7 The Index tab lets you find keywords in the index list.
 8 The Search tab finds topics that contain words that you enter.
 9 The Favorites tab lets you save topics for quick access later.

To access online Help:

 1 On the Help menu, click Microsoft Digital Image Pro Help.

Using the table of contents
You can use the table of contents to locate information by subject. The table of 
contents is a useful way to see all of the features available in each category of 
features. 

To use the table of contents: 

 1 In the left pane of the Help window, click the Contents tab. 
 2 To expand a book in the contents, click the plus sign next to it. 
 3 To display a topic, in the contents list, click the topic title. 

Using the index
You can use the index when you are looking for information about a specific 
term or keyword. 

To use the index: 

 1 In the left pane of the Help window, click the Index tab. 
 2 In the Type in the keyword to find box, type the word you want to find. 
 3 In the results list, select the word you want to find, and then click Display. 
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Using the search
You can use the search function to find all the topics in Help that contain a word 
or combination of words. 

To use the search: 

 1 In the left pane of the Help window, click the Search tab. 
 2 In the Type in the keyword to find box, type the word for which you 

want to search, and then click List Topics. 
 3 In the Select Topic to display list, select the topic you want to view, and 

then click Display. 

Product Tour
The Digital Image Tour uses pictures and text to demonstrate popular features 
and new features of the program.

To take the product tour:

 1 On the Help menu, click Take A Tour.
The Tour opens, displaying icons to represent different categories of 
features.

 2 Click an icon.
A feature list appears on the left side of the window. 

 3 Click a feature. 
Graphics and text appear that explain the feature.

 4 Repeat steps 2–4 to learn about more features.
 5 To close the Tour, click Close.
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Instructional Videos 
Instructional Videos use animation and narration to show you how to use a 
variety of image editing features on your photos.

To watch an Instructional Video:

 1 On the Help menu, click Instructional Videos.
The Help window opens to a topic about Instructional Videos.

 2 Click a video title link.
The Video player opens and the Video begins. 

The Instructional Videos are accompanied by complete, online tutorials that let 
you walk through the tasks at your own pace. To open the online tutorial, click 
the Written Tutorial button on the Video player.

Technical Support 
The type of Technical Support resources available vary based on where you live 
and how you obtained your Digital Image product. 

To view Technical Support information: 

 1 On the Help menu, click About Microsoft Digital Image Pro 9. 
 2 Click Tech Support. 
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Almost all photos can be improved with basic touchup tools. Digital Image 
touchup tools can be used to correct common photo problems such as red eye, 
crooked pictures, lighting problems or similar distractions that can ruin a photo. 
In many cases, Digital Image helps you eliminate basic problems with just a 
few clicks. 

Adjusting Brightness and Contrast
When you take a photo with an automatic camera, the camera’s automatic 
exposure feature measures the available light and determines how much light 
is required to take the photo. Sometimes, the exposure meter’s measurement 
is slightly too low or too high, creating problems with brightness and contrast 
in the photo. Digital Image provides tools to fix the levels of brightness and 
contrast.

To correct brightness and contrast:

 1 On the Touchup menu, click Brightness and Contrast.
 2 Click Levels auto fix.
 3 If you are not satisfied with the result of the levels auto fix, click Contrast 

auto fix.
 4 If you are not satisfied with the results, fine-tune the settings with the 

Brightness and Contrast sliders.
 5 Click Done.

The picture on the left is both too dark and too low contrast. The Levels auto fix tool was ap-
plied to the version on the right, correcting both the brightness and contrast levels.

Making a copy to 
touch up
Never edit an original 
photo. Always make 
a copy and edit only 
the copy. If you aren’t 
satisfied with the 
results, you can always 
start again by making 
another copy from the 
original.
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Adjusting Tint
When you take photographs, the source of the light can create a colored cast 
in the photo. We tend to think of light being white, but nearly every light 
source has its own unique color. For example, natural sunlight has more blue 
in it, while incandescent (tungsten) lights—including most household light 
bulbs—give off a reddish or yellowish cast. 

When taking a photo, you can compensate for these different colors of light by 
setting the white balance (with a digital camera), or using special filters (on a 
film camera). But if you still end up with a cast in your photos, use the adjust 
tint task to correct the balance of colors to make the lighting look more natural. 
In this task, you locate a point that should be white, and then Digital Image 
balances all of the colors in the picture based on the white point you set.

If you have already used the Levels auto fix tool, the tint problems in the picture 
may already be corrected. Use the adjust tint task to make additional adjust-
ments to the tint.

To adjust tint:

 1 On the Touchup menu, click Adjust Tint.
The mouse pointer becomes an eyedropper.

 2 With the eyedropper, click an area in the picture that should be white.
Digital Image automatically corrects the colors.

 3 If you are not satisfied with the results, use the sliders for fine-tuning. 
Set the Color slider to the color of the cast in the photo, and then use the 
Amount slider to lower the amount of that color in the photo.

 4 Click Done. 

Setting the white 
balance on a 
digital camera
Many digital cameras 
allow you to set the 
white balance for 
specific types of light, 
such as sunlight, 
incandescent, and 
flash. Using this feature 
can help reduce tint 
problems in your 
photos.

Zooming in to find 
white
If there are no 
significant areas of 
white in your photo, use 
the zoom controls to 
magnify the picture on 
the screen. When you 
zoom in, you may be 
able to use a very small 
area of white, such as 
the whites of a person’s 
eyes.
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Fixing Red Eye
Using your flash  in low light situations can give your subjects red, unnatural-
looking eyes. The Fix Red Eye tool darkens the red spots in the eyes to reduce 
or eliminate the redness. 

To fix red eye:

 1 On the Touchup menu, click Fix Red Eye.
 2 Use the pan and zoom controls to magnify your picture and focus on the 

red eyes in the photo.
 3 Click the red part of the eyes. You can click up to two eyes at once.
 4 Click Red-eye auto fix.

The redness in the eyes is removed.
 5 Repeat steps 3 and 4 as necessary.
 6 Click Done.
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Straightening a Picture
If you took a photograph while unintentionally holding the camera at an angle, 
the horizon or other straight lines will appear tilted. This tilt can be a distrac-
tion in the picture, but is easily fixed with the Straighten Picture tool.

The Straighten Picture tool rotates the picture to make the horizon level.

To make the horizon level, the Straighten Picture tool rotates the picture on 
the canvas. When rotated, part of the picture overlaps the edge of the canvas, 
and these areas would be removed during printing. The rotation also creates 
empty areas at the corners of the canvas. Fortunately, these problems are solved 
by the Auto Crop feature which is part of the Straighten Picture tool. After 
you straighten the picture, Auto Crop trims the edges of the picture so that it 
becomes aligned with the canvas.  

To straighten a picture with Auto Crop:

 1 On the Format menu, point to Straighten Picture, and then click 
Canvas.

 2 Identify a line in the picture that should be straight (such as the horizon), 
and then click one end of the line.

 3 Click the other end of the line.
The picture is automatically straightened.

 4 Make sure the Auto Crop check box is selected.
The area of the picture that will be cropped is shown in lightened color 
around the edges.

 5 Click Done.
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Cropping 
Cropping is an easy way to improve the composition of a photograph. For 
example, if your picture has distracting background elements along the top, 
bottom, or side, you can crop away these parts of the background to focus the 
attention on the subject. 

When you crop a photo, you are removing pixels, and therefore lowering the 
effective resolution (although the dots per inch will stay the same). If you crop 
a significant portion of the original, you’re limiting the extent to which you will 
be able to enlarge the picture for printing. This is why it’s better to compose the 
picture as best you can when you take it, rather than relying on heavy cropping 
later.

Cropping a picture allows you to eliminate distractions and improve the composition.

Cropping your picture to a specific proportion lets you control exactly where 
the picture will be cut. Otherwise, if your picture is not the same proportion as 
the print size, some of the picture may be trimmed during printing to fit into the 
printable area of the page. 

Using the rule of thirds
When composing a photograph, many beginning photographers consistently 
center their subject directly in the middle of the frame. While this technique 
may be the easiest way to get the subject in focus with a point-and-shoot 
camera, it is not always the most interesting way to present the subject. 

Most advanced photographers follow the rule of thirds when composing the 
space inside a picture frame. The rule of thirds is used throughout the graphic 
design world, because it helps to create balance between the subject and the 
background. When you compose a picture according to the rule of thirds, you 



44 Chapter 5: Basic Touchup

Microsoft Digital Image Suite User’s Manual

45Chapter 5: Basic Touchup

Microsoft Digital Image Suite User’s Manual

mentally divide the frame into thirds both horizontally and vertically (imagine 
a tic-tac-toe grid), and place the point of interest on one of the four spots where 
the lines intersect. 

If the photo includes a person or animal, you can place the face on one of the 
four points, looking toward the center of the scene. If the photo includes the 
horizon, it should run about one-third from the top or one-third from the bot-
tom, depending on whether the terrain or the sky is the center of focus.

The cropped picture is a more interesting composition because it follows the rule of thirds.

To crop a photo using the rule of thirds: 

 1 On the Format menu, point to Crop, and then click Canvas.
 2 Under Select a proportion, click a proportion.
 3 Select the Show guidelines for the rule of thirds check box.
 4 Click a starting point on your photo, and then drag the outline to the 

opposite corner of the area to be cropped. 
The guidelines show the cropped area divided into thirds vertically and 
horizontally.

 5 Move and resize the cropped area so a focal point in the picture is 
positioned at one of the intersections of the guidelines.

 6 Click Done.
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Using the Adjust Levels Tool
Lighting problems in some photos need more precise adjustment than can be 
achieved with the Levels auto fix or manual brightness and contrast controls. 
To achieve greater control, you can use the adjust levels tool which includes a 
histogram. The histogram is a visual representation of the photo’s tonal range, 
or the distribution of the pixels across the 256 degrees of brightness. 

In the histogram, pictured below, the horizontal axis represents the range 
from the darkest pixels (shadows) on the left to the lightest pixels (highlights) 
on the right. For each point in the range along the horizontal axis, the height 
of the graph represents the percentage of pixels at that degree of brightness. 
The example below shows the histogram of a photo that has a concentration 
of pixels between the shadows and the midtones, with very few pixels at the 
lighter end of the range. An image with a histogram like this would look very 
dark and have poor contrast.

For most photos, it’s best to have a fairly even distribution across the tonal 
range, so there is contrast between the light and dark areas. The following 
histogram example has the tones much more evenly distributed.

If you are not satisfied with the results of the manual brightness and contrast 
controls, use the manual sliders in the adjust levels tool for more precise 
control. This photo is a good candidate for using the adjust levels tool:
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When you look at the histogram, you can see that the graph falls off on each 
end of the range well before the Shadows and Highlights bars. This means that 
there are neither any very dark pixels nor very light pixels in the photo. By 
adjusting the levels, you can broaden the tonal range to make the photo more 
dynamic. This is accomplished by dragging the Shadows and Highlights sliders 
to the first vertical rises in the graph. 
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These adjustments add greater contrast to the image by using a greater percent-
age of the 256 available tones. 

The Midtones slider is also available to fine tune the brightness and contrast 
of the midtones. You can make the midtones brighter by dragging the midtones 
slider to the right, or make the midtones darker by dragging the midtones slider 
to the left.
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To adjust levels using the histogram:

 1 On the Touchup menu, click Adjust levels.
 2 Drag the Shadows slider to the right until the vertical shadows bar on the 

histogram meets the first vertical rise of the graph.
 3 Drag the Highlights slider to the left until the vertical highlights bar on 

the histogram meets the first vertical rise of the graph.
 4 If the midtones need adjustment, do one of the following:

 To lighten the midtones, drag the Midtones slider to the left.
 To darken the midtones, drag the Midtones slider to the right.

 5 To make adjustments to a specific color channel, click a channel in the 
Channel drop-down list, and then use the sliders to make adjustments to 
that channel.

 6 Click Done.
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Using Smart Erase
The Smart Erase tool helps you remove distractions from pictures. Smart Erase 
can remove items such as telephone poles, power lines, or even strangers in the 
background. In addition to removing the unwanted element, Smart Erase fills 
in the area with colors and patterns from the surrounding areas. In many cases, 
Smart Erase makes it hard to tell that the distraction was ever there.

With the consistently patterned background in this picture, Smart Erase was able to do a 
smooth job filling in the area over the distraction.

Since Smart Erase incorporates pixels from surrounding areas to fill in the 
area that has been removed, the tool works best if the surrounding areas are 
consistently patterned. 

To use Smart Erase:

 1 On the Touchup menu, click Smart Erase.
 2 Trace around the area you want to fill, releasing the pointer on the spot 

where you began tracing.
 3 Click Fill in.
 4 To fill in additional areas, repeat steps 2 and 3. 
 5 Click Done.   

Using Smart Erase 
with the clone 
brush
If you don’t get perfect 
results right away 
with Smart Erase, 
you can use the clone 
brush to clean up the 
background to make 
it look more natural. 
Learn more about 
the clone brush in 
the “Advanced Photo 
Editing” chapter.
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Removing Spots and Blemishes 
Whether you take portrait photographs or just informal snapshots, you usually 
want to present your subjects in a flattering light. Many photos of people can 
be enhanced by removing spots or blemishes from the original photo. In the 
remove spots or blemishes task, you click the spot or blemish, and the color 
from the surrounding pixels is used to paint over the discolored area. 

This task is also useful for removing isolated specs of dust from a scanned 
photo, or removing any other spots that detract from the photo. 

With a few clicks of the Remove Spots or Blemishes tool, the blemishes disappear from the 
picture.

To remove a spot or blemish:

 1 On the Touchup menu, click Remove Spots or Blemishes.
 2 Zoom in on a spot or blemish.
 3 To remove the spot or blemish, click it.
 4 Click Done.
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Removing Wrinkles
As with removing spots and blemishes, removing wrinkles is a good way 
to enhance photos that contain close-ups of people. You can make skin look 
smoother by removing crow’s feet around the eyes or other wrinkles on the 
face. The remove wrinkle tool works by covering lines with the color of the 
surrounding pixels.

The remove wrinkle tool was used on the picture on the right, eliminating wrinkles around the 
eyes to make a more flattering portrait.

To remove wrinkles:

 1 On the Touchup menu, point to Other Photo Repair, and then click 
Remove Wrinkles.

 2 Click a circle that corresponds to the size of the wrinkle you want to 
remove.

 3 Click the picture at one end of the wrinkle, and then click at the other end 
of the wrinkle.
The wrinkle disappears.

 4 Repeat step 3 to remove other wrinkles in the photo.
 5 Click Done.

Removing curved 
wrinkles
The remove wrinkle 
tool can be used to 
remove curved as well 
as straight wrinkles. 
For curved wrinkles, 
break the wrinkle into 
sections and correct 
just one section at a 
time. This might give 
you better results than 
using a wider circle.
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Adding Flash
In some lighting conditions, such as when the sun is low in the sky behind your 
subject, your subject will be very dark compared to the light in the background. 
Ideally, you could use your camera’s flash for this situation, illuminating your 
subject as you take the photo. But if you forget to turn on your flash, or if your 
subject is out of your flash’s range, your subject may come out too dark in the 
photo. 

In this situation, you can use the Digital Image add flash feature to lighten the 
dark parts of your photo, improving the exposure by imitating the light of a 
camera flash. The add flash feature works by lightening the darkest pixels in 
your picture and also slightly increasing the contrast.

When the picture on the left was taken, the boats were out of the flash’s range, so the whole 
foreground ended up in dark shadow. The add flash tool was used in the picture on the right to 
lighten the foreground and bring out the detail.

To add flash to a photo:

 1 On the Touchup menu, click Adjust Lighting.
 2 Under Add Flash, drag the slider to the right to add as much flash as you 

want.
 3 Click Done.

Fine tuning the 
lighting
If you need to make 
further adjustments 
after adding flash, you 
can use the brightness 
and contrast or adjust 
levels tools.
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Reducing Backlighting
In some photos, the subject may be properly exposed, but parts of the back-
ground may be overexposed, where some areas are “blown out,” meaning the 
tonal range of the photo is not wide enough to show the differences in the top 
range of lightly colored pixels. The reduce backlighting feature darkens the 
lightest pixels, minimizing the “blown out” look.

The picture on the left lacks detail in the bright areas of the clouds, diminishing the beauty of 
the sky. In the picture on the right, the reduce backlighting tool was applied, which darkens the 
lighter pixels.

To reduce backlighting in a photo:

 1 On the Touchup menu, click Adjust Lighting.
 2 Under Reduce Backlighting, drag the slider to the right to reduce as 

much backlighting as you want.
 3 Click Done.

Fixing severe 
lighting problems
If the lighting problems 
in your photos are too 
severe to be repaired 
by using the adjust 
lighting features, use 
the selection tools to 
select the darkest area 
of the photo. Then try 
adjusting the lighting 
just to the selected 
area.
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After you have done general touch ups to your pictures, you may want to use 
advanced editing tools for more precise editing or to apply special effects. The 
selection tools and multiple-object composites give you the power to edit very 
specific areas of your pictures. You’ll also be able to transform your pictures 
with filters, color and edge effects, and specialized editing brushes. 

Understanding Objects
For many advanced photo-editing tasks, you’ll need to understand the concept 
of objects. An object is a part of a picture that can be edited individually. For 
example, when you add text to a picture, the text is a separate object from 
the background image. When you edit the text—say, making the font color 
red—the background picture remains unchanged because it is a separate object. 

Working with Composites
A picture that contains multiple objects is called a composite. The Stack helps 
you work with composites by displaying each object separately. Using the 
Stack, you can easily select any object. Make sure the Stack is showing in the 
workspace when you are working with composites.

To show the Stack:

 1 On the View menu, click Stack. 

On the Stack, you’ll see a thumbnail representation of each object in the 
composite. The top thumbnail represents the object that is the top layer in the 
composite. The bottom thumbnail represents the background object in the 
composite. Thus, the object that is lowest in the Stack may be at least partially 
obscured in the composite by the objects on top of it.

You can change the order of the objects in the composite by dragging thumb-
nails up and down the Stack. For example, dragging an object’s thumbnail 
from the lowest position on the Stack to the top position will bring it to the 
foreground of the composite.
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Locked Objects
When you open any single-object picture, such as a picture you took with your 
digital camera, the picture will, by default, be locked to its position on the 
canvas. When an object is locked to the canvas, the lock icon  is shown next 
to that object’s thumbnail on the Stack. This lock icon indicates that you will 
not be able to drag the object around on the canvas. 

To lock or unlock an object:

 1 Right-click the object’s thumbnail on the Stack.
 2 Click Lock or Unlock.



58 Chapter 6: Advanced Photo Editing

Microsoft Digital Image Suite User’s Manual

59Chapter 6: Advanced Photo Editing

Microsoft Digital Image Suite User’s Manual

Selecting Objects with the Object Tool
The object tool  allows you to select one or more whole objects at a time. 
With the object tool, you can move, resize, and rotate selected objects by drag-
ging the object on the canvas or using the resize handles.  

Each time you start Digital Image, the object tool will be selected by default. 
You will be able to accomplish many different editing tasks by using the object 
tool as your only selection tool. Unlike the other selection tools, the object tool 
does not have an options palette.

To select an object with the object tool:

 1 Make sure that the Stack appears in the workspace.
 2 Click the object tool  button on the toolbar.
 3 On the Stack, click the object.

When an object is selected with the object tool and not locked to the canvas, 
object handles are displayed around the perimeter of the selection. Object 
handles are yellow circles that you can drag to resize and rotate the object.

To move, resize, or rotate an object with the object tool:

 1 Select the object with the object tool as described above.
 2 If the selected thumbnail has the lock icon  displayed, right-click the 

thumbnail, and then click Unlock.
 3 To move the selection, hold the cursor over the object until the move 

handle  appears, and then drag the object on the canvas.
 4 To resize the object proportionally, hold the cursor over one of the corner 

object handles until the resize handle  appears, and then drag the resize 
handle.

 5 To stretch the object, hold the cursor over the top, bottom, or side object 
handles until the resize handle appears, and then drag the resize handle.

 6 To rotate the object, drag the rotate handle  that is attached to the top of 
the selection box.

Selecting an object allows you to edit it without affecting other objects on the 
canvas. You can select an object by clicking it, either on the canvas or on the 
Stack. If you want to select a small object or one that is hidden behind other 
objects, it is often easiest to select it on the Stack. 
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Multiple Selection, Grouping, and Flattening 
Objects
Digital Image allows you to create composites that contain many objects. While 
objects are separate, you can edit each one individually. However, sometimes 
you may want to edit two or more objects at the same time. There are three 
methods to join objects so that you can edit them together. From least perma-
nent to most permanent, the three methods for combining objects are multiple 
selection, grouping, and flattening. 

Multiple Selection
Multiple selection links objects temporarily. For example, if you wanted to 
move three objects the same amount to the left, you could select the objects, and 
then drag them together on the canvas. Then, as soon as you select a different 
object to work on, the multiple-selected objects are no longer connected.

These three objects are a multiple selection, so they can be edited as a set and then 
separated later.

To multiple select objects:

 1 Make sure that the Stack is showing. 
 2 Pressing CTRL, click each thumbnail on the Stack.

The objects become multiple selected.
 3 To cancel the multiple selection, click any single object in the Stack.
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Grouping Objects
Grouping objects allows you to edit multiple objects and then maintain the 
grouped relationship while you do other tasks. The grouping relationship 
is even preserved when you close a picture file saved in PNG Plus format. 
Grouped objects can later be ungrouped and edited individually.

These three objects have been grouped, as indicated by the group icon at the bottom of the 
selection box.

To group objects:

 1 Make sure that the Stack appears in the workspace. 
 2 Pressing CTRL, click each thumbnail on the Stack.

The objects become multiple selected.
 3 On the Edit menu, click Group. 
 4 To cancel the group, click the group on the Stack, and then on the Edit 

menu, click Ungroup.
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Flattening Objects
Flattening objects is a permanent action. If you will no longer need to edit 
objects individually, you can flatten objects into a single object. This allows 
you to work on the objects together and reduce the number of objects in your 
composite. Also, many editing tasks cannot be performed on a multiple selec-
tion. But if you flatten the objects together, they become a single object, so you 
will be able to edit them together.

To flatten multiple objects:

 1 Make sure that the Stack appears in the workspace. 
 2 Pressing CTRL, click each thumbnail on the Stack.
 3 On the Edit menu, click Flatten Selected Objects.

Automatic Flattening
When working with objects that are multiple-selected or grouped, some editing 
tasks—such as using advanced selection tools—will automatically flatten the 
selected objects into a single object. Digital Image will give you a warning 
message whenever two or more objects will need to be flattened to perform an 
editing function. When you see a warning message about flattening, you can 
click Cancel to prevent the objects from being flattened. 

Flattening Objects During Saving
When you save a composite picture in the PNG Plus file format, each object 
is preserved separately. When you open the file again, you can edit each 
individual object.

However, most file formats for images do not support multiple objects. So if you 
save a picture in the JPEG format, for example, all the objects will be flattened 
into a single object. Even if you open such a JPEG file in Digital Image, you 
will not be able to edit objects individually.
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Using Selection Tools
New in this version of Digital Image are the selection tools, which give you 
more control and more options for editing images. Selection tools allow you to 
fix problems that exist in only part of the picture. You can also use selection 
tools to create new objects that can be duplicated or pasted onto other pictures.

Selection tools help you to isolate any part of a larger picture, which enables 
you to:

 Turn part of a picture into a separate object.
 Apply filters or other effects to a limited area of a picture.
 Duplicate part of an image within a picture.
 Combine parts from two or more pictures.

The selection tools are located on the toolbar next to the Selection options 
button. There are five selection tools available, and each one works well for a 
specific editing scenario. Select the method that best fits your picture and your 
intended use. In addition to the object tool mentioned above, the other four 
selection tools are:

 Marquee tool
 Freehand tool
 Edge Finder
 Magic Wand
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The Marquee Tool
The marquee tool  helps you select part of an object in the shape of a rect-
angle, circle, or other shape. This tool is useful for cropping objects or pictures 
to a standard shape.

To make a selection with the marquee tool:

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 On the toolbar, click the marquee tool button .
 4 If the Marquee Tool options palette is not visible in the workspace, click 

the Selection button on the toolbar. 
 5 To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Marquee Tool options palette.
 6 On the Marquee Tool options palette, click a shape for the marquee 

selection. 
 7 To keep the marquee shape in a specific proportion, click Shape propor-

tions on the Marquee Tool options palette, and then enter a height and 
width.

 8 On the Marquee Tool options palette, choose whether you want to make 
a new selection , add to the current selection , or subtract from the 
current selection .

 9 Drag the marquee pointer diagonally across the area you want to select.
 10 To adjust the selection shape, click Adjust marquee on the Marquee 

Tool options palette, resize or rotate the marquee shape, and then click 
Done.

 11 To feather the selection, click Feather on the Marquee Tool options 
palette, enter the number of pixels that you want feathered around the 
edge, and then click OK.

 12 To select the opposite area, click Invert on the Marquee Tool options 
palette.

Anti-aliasing a 
selection
Anti-aliasing means 
that pixels on the edge 
of the selection can 
be partially selected. 
This technique helps to 
smooth the transition 
between the selection 
and the surrounding 
area. Anti-aliasing is 
useful when creating 
composites.

Feathering a 
selection
Like anti-aliasing, 
feathering a selection 
helps to smooth its 
edges. But where anti-
aliasing only affects 
pixels directly on the 
selection border, you 
can feather a border 
of up to 250 pixels 
around the edge of the 
selected area. 
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The Freehand Tool
The freehand tool  helps you select part of an object by drawing an irregu-
lar shape. 

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 Click the freehand tool  button on the toolbar.
 4 If the Freehand Tool options palette is not showing, click the Selection 

button on the toolbar. 
 5 To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Freehand Tool options palette.
 6 On the Freehand Tool options palette, click whether you want to make 

a new selection , add to the current selection , or subtract from the 
current selection .

 7 On the picture, drag the pointer, and then click the starting point to 
complete the selection. 

 8 To feather the selection, click Feather on the Freehand Tool options 
palette, enter the number of pixels that you want feathered around the 
edge, and then click OK.

 9 To select the opposite area, click Invert on the Freehand Tool options 
palette.
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The Edge Finder
The Edge Finder  helps you select part of an object by tracing along well-
defined edges. This tool is useful for cutting out or copying people or detailed 
items in a picture. 

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 Click the Edge Finder  button on the toolbar.
 4 If the Edge Finder options palette is not showing, click the Selection 

button on the toolbar. 
 5 To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Edge Finder options palette.
 6 On the Edge Finder options palette, click whether you want to make a 

new selection , add to the current selection , or subtract from the 
current selection .

 7 On the Edge Finder options palette, enter a value in the Width box. The 
Width is the number of pixels away from the pointer that the Edge Finder 
will try to detect an edge. 

 8 On the picture, click points along the edge of the item you want to select. 
As you trace, make sure that the edge stays within the zone of the Edge 
Finder.

 9 To close the selection area, click the starting point.
 10 To modify the selection, click Adjust edges, drag any point in the selec-

tion marked by a square, and then click Done.
 11 To feather the selection, click Feather on the Edge Finder options pal-

ette, enter the number of pixels that you want feathered around the edge, 
and then click OK.

 12 To select the opposite area, click Invert on the Edge Finder options 
palette.
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The Magic Wand
The Magic Wand  lets you select parts of an object that are the same or 
similar colors. The Magic Wand is useful for selecting a consistently colored 
area—a blue sky, for example—without having to trace around it. 

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 Click the Magic Wand  button on the toolbar.
 4 If the Magic Wand options palette is not showing, click the Selection 

button on the toolbar. 
 5 To select only similarly-colored pixels that are connected to each other, 

select the Contiguous check box.
 6 On the Magic Wand options palette, enter a value in the Tolerance box. 

The Tolerance is the range of colors that will be included in the selection. 
 7 On the Magic Wand options palette, click whether you want to make a 

new selection , add to the current selection , or subtract from the 
current selection .

 8 On the picture, click the color you want to select. 
 9 If the selection has includes too much or too little of the area you want 

to select, enter a different value in the Tolerance box, and then make 
another selection.

 10 To feather the selection, click Feather on the Magic Wand options 
palette, enter the number of pixels that you want feathered around the 
edge, and then click OK.

 11 To select the opposite area, click Invert on the Magic Wand options 
palette.
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Editing and Copying Selected Areas
Using the advanced selection tools helps you to isolate a very specific area of 
a picture for editing or copying. For example, if a picture has generally good 
lighting levels, but a person’s face in the picture is in dark shadows, you can 
make a selection of just the face, and then adjust the brightness and contrast 
only in the selected area. And with anti-aliasing and feathering the selection, 
your edits to the selected area can look natural since the edited area will blend 
smoothly with the surrounding pixels. 

Copying, Cutting, and Pasting Selections
Advanced selection tools also allow you to cut out or copy part of an object 
to create a new object. These techniques allow you to trim a hole in a picture 
or create a new object that can be pasted in the same picture or in a different 
picture. 

To cut a hole in an object:

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object you want to cut a hole in.
 3 On the toolbar, click a selection tool, and then select part of the object.
 4 On the Edit menu, click Cut.

To copy and paste part of an object:

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object you want to copy part of.
 3 On the toolbar, click a selection tool, and then select part of the object.
 4 On the Edit menu, click Copy.

The selection is copied to the clipboard.
 5 If you want to paste the selection onto a different picture, open that 

picture so that it is on the canvas.
 6 On the Edit menu, click Paste.

The selection becomes a new object on the Stack.

Note: If you paste the selection onto the same picture that you copied it from, 
the new object will be in the same position and may not look like a separate 
object. But the new object will be visible on the Stack, and you can use the 
object tool to move, resize, or rotate the new object.
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Filters
The term filter originates from the colored glass covers placed over a camera 
lens. The first filters in digital imaging sought to mimic the results of these 
physical camera filters, providing a slight shift in color, or increasing the 
intensity of colors. But the filters in Digital Image can create many other 
effects, from sharpening an image to making the picture look like a painting or 
a mosaic.

Three different filters were used on the original picture (upper left): The colored pencil filter 
(upper right); the watercolor filter (lower left); and the film grain filter (lower right). 

To apply a filter:

 1 On the Effects menu, point to Filters, and then click a filter.

Filters create a whole new look for your pictures. Many filters make the image 
look less like a photograph and more like a drawing, painting, mosaic, or other 
hand-created artwork. Filter-enhanced pictures can become an attractive focal 
point of projects such as greeting cards and calendars. 

More filters, more 
control
On the Effects menu, 
if you point to Filters, 
and then click All 
Filters, you will see 
the complete selection 
of filters available. 
You can also change 
advanced options and 
control settings such as 
filter transparency and 
pressure. 

Using plug-in 
filters
In addition to over 
200 standard filters in 
Digital Image, you can 
also use Photoshop-
compatible plug-in 
filters, available from 
many third-party 
companies at retail 
stores and on the Web.
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Color Effects 
You can give a color picture a new look by applying a color effect. Turn a 
favorite color picture into an instant classic by changing it to black and white. 
Or, apply the antique effect, which “ages” your picture by giving it a sepia tone.

To turn a color picture to black and white or antique:

 1 On the Effects menu, click one of the following:
 Antique

  Black and White
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Paint Effects 
With the freehand paint brush, you can choose from several painting tools: 

 Paint brush
 Airbrush
 Pencil
 Eraser
 Highlighter 
 Chalk

Use these tools to add new colors to a picture.

To use the freehand paint brush:

 1 On the Effects menu, point to Paint Brush, and then click Freehand.
 2 Click a painting tool, and then click a color.
 3 Click a brush size, and then paint by dragging on the picture.
 4 Click Done.

You can paint with stamps to enliven your pictures with a rubber stamp effect, 
Choose from a variety of stamp designs or make your own. Paint with a single 
stamp design, or use multiple stamps on the same picture.

You can choose from a wide variety of stamps to customize any picture.
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To paint with stamps:

 1 On the Effects menu, point to Paint Brush, and then click Stamps.
 2 Click a stamping style, and then click a stamp.
 3 Click a stamp size, and then apply the stamp by clicking on the picture.
 4 Click Done.
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Clone Brush
The clone brush is a sophisticated editing tool that allows you to paint with a 
sample from another part of the image. Unlike the airbrush tool that paints in 
a solid color, the clone brush allows you to paint gradations of color or varied  
textures. 

The clone brush works very well when touching up a face or an area of skin. 
For example, you can paint over a blemish with an area of clear skin copied 
from another part of the face or body. Similarly, you can use the clone brush to 
cover up distractions in the background of your picture. For example, you could 
paint over power lines with a matching gradient of color sampled from a clear 
area of the sky. 

The original picture on the left contained some trees in the lower-right corner of the frame. The 
clone brush was used to cover the trees with a sample from a clear area of the sky.

To use the clone brush:

 1 On the Stack, click the object you want to touch up.
 2 On the Touchup menu, click Clone Brush.
 3 Click a brush size.
 4 On your picture, click the spot from which you want to copy.

This spot—called the start position—is marked with a cross-hair while 
you paint.

 5 Move the circular pointer to the position you want to paint over.
 6 Drag the circular pointer to paint. As you paint, keep an eye on the cross-

hair so that you don’t copy unwanted areas.
 7 Click Done.

Cloning from a 
different layer
When using the clone 
brush, your starting 
point must be in the 
same object as where 
you want to paint. To 
clone from one object 
to another, first group 
the objects. 
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Blending Brush
The blending brush works similarly to the clone brush, but can give you a more 
subtle, smoother effect. Like the clone brush, you select an area to sample from. 
But when the sampled area is applied to the new area, the colors are blended in 
with the colors of the surrounding area. The blending brush works very well for 
touching up skin.

For touching up skin, the blending brush lets you cover up blemishes with colors and patterns 
from clear areas of skin.

 1 On the Stack, click the object you want to touch up.
 2 On the Touchup menu, click Blending Brush.
 3 Click a brush size.
 4 On your picture, click the spot from which you want to copy.

This spot—called the start position—is marked with a cross-hair while 
you paint.

 5 Move the circular pointer to the position where you want to paint with the 
blending brush.

 6 Drag the circular pointer to paint. As you paint, keep an eye on the cross-
hair so that you don’t copy unwanted areas.

 7 Click Done.



74 Chapter 6: Advanced Photo Editing

Microsoft Digital Image Suite User’s Manual

75Chapter 6: Advanced Photo Editing

Microsoft Digital Image Suite User’s Manual

Distortion Brush
The distortion brush tool lets you smear, bulge, shrink, or erase part of the 
picture. When touching up a picture, you can use the distortion brush to dimin-
ish or accentuate certain features in the picture. 

The distortion brush can be used to make some funny or whimsical images.

To use the distortion brush:

 1 On the Stack, click the object you want to touch up.
 2 On the Effects menu, click Distortion Brush.
 3 Click an effect, and then click a brush size.
 4 Do one of the following:

 Click on the picture to distort inside the circular brush area.
 Drag on the picture to distort a wider area. 

 5 Click Done.

Freeing up 
memory
The distortion brush 
requires a lot of 
computer memory, 
especially if you 
drag it across a wide 
area. To speed up 
the processing of 
the effect, try closing 
other applications you 
have running on your 
computer.  
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If you take photos regularly, it can become time consuming to perform basic 
editing to all of your pictures after you download them from your camera. Mini 
Lab contains tools that can help you save time with routine editing that needs to 
be done to many or all of the photos in a batch.

If you have a high-capacity storage medium in your camera, you may have 
dozens or more photos to download at once to your hard disk. Some of these 
photos may be excellent “keepers” that you will want to spend some time 
editing carefully later on. But many of the photos only need a few quick edits: 
changes such as rotation and removal of red eye. 

Opening each photo individually, performing basic edits, and then saving each 
one could take a lot of time. Mini Lab lets you perform these routine editing 
tasks to many photos at once. Mini Lab lets you select multiple photos to 
perform the following tasks:

 Levels auto fix
 Contrast auto fix
 Tint auto fix
 Rotate 
 Crop
 Brightness and contrast
 Fix red eye
 Save as (to save copies of the originals, change file format, and rename 

files)
 Print
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Mini Lab displays all of your open photos and includes a list of editing options 
that you can perform on multiple photos. This diagram identifies the main 
features of Mini Lab.

 1 The Open more files button opens the file browser to let you find more 
pictures to edit.

 2 The editing options list shows all of the tasks available for batch editing.
 3 File options let you save or print multiple photos.
 4 The Workspace in Mini Lab contains thumbnails of all of your opened 

pictures.
 5 The Done button closes Mini Lab, keeping the photos open and maintain-

ing the changes you have made. To save photos before leaving Mini Lab, 
select the thumbnails and click Save before you click Done.

 6 The Cancel button closes Mini Lab, undoing any unsaved changes.
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To open Mini Lab from Digital Image:

 1 On the Touchup menu, click Batch Edit in Mini Lab.

To open Mini Lab from the Library:

 1 In the Thumbnail pane, select the pictures you want to edit.
 2 On the Tasks menu, click Batch Edit.

After you open Mini Lab, select the photos you want to edit, and then click one 
or more editing tasks. Some of the batch editing tasks (Levels auto fix, contrast 
auto fix, tint auto fix, rotate clockwise, and rotate counterclockwise) will be 
performed to all of the selected photos at once. The other editing tasks, such as 
cropping, let you set your preferences for each picture.

Mini Lab does not automatically save your batch edits. To save your pictures, 
you can select photos and click Save. If you click Done to leave Mini Lab 
without saving, the edits will not be saved. 
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When you’ve finished editing a photo, you can add polishing touches by sur-
rounding it with an edge, a border, a mat, or a frame. 

Edge Effects
Edge effects alter the outside edge of a photo. For portrait photos, try the soft 
edge effect. To draw attention to photos that you post on a Web site, try apply-
ing one of the highlighted edges.

The photo on the left has highlighted edges applied, which work great for photos on the Web 
and in e-mail. The photo on the right has been enhanced with soft edges.

To add an edge effect:

 1 On the Stack, click the layer to which you want to add the edge effect.
 2 On the Effects menu, point to Edges, and then click an edge effect or 

border.
 3 If available, click a specific edge or border.
 4 Follow the instructions on the screen to customize the size or color of the 

edge or border.
 5 Click Done.

Shrinking a picture 
to show the edge 
effect
Some edge effects 
appear only behind and 
outside the picture. So 
if your picture reaches 
the edge of the canvas, 
you might not be able 
to see the edge effect 
when you print it or 
save it to the Web. 

To make sure you can 
see an edge you’ve 
added, make sure the 
object is not locked to 
the canvas, and then 
the press the CTRL key 
while you drag in one 
of the photo’s corner 
resize handles. This 
will shrink the photo 
proportionally on the 
canvas, so that the 
border lies within the 
printable area.
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Mats and Frames
If you plan to put a photo in a traditional photo frame, you can add a Digital 
Image mat to your photo before you print it. Mats create an elegant effect, and 
can also help to fit an oddly-proportioned print to a standard size frame. 

If you don’t plan to mount a photo in a traditional frame, but would like to 
print and display it, use a Digital Image frame instead. You can choose from a 
variety of frame themes to complement the subject of your photo. You can even 
add both a mat and a frame to the same photo.

Digital Image has a wide variety of mats and frames to finish your favorite photos.

To add a mat or a frame:

 1 Select the picture or object to which you want to add a mat or frame.
 2 On the Effects menu, point to Edges, and then click Frames and Mats.
 3 Click a theme, click a design, and then click Open.
 4 Drag your photo from the Files palette into the frame or mat, and then 

click Next.
 5 Move or resize the photo so that it fits within the frame, and then click 

Done.

Choosing the right 
mat
When choosing a 
mat, consider the 
colors in your photo 
and the colors of your 
frame. A mat should 
not overpower the 
subject of the photo. Try 
selecting a soft-colored 
mat that matches 
one of the photo’s 
secondary colors. 
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A great way to present your pictures and share them with friends and family 
is to create photo projects. Digital Image offers a range of designs that you can 
use to showcase your pictures. Choose from greeting cards, calendars, business 
cards, and more.

Creating Photo Cards
Use your own photo to personalize a greeting card for a holiday, a party invita-
tion, or any other occasion. 

To open a photo card design:

 1 Open a photo and check to see that it appears on the Files palette.
 2 On the File menu, click Create a Project.
 3 On the All Types of Designs page, click Cards.
 4 Click Photo Frame Cards.
 5 Click a theme, click a design, and then click Open.
 6 Follow the instructions on the screen. 
 7 To edit the inside pages, on the View menu, click Front of Card, Inside 

of Card, or Back of Card.  

Once your card project is open, you can add your own text, photos, and clip art. 
Since most printers cannot print to the edge of the page, the purple margins on 
the edges of a card project represent the unprintable areas of the card.

Photo cards are either half-fold cards, which are larger cards printed on both 
sides of the paper, or quarter-fold cards, which are smaller cards printed on only 
one side of the paper. 

A favorite golfing photo was used to create this half-fold card.

Working with a 
multi-page project
When working with a 
project that has more 
than one page, such 
as a greeting card, 
the multi-page palette 
appears on the bottom 
of the screen. This 
palette lets you switch 
between pages in the 
project. 
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To change the fold style of a card:

 1 On the Format menu, click Change Card Fold.
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Creating Calendars
Calendars are a great way to showcase your favorite photos. Calendar projects 
are available in the following formats: 

A one-week calendar A one-year calendar

A one-month calendar

The first three months of a 12-month calendar
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To create a calendar project:

 1 On the File menu, click Create a Project.
 2 Click Calendars.
 3 Click a calendar type.
 4 Click a theme, click a design, and then click Open.
 5 Set the start date for the calendar, and then click Next.
 6 Follow the instructions on the screen to add a photo to your calendar, and 

then click Next.
 7 Move or resize your photo on the calendar. Use the corner resize handles 

to resize the photo proportionally.
 8 Click Done.

When you create a 12-month calendar, you can add different photos to each of 
the 12 month pages.

To complete a 12-month calendar:

 1 Complete the instructions above to create a 12-month calendar.
 2 Open the photos you want so that they appear in the Files palette.
 3 Use the multi-page palette to switch between pages in the project. 
 4 Drag photos from the Files palette into each of the 12 month pages.
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Saving Pictures
If you’re like most people, you can’t stand to throw photos away, even if they’re 
imperfect. You probably have a large box or two filled with envelopes of old 
negatives and photographic prints. Keeping track of all of your old prints and 
negatives can be a formidable task. 

Fortunately, digital photography makes saving, storing, and organizing photos 
much easier. However, there are some important things you should know about 
saving your photos to make sure they’ll be in good condition whenever you 
want to enjoy them.  

Saving Multiple Versions
Once you’ve downloaded a photo to your computer and erased it from your 
camera, your computer’s hard disk contains the only copy of that photo. This 
original version should be treated like a film negative: You don’t want to do 
anything to it that will alter the original content. Except rotation to correct 
orientation or renaming the file, the original version should be left alone.

When you want to edit a photo or add it to a project, you should always make a 
copy of the original and work with the copy. That way, if you make some edit-
ing changes that you regret later, you can always go back to the original, make a 
new copy, and start over.

To make a copy of a photo:

 1 Open the picture.
 2 On the File menu, click Save As.

The Save As dialog box opens.
 3 Click the folder where you want to save the copy of the original. 
 4 In the File name box, enter a name for the copy.
 5 Click Save.

The Save As dialog box closes, with the new copy of the picture open in 
the workspace. 
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Choosing a File Format
Digital Image allows you to save photos in a number of image file formats. You 
can determine the best format for saving your photos based on what you will 
use the photos for, compatibility with other computers, and file size. To help 
you understand the difference between file formats, here are some important 
characteristics of three common image formats:

 Digital Image PNG Plus (.png) saves the individual objects in your 
photo projects so you can edit them later. PNG offers lossless compres-
sion, but not all computers have the software to open PNG files.

 TIFF (.tif) is a common format for cameras that produce lossless images. 
TIFF does not support layers, but is a good format for saving important 
photos, although the files are relatively large. 

 JPEG (.jpg) is the most common format for images, since the files can 
be opened on practically any computer. JPEG does not support layers. 
Too much JPEG compression can reduce image quality, but JPEG is a 
format that makes relatively small files that work well for most purposes, 
especially for e-mail and the Web. 

To save a photo in a specific file format:

 1 On the File menu, click Save As.
The Save As dialog box opens.

 2 In the Save as type box, click a file type.
 3 Click Save.
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Setting PNG Plus Options
Only Digital Image and Picture It! can read individual objects saved in PNG 
Plus files. However, a PNG Plus file contains a flattened PNG version of the 
picture that can be read by many other programs, including Internet Explorer. 
By default, Digital Image saves the flattened version of the picture at the same 
size as the original, multi-object picture. But while this flattened version of the 
picture allows the file to be opened by other programs, it does increase overall 
file size. 

If you don’t need to have a full-size, flattened version of the picture embedded 
in each PNG Plus file, you can choose to have the flattened version of picture 
be saved at a smaller size. Limiting the dimensions of the embedded file can 
decrease the overall file size.  

To limit the size of the embedded, flattened PNG file:

 1 On the Tools menu, click Options.
 2 Click PNG Plus options.
 3 Click No Larger Than, and then enter values to limit the width and 

height. 
 4 Click OK, and then click OK.
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Saving for E-mail and the Web
Unlike photos for printing, photos for e-mail and the Web work best if they are 
relatively low resolution. Low-resolution photos, such as one that is 440 x 330 
pixels, move faster through dial-up modems, and they are the right dimensions 
for viewing on most computer monitors.  

To save a photo for e-mail or the Web:

 1 On the File menu, point to Save a Copy For, and then click Save for 
E-mail or Web. 

 2 Do one of the following:
 Click a picture size
 Set maximum dimensions

 3 Click Save As.
The Save As dialog box opens.

 4 Click the folder to which you want to save the photo.
 5 In the File name box, type a file name, and then click Save.

Avoid sending 
large photos in 
e-mail
Sending high-resolution 
photos in e-mail may 
cause problems for your 
recipients. For example, 
a single 5-megabyte 
(MB), high-resolution 
image will take over 20 
minutes to download on 
a 28.8-Kbps modem. 
Also, some e-mail 
programs limit the 
size of attachments, 
and may, for example, 
block e-mail with 
attachments larger 
than 1 MB.
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Printing Pictures

Printing Single Pictures
Digital Image has a simple process for printing single images. When using the 
single-picture printing task, one copy of the picture will print on the page, and 
the picture will be centered on the paper. 

To print a single picture:

 1 Make sure your printer is turned on and connected to your computer.
 2 On the File menu, click Print.
 3 Under Select a printer, click a printer.
 4 To specify printer settings, click Change printer settings.
 5 Select the number of copies, and then select a print size.
 6 Click an orientation, and then click Print.

Printing from 
Photo Library
Digital Image Library 
uses the same printing 
tools as Digital Image. 
To start the print task, 
use the Thumbnail 
pane to select the 
picture or pictures that 
you want to print. Then 
click Print on the File 
menu.
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Printing Multiple Pictures
Digital Image has a wide variety of templates that allow you to print multiple 
pictures on a page. You can print multiple copies of the same picture or multiple 
pictures together at the same time. 

Printing on a multi-photo sheet saves paper and is a convenient way to create prints to give to 
family and friends.

To print multiple photos on the same page:

 1 Make sure your printer is turned on and connected to your computer.
 2 Open all the pictures that you want to print so that they are on the Files 

palette.
 3 On the File menu, click Print.
 4 Under You can also, click Print multiple pictures or special paper.
 5 Under Select a printer, click a printer.
 6 To specify printer settings, click Change printer settings.
 7 Select a category of page layout, and then click an orientation.
 8 Click a layout in the right pane, and then click Next.
 9 Drag pictures from the Files palette onto the layout.
 10 Click an option for fitting the selected picture to the area, and then click 

Next.
 11 Preview the page layout, and then enter the number of copies you want to 

print.
 12 Click Print.

Installing printer 
drivers
When adding a new 
printer, make sure that 
you install all the printer 
software and drivers. 
If you’re installing an 
older printer, you may 
be able to find updated 
printer drivers on the 
manufacturer’s Web 
site.
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Selecting Print Quality
Most desktop printers are capable of printing in a range of qualities, from a 
low-quality draft mode to a high-quality setting that requires more time and 
uses more ink. Printer settings for quality and color vary, but you may be able 
to specify your paper type, ink type, dots per inch required, and color manage-
ment preferences. Some printers have simplified printing options such as 
“Good,” “Better,” and “Best.” Make sure to read your printer’s manual to find 
out how to take advantage of these different settings.

To select print quality for your printer:

 1 On the File menu, click Print.
 2 Click Change printer settings.

Your printer’s dialog box opens. 
 3 Adjust your printer’s quality settings, and then click OK.

Selecting a Print Size
The quality of photo prints is directly related to the number of pixels in the 
picture. A high-resolution picture contains a lot of detailed visual information, 
and can be printed at larger sizes. For example, a picture whose dimensions are 
2048 x 1536 pixels (3.1-megapixel) would look good even when printed as large 
as 8" x 10" on most printers. 

A low-resolution picture has less detailed visual information, and therefore can-
not be printed in larger sizes. A picture with pixel dimensions of 1280 x 960, 
for example, lacks the detail needed to fill an 8" x 10" print. The result would 
be a grainy, pixelated image. But printing this picture at a smaller size, such as 
4" x 6", would give you a sharp, detailed print.

Turning on color 
management
Check your printer’s 
manual to see 
if it offers color 
management. Color 
management can help 
your printer to produce 
colors that match the 
ones on your monitor. 
If your printer offers 
color management, 
click Change picture 
settings while 
performing the Print 
task. Your printer’s 
dialog box will open, 
and you can adjust 
the settings for color 
management.
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Choosing Photo Paper
If you want your images to look like traditional photographs, choose paper that 
is clearly labeled as photo paper. Photo paper comes in a range of thicknesses 
and textures. Paper weight ranges from ordinary office-document weight to 
fairly heavy watercolor paper. If you choose a heavyweight paper, check your 
printer’s manual to make sure that your printer can handle it. 

The quality of the image will be affected by the kind of paper stock you choose. 
As a rule, you’ll see the widest range of colors and get the deepest blacks from 
paper that has been specially coated to accept inkjet inks. The range of colors 
appears to be widest on the whitest papers. Glossy surfaces also create the 
illusion of deeper blacks. However, if you’re going to display your prints, glossy 
surfaces can cheapen the look of the work, and surface glare can make the 
images more difficult to view.

Paper formulations also contribute greatly to resisting fading and color shifting. 
If you’re using “fade-resistant” or “archival” inks, look for coated, acid-free 
papers that are also advertised as fade-resistant or archival.

Creating Long-lasting Prints
How long can you expect a print to last? With some inkjet prints, you can only 
expect a fade-free lifespan of two months to two years. All of the major printer 
manufacturers are beginning to advertise greater image stability for the output 
of certain printer/ink combinations, but few of these manufacturers claim that 
prints will last more than about four years. 

When buying supplies for your printer, check which types of ink and paper are 
recommended by the manufacturer of your printer, and find out about the ink’s 
lifespan rating. Some six-color printers use inks specially formulated for long 
life. When printed on high-quality heavyweight matte paper, photos from these 
printers can last approximately 40 years before perceptible fading occurs.

Fade ratings are given as the amount of time before any color shift in the print 
can be seen by the naked eye. The actual time it would take for the print to 
become unacceptably discolored would be several times that. These ratings are 
based on indoor exhibition under glass in an atmosphere that is not chemically 
polluted. Ozone is especially harmful to dye-based printing inks. Do not 
display these prints in rooms where oxygen tanks or electric air fresheners are 
used—both produce high levels of ozone. 
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Ordering Prints and Gifts on MSN Photos
Order prints of your photos online at MSN Photos and have the prints sent to 
you or your family and friends. On MSN Photos, you can also use your photos 
to create a variety of photo gifts.

To order prints and enlargements:

 1 On the File menu in Digital Image, point to Print Professionally Online, 
and then click Prints and Enlargements. 

 2 Choose to print either the current picture or all opened pictures in the 
Files palette.

 3 To open additional photos for ordering prints and enlargements, click 
Add or remove pictures, and then follow the instructions on the screen.

 4 Click Next. 
 5 Follow the instructions on the screen to order the prints and enlargements 

you want. 
 6 Click Done.

To order photo gifts:

 1 On the File menu in Digital Image, point to Print Professionally Online, 
and then click Photo Gifts. 

 2 Choose to print either the current picture or all opened pictures in the 
Files palette.

 3 To open additional photos for ordering prints and enlargements, click 
Add or remove pictures, and then follow the instructions on the screen.

 4 Click Next. 
 5 Order the photo gifts you want. 
 6 Click Done.
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Digital Image Library is a powerful tool that helps you organize, find, and 
archive your pictures. Digital Image Library does not store your pictures. 
Instead, Digital Image Library stores information about your pictures, includ-
ing a thumbnail version of each picture. So you can conveniently organize the 
pictures on your computer. But you can also use Digital Image Library to keep 
track of pictures that you store on removable media, such as a photo CD or 
DVD. 

Digital Image Library automatically tracks information about each picture you 
add to the library, including date taken, file size, image size, and the folder 
where the picture is stored. Then you can add your own picture information, 
such as ratings, keywords, and captions. Tools like the Keyword Painter and the 
Selection Preview pane make it easy to add this information to many pictures at 
the same time. 

With all of this information about each picture, Digital Image Library helps 
you locate your pictures with powerful filtering and grouping. Even if you have 
added pictures from many occasions over the years, you can locate pictures that 
share the same keywords, dates, ratings and more. 

Digital Image Library also makes it easy to archive your photos on CDs or 
other media. Digital Image Library also allows you to make simple changes 
to multiple pictures at the same time, such as batch editing in Mini Lab, batch 
rename, converting file format, and batch resize.

Opening Digital Image Library
The Digital Image Library can be opened from the Windows Start menu or 
from the Digital Image Startup Window or File menu. 
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Adding Pictures to Digital Image Library
Any pictures you have in your My Pictures folder—and its subfolders—are 
automatically added to Digital Image Library’s database. You can also add 
pictures from other folders on your computer. 

The first time that you open Digital Image Library, the Welcome to Digital 
Image Library window will open to help you add pictures from folders other 
than the My Pictures folder. After the first use of the Library, you use the same 
process to add additional pictures to Digital Image Library.  

To add pictures from a folder on your computer:

 1 On Digital Image Library’s File menu, click Add Pictures to Library.
The Add Pictures to Library window opens. The folders already 
cataloged in Digital Image Library are displayed.

 2 Click Browse. 
 3 Navigate to the folder containing the pictures you want to add, click the 

folder, and then click OK.
 4 Click Done.

Adding Pictures 
from CDs and 
other removable 
media
You can use Digital 
Image Library to help 
catalog your pictures 
located on CDs or other 
removable media. To 
import these photos 
into the Library, click 
the Import button on 
the toolbar to launch 
the Import Pictures 
Wizard.
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Scanning for Pictures
Digital Image Library can scan your computer’s hard disk drive to locate 
pictures to add to Digital Image Library. This feature is helpful if you have pic-
tures stored in multiple locations or if you don’t remember where your pictures 
are stored. The scanning process can take some time if there are many picture 
files on your computer.

To scan for pictures on your computer:

 1 On Digital Image Library’s File menu, click Add Pictures to Library.
The Add Pictures to Library window opens. The folders already 
cataloged in Digital Image Library are displayed.

 2 Click Scan. 
 3 In the Beginning Picture Scan dialog box, click OK.

The hard disk drive is scanned, and the folders containing pictures are 
displayed.

 4 Clear the check box next to any folder you don’t want to add.   
 5 Click OK, and then click Done. 
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Adding Keywords
Adding keywords to your pictures is one of the most powerful ways to organize 
and later locate your pictures. You create your own keywords to identify the 
subjects of your pictures.  You can add multiple keywords to one picture, and 
add the same keyword to multiple pictures. 

The Keyword Painter is a fast way to add multiple keywords to pictures in 
Digital Image Library. 

Applying keywords with the Keyword Painter

 1 On the Tools menu, click Keyword Painter.
 2 If desired, add a new keyword to the list by clicking <click here to add 

keyword>. 
 3 Click the keyword or keywords you want apply to pictures.
 4 Click the pictures you want to assign those keywords to.
 5 To close the Keyword Painter, click the close button on the Keyword 

Painter title bar.



110 Chapter 11: Organizing and Archiving in Digial Image Library

Microsoft Digital Image Suite User’s Manual

111Chapter 11: Organizing and Archiving in Digial Image Library

Microsoft Digital Image Suite User’s Manual

Viewing Your Photos
Once you have added your pictures to Digital Image Library, you can custom-
ize the way you view the pictures. The left pane of Digital Image Library is 
called the View By pane. The View By pane allows you to filter the pictures 
displayed in the Thumbnail pane. Using the View By pane is helpful if you have 
a large number of pictures in Digital Image Library.

If you are viewing by date or by folder, you can click the All Pictures View so 
that all of your pictures show up in the Thumbnail pane.

Viewing by Folder
Viewing by folder allows you to filter your pictures based on where the pictures 
are stored. Remember, Digital Image Library does not actually store pictures, 
it just remembers where they are located. When viewing by folder, the folders 
shown mimic the folder structure on your computer and removable media. 
When you click a folder or drive in the View By pane, only pictures in that 
folder (and its subfolders) are displayed in the Thumbnail pane.

To filter by folder:

 1 On the View By menu, click Folder. 
 2 In the folder structure, click a folder or drive.

Pictures in that folder or on that drive are displayed in the Thumbnail 
pane.

 3 To view pictures from all folders and removable media, click All Pictures 
View.

Viewing by Date
Viewing by date allows you to filter your pictures based the dates the pictures 
were taken. You can set the filter to display pictures taken in a particular year, 
month, or even a single day. When you click a year, month, or date in the View 
By pane, only pictures taken during that time frame are displayed in the main 
viewing area.

To filter by date:

 1 On the View By menu, click Date. 
 2 Click a year to display the months within that year. 
 3 To display the days in a month, click a month.
 4 To display the pictures from a particular day, click the day. 
 5 To view pictures from all dates, click All Pictures View.
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Viewing by Keyword
Viewing by keyword allows you to filter pictures based on keywords you 
assigned.

To filter by keyword:

 1 On the View By menu, click Keyword.
 2 Click either With at least one selected keyword or With all selected 

keywords.
 3 Click the keyword or keywords you want to find pictures for.

Pictures with those keywords assigned appear in the Thumbnail pane.
 4 To deselect a keyword from the filter, click the keyword to clear its check 

box.
 5 To find pictures with no keywords assigned, click the Unassigned 

keyword.
 6 To view all pictures regardless of keywords, click Folder on the View By 

menu, and then click All Pictures View.

Using the Thumbnail Slider
The thumbnail slider, in the upper right of the Thumbnail pane, allows you to 
change the size of the thumbnails. With larger thumbnails, you must scroll more 
to see all your pictures, but more detail is visible. With smaller thumbnails, you 
scan see more pictures at once.

To use the thumbnail slider:

 1 To increase the size of the thumbnails, do one of the following:
 Drag the slider to the right.
 Click the plus (+) button.

 2 To decrease the size of the thumbnails, do one of the following: 
 Drag the slider to the left.

  Click the minus (-) button.
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Showing Thumbnail Data
There are three ways to view the thumbnails and their associated data in the 
Thumbnail pane.

Tiles View
Along with the thumbnail, the tiles view displays:

 Caption
 Time and date taken
 File size
 Image size (pixel dimensions)
 File name
 Rating

Thumbnails View
The thumbnails view displays only the thumbnail with no data.

Thumbnails with Text View
The thumbnails with text view displays the thumbnail and the field that the 
pictures are arranged by.

To switch views in the Thumbnail pane:

 1 On the View menu, click one of the following:
 Tiles
 Thumbnails

  Thumbnails with text
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Grouping Your Pictures
You can group the pictures in the Thumbnail pane according to date, ratings, 
keywords, or other information.

Grouping by rating, for example, will separate all the one-star pictures into one 
group, the two-star pictures into another group, and so on. 

To group your pictures: 

 1 On the Group By menu above the Thumbnail pane, click a grouping 
option.

Showing the Table of Contents
You can open the table of contents, which is hidden by default, to list all of the 
groups currently in the Thumbnail pane. The table of contents is located along 
the left of the Thumbnail pane. To see the pictures of a particular set, just click 
the group in the table of contents.

To show the table of contents:

 1 On the View menu, click Show Table of Contents.
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Using the Preview Pane
The Preview pane, located under the Thumbnail pane, is a convenient way 
to view and edit information about a picture or pictures. The Preview pane 
displays the information about the pictures selected in the Thumbnail pane. You 
can click any of the fields (except file size and image size) in the Preview pane 
to edit the information. 

To use the Preview pane:

 1 In the Thumbnail pane, select the picture you want to preview. To 
multiple-select pictures, press CRTL while you click the thumbnails.

 2 Click one of the following fields:
 File name will change the file name for all selected pictures. If more 

than one picture is selected, the file names will be the base name that 
you enter followed by a sequential number.

 Caption will apply a new caption that you enter to all selected 
pictures, replacing any previously associated captions. 

 Date taken will change the date taken field for all selected pictures, 
which is useful if your camera recorded incorrect dates.

 Common keywords opens the Keyword Editor to add new keywords 
to the selected pictures; existing keywords will not be deleted.

  Average rating assigns a new rating to each selected picture, 
 replacing any preexisting rating.

Showing the 
Preview pane
The Preview pane can 
be hidden from view to 
make more room in the 
Thumbnail pane. If the 
Preview pane is hidden, 
you can show it again 
by checking Preview 
Pane on the View 
menu.
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Archiving Pictures
One of Digital Image Library’s most powerful features is the Archive Pictures 
Wizard. Whether you take a lot of pictures or just a few, archiving your picture 
files can prevent the files from being lost in the event of problems or damage to 
your computer’s hard drive. 

If you have limited hard drive space, archiving allows you to make more room 
on the hard drive by transferring pictures to CDs or other media. 

Within Digital Image Library, you can set up reminders to archive your 
pictures. You can set this reminder to occur on a regular basis, such as every 
month, or to occur after you have added a certain volume of image files. 

To set the archive reminder interval:

 1 On the Tools menu, click Options.  
 2 Click the Archive Settings tab.
 3 Under Display the archive reminder, click a reminder setting.

You can begin the Archive Pictures Wizard by clicking Archive when you see 
the Archive Reminder. Or, start the wizard at any time by clicking the Archive 
button on the Digital Image Library toolbar.

Once the Archive Pictures Wizard begins, you can choose from four archiving 
options: 

 Pictures added since the last archive and any modifications not archived. 
 Pictures added since the last archive (modified pictures will not be 

archived).
 Pictures selected when you entered the Archive Pictures Wizard.
 All Pictures in Digital Image Library.

The Archive Pictures Wizard will guide you through the whole archiving 
process, allowing you to select an archive location, archive friendly name, and 
other options.
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Editing and File Management from Digital Im-
age Library
With its powerful organizational tools, Digital Image Library is an easy way to 
locate pictures in your collection. Once you have found the pictures you want to 
work with, you can select those pictures for editing and file management. 

Editing in a Photo Editor
From Digital Image Library, you can open pictures in a photo editor, perform 
your editing tasks, and then return to Digital Image Library.

To edit pictures in a photo editor:

 1 In the Thumbnail pane, select the pictures you want to edit.
 2 On the Tasks menu, click Edit.

The pictures open in the photo editor.
 3 Edit and save the pictures.
 4 Close the photo editor.

Thumbnails in Digital Image Library will be updated to show your edits.

By default, Digital Image Library will open the pictures to be edited in Digital 
Image. But you can set Digital Image Library to open a different photo editor.

To change the photo editor associated with Digital Image Library:

 1 On the Tools menu, click Options.  
 2 Click the General tab.
 3 Under Change Picture Editor, do one of the following:

 Click Use Digital Image 9.
  Click Use a different picture editor, and then click Browse to locate a

 different editing program.
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Editing in Mini Lab
Mini Lab allows you to perform the most common editing tasks to multiple 
pictures at the same time. Some of these tasks include: 

 Levels auto fix
 Contrast auto fix
 Rotate
 Crop 
 Fix red eye 

The Mini Lab you can access from Digital Image Library is the same Mini Lab 
you can access from Digital Image.

To batch edit pictures in Mini Lab:

 1 In the Thumbnail pane, select the pictures you want to edit.
 2 On the Tasks menu, click Batch Edit in Mini Lab.

Mini Lab opens with the selected pictures.
 3 For each batch-editing task, select the pictures you want to edit, and then 

click an editing option. 
 4 Click a file saving option. You must save the files for the Mini Lab 

changes to be saved.
 5 Click Done.

Mini Lab closes, and thumbnails in Digital Image Library will be updated 
to show your edits.

Batch File Management
Digital Image Library has its own tools for batch file management. These tools 
include batch rename, batch convert file format, and batch resize. These file 
management options save you time when you need to perform the same task on 
multiple files.

To begin batch file management:

 1 In the Thumbnail pane, select the pictures you want to manage.
 2 On the File menu, click one of the following:

 Batch Rename
 Batch Convert File Format
 Batch Resize

 3 Follow the instructions on the screen.
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No matter how polished and creative you are as a photographer, Digital Image 
is a valuable tool for helping you get the most out of your photos. With Digital 
Image features, you can easily correct common photo problems such as red 
eye and overexposure. And you can use features like filters and layers to create 
photos strikingly different from your originals.

Although Digital Image is a powerful photo-editing program, it’s important 
to get the best photo you can at the time you take it. Digital Image can do a 
lot to correct minor problems with the originals, but certain problems, such as 
severely blurred or underexposed photos, cannot easily be fixed with computer 
software. And if you can develop your photography skills to take higher-quality 
photos, you can spend your time doing creative photo editing with Digital 
Image, rather than fixing mistakes that can be avoided. 

Many cameras available today offer a high degree of automation: just turn 
the camera on and press the shutter, and the camera does the rest. While this 
approach is quick and easy, it isn’t perfect in all situations. As a photographer, 
you can learn to fine-tune the settings on your camera to gain greater control of 
the camera to get the best possible photo for each situation. 

With the range of cameras available—from basic point-and-shoot models 
to professional SLR (single-lens reflex) cameras—this chapter cannot cover 
specifics for all features available on all cameras. But this chapter does provide 
a foundation of photography concepts that are vital to taking consistently good 
photographs.

The first section of this chapter contains information specific to digital cameras: 
concepts such as resolution and compression that don’t have direct counterparts 
in film photography. Later sections cover universal photography concepts that 
apply to both film and digital cameras.

Opening photos 
from your digital 
camera
For information on 
opening photos from 
your camera in Digital 
Image, see the digital 
camera section in the 
“Opening and Importing 
Pictures” chapter.
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About Digital Cameras
If you’re new to using digital cameras, several camera features may seem 
foreign to you. Some of these features, such as digital zoom and compression, 
did not exist with film cameras because the technology did not exist. But it’s 
important to understand what these features do and when it’s appropriate to use 
them (or, in some cases, not use them).

Photo Quality
A digital photograph is composed of tiny colored squares called pixels (short 
for picture elements). Like a mosaic, the pixels blend together to form a picture. 
Each digital photo consists of a set number of pixels, ranging from a few 
thousand to millions. When a digital camera takes a photo, it creates a digital 
file that specifies the number of pixels and the precise color of each pixel.

Pixels are not a set size, so they can shrink or enlarge if photo size changes. 
When a photo is enlarged too much, the individual pixels become visible, mak-
ing a poor-quality photo. 

The original photo on the left was saved at high resolution, and you can see sharp detail. The 
photo on the right has been saved at such low resolution that you can see the individual pixels.

The number of pixels that make up a photo is the photo’s resolution. Resolution 
and compression are key factors in determining the quality of a digital photo. 
The following sections explain resolution and compression.  
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Resolution
Resolution is one of the main determinants of photo quality since it is a 
measure of the total number of pixels that make up a photograph. Resolution 
is sometimes expressed as the total number of pixels, such as 3 megapixels (3 
million pixels), or in pixel dimensions, such as 320 x 240 (which equals 76,800 
total pixels). 

Resolution is important primarily because it determines how much you can 
enlarge and print a photo. Everything else being equal, a 3-megapixel photo 
and a 320 pixel x 240 pixel photo look the same in a wallet-size print. But if you 
enlarge those two photos to 5" x 7" prints, the quality of the 320 x 240 photo is 
very low: you can see the individual pixels. The 3-megapixel photo still looks 
sharp at the larger size, since its pixels are too small to be seen.

Resolution is also important because it determines file size. High-resolution 
photos contain color information for many more pixels than low-resolution 
photos, so the files for high-resolution photos can be significantly larger. File 
size becomes an issue if you have limited storage on your camera or hard disk, 
or if you need to send the photos through e-mail.

The following chart gives an estimate of file size and maximum print size for 
various resolutions. The chart lists file sizes for JPEG format, which is a com-
mon (but not the only) format for photos. 

  Approx. JPEG file size 
Dimensions Total pixels (with slight compression*) Maximum print size

320 x 240 76,800 23 KB Wallet size

640 x 480 307,200 91 KB 4" x 6"

1280 x 960 1,228,800  363 KB 5" x 7"
 (1.2 megapixels)

1600 x 1200 1,920,000  576 KB 8" x 10"
 (1.9 megapixels)

2,048 x 1,536 3,145,728  970 MB 11" x 14" and larger

 (3.1 megapixels)

* Compression, which is explained in the following section, varies by camera, so you may find different file 
size results.
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Instead of film, a digital camera uses an image sensor—usually a CCD 
(charge-coupled device) or CMOS (complementary metal oxide semiconductor) 
chip—to capture the visual information when you take a photo. The image sen-
sor on a simple, low-resolution camera might capture just over 76,000 pixels. 
The image sensor on a high-quality digital camera might capture more than 
6 megapixels. As you can imagine, the 6-megapixel camera can produce very 
large, high-quality photos (with very large files). The 76,000-pixel camera can 
capture a relatively small number of pixels, so photo quality would be fair to 
poor, even at small print sizes.

On many cameras, you can set the resolution at which the image sensor 
captures the photo. As a rule of thumb, always shoot at the highest resolution 
possible—you’ll get higher-resolution photos that you can print in larger sizes. 
However, in some cases you may want to lower the resolution so that the files 
will be smaller. This allows you to store more photos on the camera’s storage 
media, but you must sacrifice some quality for quantity.

Make sure to check your camera’s manual to find out what resolution you will 
get from the photo-quality settings on your camera. Beware of settings that 
offer “enhanced” or “interpolated” resolution. These features add extra pixels 
not found in the original photo to produce a higher-resolution photo, which may 
reduce overall sharpness or quality.

Megapixel rating
One of the main factors 
in the price of a digital 
camera is its megapixel 
rating. The megapixel 
rating indicates the 
maximum number of 
pixels (in millions) that 
are captured by the 
camera’s image sensor.
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Compression
You’ve seen one way to reduce photo file size: lower the resolution at which you 
shoot the photo. You can also reduce file size by having the camera compress 
the photo file as it saves the file to the camera’s memory. Compression consoli-
dates similar information in the photo, and discards some information. With 
JPEG compression, for example, series of similarly colored pixels are grouped 
together and considered to be the same color. In the code that makes up the file, 
the color information for these grouped pixels only has to be listed once instead 
of hundreds, or even thousands, of times. This shortcut can reduce file size 
considerably. Taken to extremes, a photo in highly compressed JPEG format 
might be 95 percent smaller than the same photo in an uncompressed format.  

Although compression does reduce file size, it also reduces photo quality. Slight 
to moderate compression might not noticeably reduce photo quality, but high 
compression produces visible areas of splotchy color called artifacts. Even with 
slight compression, artifacts become more pronounced each time the photo is 
saved and compression is applied.

The left photo has been saved with lossless compression, so all of the image quality is 
retained. The photo on the right was saved with heavy JPEG compression—which is not loss-
less—and the compression significantly reduced the image quality.

For important photos that you want to make into prints, it’s good practice to 
use little or no compression. Or, if your camera offers it, you can take your 
photos in a format, such as TIFF, that offers lossless compression. Lossless 
compression reduces file size, but retains all of the photo quality once the photo 
is restored.    

File size and photo 
quality
Lowering resolution and 
increasing compression 
both reduce file size 
and photo quality. 
Bearing this in mind, 
you can use file size as 
a rough way to judge 
photo quality.
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File Formats
There are many file formats designed for photos or other digital images. Digital 
Image can work with JPEG, TIFF, and many other file formats. If your camera 
allows you to choose file formats for your photos, you can decide which format 
to use based on your particular criteria: photo quality, file size, or compatibility 
with other programs.

The JPEG format is the most common format for photos. JPEG files are versa-
tile, since they can accommodate over 16 million colors, can be compressed, 
and can be viewed in any Web browser. To reduce file size, the JPEG format 
always uses compression, although the degree of compression varies by camera. 
Experiment with the compression settings on your camera to find a low-
compression setting that produces good or excellent results. Because JPEG uses 
some compression every time a file is saved, many photo purists prefer formats 
like TIFF over JPEG. 

The TIFF format provides an extremely accurate recording of digital-image 
data. Some cameras can use a lossless compression method with TIFF. But even 
with some compression, TIFF files are generally larger than JPEG files for pho-
tos with the same resolution. For example, a single uncompressed 5-megapixel 
TIFF image is larger than 10 MB. To work with photos of that size, you need a 
lot of memory on your computer as well as a high-volume storage disk.   

File formats 
compatible with 
Digital Image
Digital Image can open 
photo files in any of the 
following formats:

 Adobe Photoshop 
(.psd)

 AutoCAD (.dxf)

 CorelDraw (.cdr)

 Enhanced Metafile 
(.emf)

 EPS (.eps)

 FlashPix (.fpx)

 GIF (.gif)

 Home Publishing 
(.php)

 JPEG (.jpg)

 Kodak Photo CD 
(.pcd)

 Macintosh PICT (.pct)

 Micrografx Designer 
(.drw)

 PC Paintbrush (.pcx)

 Picture It!/Digital 
Image (.php, .mix, 
.fpx)

 PNG (.png)

 TIFF (.tif)

 Targa (.tga)

 Windows Bitmap 
(.bmp)

 Windows Metafile 
(.wmf)
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Using Zoom Features
A zoom lens lets you adjust the focal length of the lens, making your subject 
appear closer to or farther from the camera. Some cameras have built-in 
adjustable zoom lenses; others accommodate interchangeable zoom lenses of 
different focal lengths. 

Digital cameras may offer optical zoom or digital zoom. An optical zoom 
feature uses the same principle as a zoom lens on a film camera: the lens itself 
moves to change the focal length. In any of the zoom positions, the resulting 
resolution is the same. 

A digital zoom feature does not move the lens. Instead, the software inside the 
camera crops the photo to make the subject appear closer. Because the pixels 
are removed from the area that’s cropped out, the overall resolution is lower. 
Many cameras offer a combination of optical and digital zoom. For best results, 
use only optical zoom. Then, if necessary, use Digital Image to crop the photo.

Both “digital zoom” and “enhanced resolution” features use interpolation to 
add pixels to the original photo, a process that increases the overall size or 
resolution. Interpolation assigns colors to the added pixels based on the colors 
of the surrounding pixels. While these features technically do increase resolu-
tion, they do not achieve the same photo quality as a photo that has not been 
interpolated. If your camera has digital zoom or enhanced resolution, test it and 
make sure you like the results before you use it for important photographs. For 
true zoom capability and highest image quality, use optical zoom.

Expand your 
perspective
Zoom lenses are great 
for capturing objects 
you can’t get close to, 
such as a ship sailing 
in water far from the 
shore. Use a zoom lens 
to get close-up, candid 
shots of people without 
seeming intrusive or 
conspicuous.
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Memory Cards, Disks, and Sticks
After the image sensor captures a photo in your digital camera, the digital 
information is stored on removable media, such as a CompactFlash or Smart-
Media card, a memory stick, a floppy disk, a CD, a microdrive, a miniature 
storage card, or a secure multimedia card.

Floppy disks and CDs have the advantage of being inexpensive and easy to 
find, even if you’re traveling abroad. Floppy disks, however, have very limited 
storage capacity.

Memory cards are small, durable, and reusable. And storage technology has 
been steadily improving, so you can now find cards that store as much as 1 
gigabyte (GB). Memory cards can be reused over and over, which, over time, 
makes them less expensive than film .

Buying additional storage media, like these CompactFlash cards, allows you to take many 
more photos in a single session.

Storage media size dictates how many photos you can store. The media that is 
included with some cameras can only hold a few high-resolution photos. This 
type of low-capacity card can be impractical for situations such as traveling. To 
give yourself more flexibility, you may want to purchase additional removable 
storage media.
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Battery Life
Compared to film cameras, many digital cameras use batteries at a surprising 
rate. The LCD preview screen and the flash on the camera both put a heavy 
drain on the batteries. And unlike some manual film cameras, digital cameras 
cannot function without batteries or an AC power adapter.

To ensure longer shooting, you can buy rechargeable batteries, which last longer 
than disposable alkaline batteries. Keep your spares charged so they’ll be ready 
when you need them. If you are running low on power and don’t have a spare 
battery, conserve remaining power by trying the following:

 Turn off your LCD screen and compose through the viewfinder.
 Turn off your flash so that it doesn’t fire automatically. Turn the flash on 

only when you really need it.
 Wait until you’re home to preview your photos.

The best 
rechargeable 
batteries
Lithium-ion batteries 
and nickel metal 
hydride (NiMH) 
batteries both 
work very well with 
cameras, providing 
excellent power and 
convenience.
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Using the Flash
Learning to use the flash is one of the easiest ways to get better photos both 
indoors and outdoors. Especially when you’re photographing people, overpow-
ering light from the flash can ruin the shot, often in ways that are difficult to 
correct with photo-editing software.

Most inexpensive and moderately priced cameras come equipped with a built-in 
flash. The flash may be programmed to go off automatically when the camera 
senses that the flash is needed. But relying on the camera’s judgment will not 
always give you the best results. Built-in flashes can create harsh shadows, 
overexposed areas, and unnatural-looking light.

Read your camera’s manual to learn what the recommended flash range is, and 
to find out how to adjust different flash settings. Three of the most common 
flash settings are outlined in the following sections.

Automatic Flash
Contrary to what you might think, you may be better off without your flash in 
many situations. If you think the scene is too dark to take without a flash, try 
increasing the ambient light by turning on lamps and opening the drapes. On 
most digital cameras, you can increase the ISO equivalent setting, in effect 
making the image sensor more sensitive to the available light, which allows you 
to shoot in low light without a flash.

Many newer cameras offer low-light shooting modes and night-flash settings 
that improve the quality of low-light photos. If your camera offers these 
options, use them. Otherwise, always stay within the recommended range of the 
flash.

Upgrading your 
flash
If your camera supports 
an external flash, 
consider buying one, 
especially if you take 
a lot of indoor photos 
of people. An external 
flash will give you much 
more control and often 
better results.

The range of your 
flash
Check your camera’s 
manual to find out the 
recommended range 
for your flash. Most 
on-camera flashes are 
designed to illuminate a 
subject that is 10 to 15 
feet from the camera. 
If the flash is too close, 
your subject may look 
too bright or washed 
out in the photo. If 
you’re too far away, the 
flash doesn’t provide 
enough light.
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Red-Eye Reduction Flash
One of the most common problems with flash photos of people and pets is red 
eye. This problem is caused by a flash located very close to the camera lens. 
The light from the flash reflects off the blood vessels in the subject’s retina, 
causing the pupils to look red. This problem occurs frequently in low-light 
situations, when pupils are likely to be dilated. There are several things you can 
do to help avoid red eyes in your photos:

 Increase the ambient light in the room. Turning on lights and opening up 
the drapes reduces the size of your subjects’ pupils.

 Use your camera’s red-eye reduction setting. This feature fires preflash 
bursts that help reduce the dilation of the pupils before the exposure.

 If you have an off-camera flash, move it away from the camera lens. 
Then, even if your subjects’ pupils are dilated, the light comes from a 
different angle and reduces or eliminates the red-eye effect.

Fixing red eye with 
Digital Image
If you end up with red 
eyes in your photos, 
Digital Image makes 
it very easy to remedy 
this problem. For more 
information, see the 
section on removing 
red eye in this book’s 
“Basic Touchup” 
chapter.
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Fill Flash
You can use the fill flash setting to fill in deep shadow areas caused by bright 
overhead sunlight, or in a scene where the light is behind the subject. 

In the left photo, the strong backlighting creates a shadow that covers the subject’s whole 
face. For the photo on the right, fill flash was used to counteract the backlighting and keep the 
shadows off the subject’s face.

If your flash is using the automatic setting, bright daylight can prevent it from 
firing. Turn on the flash manually, or, if your camera has a fill-flash setting, 
turn it on. If you see shadows on your subjects’ faces as you’re composing the 
shot, fill flash is a good idea.

An alternative to using the fill flash is moving to a different place where the 
light from the sun is diffuse and indirect, which produces a softer, more flatter-
ing portrait light.
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Using Your Camera’s Manual Settings
In today’s camera marketplace, the lines between manual and automatic cam-
eras have become blurred. It used to be that manual cameras were 35mm SLR 
(single-lens reflex) cameras with manual controls for focusing, aperture, shutter 
speed, and film speed. On the other end of the spectrum were fully automatic 
cameras with very limited controls, possibly only a shutter button. 

For serious camera users, the manual SLR cameras were usually the best 
option, since they offered so much control. The creative process was not left to 
the automatic settings of a camera. Automatic point-and-shoot cameras were 
good for novice photographers who didn’t want to worry about setting the cam-
era controls. Many automatic cameras could produce adequate or even excellent 
photos without requiring knowledge of advanced photography concepts. 

While you can still find fully automatic and fully manual cameras, many of 
today’s cameras offer different modes for different degrees of automatic and 
manual control. For example, some SLR film cameras let you switch to an auto-
matic mode where the camera determines everything from focusing to setting 
the aperture. Many compact digital cameras are designed to be used primarily 
in automatic mode, but also allow you to switch to program and manual modes 
to control exposure settings, like shutter speed and aperture. 

With digital cameras, the adjustments that you make are often digital approxi-
mations of the equivalent function in film cameras, as with shutter speed or 
ISO. But the photographic result is the same. The following sections provide an 
overview of the most important manual camera settings and concepts. 

Exposure
Exposure describes the amount of light that comes into your camera when you 
take a photo. Setting the camera to the correct exposure is crucial to getting the 
proper tones and colors in your photos. Overexposure occurs when too much 
light has reached the image sensor (or film in a film camera), which decreases 
detail and causes the photo to look washed out. Underexposure occurs when 
insufficient light has been let into the camera, and the photo looks dim and 
murky.

Exposure is controlled by three factors: the aperture, the shutter speed, and the 
ISO rating. Aperture is the size of the opening that lets light into the camera. 
Shutter speed is how long light is allowed into the camera. ISO rating (the film 
speed in a film camera) is the sensor or film’s sensitivity to light.
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The water glass analogy

When taking a photograph, your goal is to achieve a perfect exposure. To create 
the right exposure, you need to understand the relationship between the three 
exposure factors: aperture, shutter speed, and ISO rating. Achieving perfect 
exposure can be compared to filling a glass completely without spilling any 
of the water. For a perfect exposure, the glass should become completely full 
with no water spilling over. In this analogy, the tap symbolizes the aperture: 
the wider the tap is open, the faster the glass fills up. The time that the tap is 
open represents the shutter speed: leaving it open longer lets more water into 
the glass. To fill the glass to exactly the right level, the rate of flow must be set 
according to the time the tap is open. 

The third factor, ISO rating, can be equated to the size of the water glass. A 
smaller glass, representing a faster ISO rating, fills up more quickly than a 
larger glass, representing a slow ISO.

Understanding automatic exposure

As a photographer, you will come across a wide range of lighting conditions, 
and each condition requires that you adjust your camera to different exposure 
settings. For example, shooting a photo on a beach on a sunny day calls for 
different exposure settings than shooting on the same beach on a cloudy day.

For many conditions, the camera’s automatic exposure setting gives you good 
or even excellent results. But for some situations, the automatic exposure does 
not perform as well.

Automatic exposure assumes that the scene you are photographing has a few 
bright spots, many midtones, and a few dark areas. As the camera’s meter reads 
the available light in your scene, it averages the light in the bright, middle, and 
dark areas, and then calculates the exposure necessary to bring the average 
level to a tone of medium brightness called middle gray. 

Automatic exposure does not work well if your scene is dominated by large 
sections of very light or very dark colors. A bright field of snow, for example, 
has so much bright light that the automatic exposure lowers the brightness until 
the snow looks gray. To work around this shortcoming, you can use exposure 
compensation.
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Exposure Compensation
Some cameras have an exposure compensation feature that lets you manually 
override the automatic exposure setting. Exposure compensation lets you adjust 
the exposure with settings such as +2, +1, -1, and -2. A +1 setting, for example, 
tells the camera’s automatic exposure system to make the middle tones brighter. 
When taking a photo dominated by bright snow, increasing the exposure with 
the +1 setting might correct the light level for the snow-filled scene. Your actual 
results will vary according to your camera and the brightness of the day. 

With bright snow in a scene, setting your camera’s exposure compensation setting to +1 or +2 
might help you to get the right exposure.

Increasing your 
chances with 
bracketing 
If you’re not sure 
what the best 
exposure setting is, try 
bracketing. Bracketing 
involves taking 
multiple photos of the 
same scene. Start by 
using the automatic 
exposure, and then use 
exposure compensation 
to take additional 
frames with increased 
and decreased 
exposure levels. With a 
series of photos taken 
at different settings, 
there is a good chance 
that one has the 
exposure just right.
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Aperture
The aperture is the opening through which light passes to reach the film, or, in 
digital cameras, the image sensor. Aperture is measured by f -number, where 
a specific setting is called an f-stop. With f -stops, a low number, such as f /4, 
represents a wider opening that lets in more light. A small aperture, such as 
f /16, lets in significantly less light. 

Some cameras have a fixed aperture that can’t be adjusted. If you’re adjusting 
the aperture yourself, a setting of f /8 is a good place to start, since it gives you a 
fairly wide zone of sharpness.

If your camera allows you to adjust the aperture, use the settings to regulate the 
depth of field in your photo. Depth of field refers to the zone in your photo that 
is in acceptably sharp focus. A wide aperture gives you a shallow depth of field, 
while a small aperture allows a very deep zone—maybe even everything in the 
photo—to be in focus. 

Imagine pointing your camera down a set of railroad tracks which go all the 
way to the horizon. With a wide aperture, like f /2.8, if you focus on a railroad 
tie a short distance away, only a few of the other ties are in sharp focus. With a 
narrow aperture, like f /22, many more of the ties are in focus, even those quite 
a distance from your main focal point.

A wide aperture will give you a short depth of field, as illustrated in the photo on the left, where 
only the eagle is in focus. The photo on the right was taken with a small aperture, so almost 
everything is in focus.

For portrait photography, a wide aperture helps to limit the focus. Your 
subject’s face is clear and sharp, but objects in the background are blurred. But 
if you’re shooting a vacation photo of someone posing in front of a monument, a 
narrow aperture may be in order. With the narrow aperture, both the person and 

Program modes
If your camera offers 
program modes for 
specific photos like 
portraits or action 
shots, read your 
camera’s manual to 
find out the aperture 
settings used for those 
modes. 
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the monument can be in focus in the same photo. 

Of course, adjusting the aperture also affects how much light is let into the 
camera. But if a specific depth of field is important for your shot, you can 
switch to manual mode, set the aperture, and then set the shutter speed to get 
the correct exposure level. Some cameras also offer an aperture priority mode 
that automatically selects the correct shutter speed to produce the correct 
exposure for the aperture you select.
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Shutter Speed 
In most cameras, the shutter is the curtain in front of the film or image sensor 
that is retracted for a precise amount of time to let light into the camera. Shutter 
speed can be adjusted to let light into the camera for a longer or shorter amount 
of time. 

When determining the correct exposure for a photo, both shutter speed and 
aperture must be considered in relation to each other. An increase in shutter 
speed, which lessens the time the film is exposed to light, requires that you 
widen the aperture to let in more light.

Shutter speeds are measured in fractions of seconds. In automatic mode, 
many cameras will use a shutter speed of about 1/125th of a second. For action 
photography, a very fast shutter speed, like 1/500th of a second, can help to stop 
action and reduce blurring caused by movement of your subject. 

A fast shutter speed like 1/250th of a second can help you freeze action.

On the other extreme, you might set the shutter to stay open for four seconds, or 
even more for low-light night photography without a flash. But shutter speeds 
slower than 1/30th of a second increase the likelihood that slight movements in 
your hand while you take the shot will cause a blurred photo. To avoid camera 
shake, mount your camera on a tripod or other firm surface for slow shutter 
speeds.  

Shutterless 
cameras
Many digital cameras 
do not even have a 
true shutter. Instead, 
the image sensor is 
programmed to control 
the exposure time. The 
effect of shutter speed 
control is the same as a 
physical shutter.
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To accommodate the low light of this twilight scene, the camera was mounted on a tripod and 
set to a slow shutter speed.

Some cameras offer a shutter priority mode that sets the aperture automatically 
after you set the shutter speed. This can be useful if you’re in a situation where 
shutter speed is more important than aperture, like when you’re shooting a 
subject in motion.  
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ISO Setting or Equivalent
When shooting on film, you have the opportunity to select different types of 
film for specific uses. Films are available in different speeds that are more 
sensitive or less sensitive to light. 

The film speed is measured by ISO number. A high-speed film, such as ISO 
800, is ideal for low-light situations or action photography, since the film 
requires less light to properly expose the photo. Slow-speed films, such as 
ISO 100 or ISO 200, are good for photographing in bright daylight, since they 
require a lot of light. If you plan on using the same roll of film for shooting in 
multiple settings and light levels, ISO 400 film is a good compromise and does 
relatively well in most situations.

Faster films generally produce grainier photos than lower-speed films. Some of 
the newer varieties of professional grade high-speed films produce a finer grain 
structure, which is less noticeable. 

Since digital cameras use an image sensor instead of film, there is no way 
to actually change the film speed. However, many digital cameras provide 
the digital equivalent of an ISO. Sometimes called the sensitivity setting, this 
feature allows you, in effect, to change the ISO setting. For example, if you are 
shooting in a low-light situation, you can switch from ISO 100 to ISO 400.

With most digital cameras, setting the digital equivalent of the ISO setting to 
a faster speed can introduce noise to the photo. Similar to the graininess from 
high-ISO film, noise is random pixels in the photo that are slightly off-color or 
too bright. Cameras vary widely, so it is worthwhile to experiment with your 
digital camera’s ISO settings and examine the results. 

In low-light situations, consider turning off the flash and setting the camera to 
a faster ISO setting. This may produce some noise in the photo. But that result 
might be preferable to what you’d get by taking the photo at slower ISO setting 
with the harsh lighting of the on-camera flash.

ASA versus ISO
If you have an older 
camera, the film speed 
dial might be labeled 
ASA instead of ISO. 
These film speed 
ratings are the same, 
and the ratings are 
interchangeable. 

Avoid sharpening a 
photo with noise
Do not use the 
sharpen feature in 
Digital Image on digital 
photos with noticeable 
noise; sharpening 
accentuates the 
inaccurate pixels.
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Setting the White Balance
Most digital cameras are automatically programmed to calculate the proper 
white balance for each exposure. To calculate the white balance, the camera 
assumes the lightest spot in the picture is white, and adjusts the other colors 
accordingly. Under most circumstances, this automatic function should prevent 
an off-color cast in your photos. 

However, in some lighting conditions, the camera fails to correctly set the white 
balance. If you’re shooting indoors, for example, incandescent lights give off 
a yellowish or reddish glow. This color is not really visible to the naked eye, 
but often shows up in indoor photos. To counteract this problem, most digital 
cameras have preprogrammed color balance settings that compensate for 
different kinds of light. Typical settings include cloudy, shade, incandescent, 
flash, fluorescent, and sunny. These settings compensate for the different colors 
of light likely to be present in those conditions, and should produce photos that 
require little or no color correction. Read your camera’s manual to find out 
about specific white balance settings it offers.

With film cameras, there is no way the camera itself can compensate for dif-
ferent lighting conditions. But there are two ways you can compensate for the 
colored light: 

 Use film designed for specific lighting situations. Tungsten-balanced 
films, for example, help to neutralize the color of tungsten or halogen 
illumination.

 Use a filter on your camera lens. For example, if you’re using daylight-
balanced film but want to shoot indoors, you can use a blue-colored filter 
to absorb the overriding yellows and reds of the indoor incandescent 
lights. 

Correcting tint in 
Digital Image
If your photo has a 
colored cast from a 
light source, correct the 
problem with the Digital 
Image Adjust Tint tool.

Setting the white 
balance manually
Some digital cameras 
offer manual white 
balance control. This 
feature allows you to 
set the white balance 
by focusing on a pure 
white object, such as 
a piece of paper, and 
then locking down the 
white balance before 
you take the photo. 
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Using Automatic Modes on Your Camera 
Many of the automatic cameras sold today—even some of the less-expensive 
models—have preprogrammed modes that are designed for special situations. 
Sometimes called program modes, these modes automatically adjust your cam-
era to special settings designed specifically for things like macro photography, 
action shots, portraits, panoramic mode, or picture series. 

If you’re a beginning photographer who is not always confident enough to 
adjust your camera’s manual settings, use the automatic modes to help you take 
better photos. 

If your camera does not allow you to adjust settings manually, the automatic 
modes may be the most likely way for you to take successful photos in these 
situations. 

The following sections describe the most common automatic modes available 
on many digital and film cameras. Since the type and implementation of auto-
matic modes vary for each camera, read your camera’s manual for availability 
and usage instructions.
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Macro Mode
Most cameras in automatic mode have trouble focusing on objects that are 
less than 12 inches (30 centimeters) away. So when you’re shooting close-up 
photography, like capturing a special piece from your coin collection, you need 
to set your camera to macro mode. Macro mode adjusts the focal length to 
accommodate the unusually short distance to the subject.

Macro mode usually reduces aperture, which widens the depth of field, and 
increases the chances that the whole subject is in focus. 

The camera’s macro mode was used to capture the fine detail of the jewelry.

When using macro mode, make sure to turn off the flash, since the flash does 
not provide proper illumination at such close range. Tripods are a good way to 
keep the camera steady for a close-up shot. If you don’t have a tripod, set the 
camera on a firm surface, focus the photo, and then activate the shutter with 
the self-timer. This way, your hand does not have to touch the camera and 
accidentally introduce any movement to the shot.
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Action Mode 
If you’re photographing subjects such as athletes, moving cars, or even fast-
moving children, a camera’s action mode helps keep your subject in focus. 
The most significant characteristic of action mode is the faster shutter speed 
of at least 1/500th of a second, which helps to freeze the action of your moving 
subject. The action mode in most cameras also uses a wider aperture setting (to 
offset the fast shutter speed), and multipattern light metering, which compen-
sates for overly bright and overly dark areas.   

Action mode uses a fast shutter speed to freeze the action of a fast-moving subject.

Digital cameras create a unique challenge for shooting action photography: the 
time lag between when you press the shutter button and the actual exposure. 
With film cameras, pressing the shutter button causes the shutter to open virtu-
ally simultaneously. But with digital cameras, you might have to wait as long 
as four seconds before the photo is taken. When shooting moving objects, four 
seconds can seem like an eternity. 

One way to compensate for the shutter lag is to anticipate your shot. Imagine 
you are photographing a runner with a camera that has a four-second shutter 
lag. (The four-second shutter lag will not be highlighted on the camera’s 
packaging, but you can figure it out through your own experience.) First, focus 
your camera on a spot that the runner will cross in about 10 seconds. When 
the runner is only four seconds away from your target spot, press the shutter 
button. The exposure should occur just as the runner comes into your field of 
focus. 

When the lag is a 
drag
Some digital cameras 
have a much shorter 
shutter lag than 
others. You may want 
to consider this factor 
when buying your next 
camera.
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Another way to shoot a moving subject is to pan your camera with the action. 
While a stop-action photo freezes everything in the photo, panning your 
camera keeps your moving subject in focus, but blurs the background. For this 
effect, you do not want to use the action mode, because you do not want a fast 
shutter speed. To accomplish this effect, follow your moving subject in the 
viewfinder (or LCD screen) as it moves, but pan the camera so that your subject 
remains in the same position in the frame. Your result won’t show the subject in 
as clear a focus as stop action, but the blurred background helps to pronounce 
the speed and movement of your subject.

Since the camera panned with the subject, the girl is in fairly sharp focus and the background 
is blurred. This helps convey movement.
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Burst Mode
Burst mode is a feature that allows you to take a series of photos in quick suc-
cession. Most cameras’ burst modes allow you to take 10 to 15 photos in 5 to 15 
seconds.

Even on digital cameras with slow shutter lags, the burst mode still allows you 
to take many frames in a short time span. The burst feature uses a buffer to 
temporarily hold the information from the image sensor. After the set of 10 to 
15 frames is stored in the buffer, the camera processes each frame separately 
and sends them to the removable storage media.

If your camera has a burst mode feature, you can use it to overcome the slow-
ness of the shutter lag. When photographing a child, for example, it can be hard 
to get the child to pay attention for the few seconds that it takes to shoot the 
photo. But with burst mode, you might be able to shoot 10 frames within 10 
seconds. During that 10 seconds, you can encourage the child to talk, look at 
the camera, and make different movements and expressions. It’s doubtful that 
all 10 exposures will turn out to be great photos, but you’re much more likely to 
get at least one good shot than if you’d just taken a single frame.

Another great use of the burst mode feature is to take a photo series of an action 
sequence. Create a series of photos of a golf swing, a child riding a bike, or a 
pet moving across the yard. Then you can assemble the whole series in a slide 
show, or mount the photos together in a frame. 

Showing the whole 
series online
Digital Image offers 
Flipbook animations 
as a creative way to 
present a series of 
photos in sequence. 
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Portrait Mode
For portraits and candid shots, using your camera’s portrait mode is a 
convenient way to get good results. Portrait mode is set to use a relatively wide 
aperture, creating a shallow depth of field. With only your subject in focus, 
objects in the background are less distracting, and your subject dominates the 
frame. 

With a shallow depth of field, it’s crucial that you get your subject in sharp 
focus. If your depth of field is so short that you can’t focus on every part of your 
subject at the same time, focus on the subject’s eyes, and let hands and feet be 
less in focus. 

For this portrait, the Diffuse Glow filter was applied in Digital Image to soften the focus.

For successful portraits, remember to fill the frame, and use a slightly telephoto 
lens, such as a 105mm, or a slight zoom setting. Keep the background very 
simple, unless you are using objects in the background as context for your sub-
ject. If shooting indoors, an off-camera flash or other light source works best. 

Reduces wrinkles 
and blemishes!
The Diffuse Glow filter 
available in Digital 
Image works well when 
applied to portrait 
photographs. The filter 
simulates the effect of 
using a soft diffusion 
filter on your camera, 
softening the photo and 
minimizing wrinkles or 
blemishes.

Relaxing your 
subject
An important 
aspect of portrait 
photography is to get 
your subject relaxed 
and comfortable for 
the pose. Try using 
conversation or other 
pleasant distractions to 
get your subject’s mind 
away from the camera.
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Panoramic Mode
For landscapes, large groups of people, and other long horizontal shots, a 
camera’s panoramic mode helps you compose the photo without too much 
sky or ground in the photo. Panoramic shots have a different aspect ratio than 
standard shots, meaning the width of the frame is proportionally much greater 
than in a photo with a standard aspect ratio. 

Some panoramic cameras take photos with an aspect ratio of 4:11 (four units 
tall by 11 units wide), compared to the aspect ratio of 3:4 for standard shots 
on most digital cameras. As with the shape of a movie theater screen versus a 
television screen, the wider frame gives you some new creative territory when 
composing your photo. 

Switching your camera to panoramic mode gives you new compositional possibilities.

True panoramic cameras use a wide-angle lens to let you capture more width 
of the scene by staying in the same position. Many cameras, including digital 
cameras and APS cameras, offer a panoramic mode without a wide-angle lens. 
Instead, the panoramic effect is achieved by simply cropping off the top and 
bottom of the frame. This type of panoramic shot does give you a wider aspect 
ratio, but not a wider angle. On some digital cameras, using the panoramic 
mode means that each photo has fewer pixels (since the top and bottom are 
cropped), so each panoramic shot takes up less space on your storage media.  
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Using the Self-Timer
Many digital cameras, even inexpensive ones, come with a self-timer feature. 
Some self-timers open the shutter after a preset amount of time, such as 10 
seconds; others allow you to adjust the length of time before the shutter fires. 
Either way, this fairly simple feature is great for getting yourself into a photo 
and for taking long exposure shots.

Getting Yourself into a Photo
To get yourself into a photo, plan where you want to position yourself for the 
shot. Then set up the camera by putting it on a tripod, a table, or any other flat, 
stable surface. With your camera in position, focus the camera on your subject, 
which should be close to the position where you will stand for the photo. 

If your camera has autofocus, press the shutter halfway down to focus, press the 
self-timer button, and then press the shutter all the way down. Then you’ve got 
about 10 seconds to get yourself in position for the shot. 

Taking Long Exposure Shots
Another great use of the self-timer is for exposures with a relatively slow shut-
ter speed. For speeds slower than 1/30th of a second, there is a good chance the 
slight movements in your hands will cause blurriness in your photo. Even if you 
have very steady hands, the slight movement of your finger pressing the shutter 
button can create movement. Using the self-timer will eliminate this problem. 
By setting the camera on a firm surface and using the timer, your hands don’t 
have to be anywhere near the camera while the shutter is open.

Creating a 
makeshift tripod
If you’re outdoors, try  
propping the camera 
on a rock or car roof. 
Then fine-tune the 
positioning by putting 
the camera on a jacket 
or other object that you 
can shape to adjust the 
camera angle.
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Ten Tips for Great Pictures
The following 10 tips offer suggestions for developing your photography 
approach, technique, composition, and habits. If you are an inexperienced 
photographer, some of these tips might be new ideas for you. If you’re a photog-
raphy veteran, these tips might be a good reminder of things you haven’t heard 
in a while. Either way, we hope they inspire you to get out and shoot some great 
photos!

1. Know Your Gear
Having command of your equipment is an important aspect of enjoying and 
being successful with photography. As you get to know your gear and gain 
confidence in a camera’s capabilities, the camera can become an extension of 
yourself. When you have reached this level of competence, you can concentrate 
more on the creative aspects of photography. 

When you get a new camera, first read through the manual. With digital cam-
eras especially, operating the controls may not be intuitive, since many digital 
cameras’ controls must be accessed through menus on the LCD screen.  

After you’ve read the manual, and you understand how and when to use your 
camera’s features, go out and take a variety of photos using the different 
settings. Take some photos outdoors and indoors, with the flash and without 
the flash, with automatic settings and with manual settings. As you shoot, 
take notes to record the settings used for each shot. Later, look at your photos 
on your computer, and take note of both the settings that worked well and the 
settings that produced poor results. 

Missing a great photo because you get hung up on technical issues is frustrat-
ing. Spend time getting to know your gear, and prepare for great photo 
opportunities. 
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2. Nail the Exposure
In a finished photo, exposure is something that you usually only notice when 
it is out of adjustment. A perfect exposure is not something that jumps out 
at you from a photo, but a problem exposure definitely stands out. In an 
overexposed photo (caused by too much light), the shadow areas are light, and 
the highlighted areas are almost entirely white. In an underexposed photo, too 
little light has been let into the camera, creating a photo that lacks detail, with 
filled-in shadow areas and dull highlighted areas.

Special lighting situations can fool the built-in light meter in your camera. If 
you want to start with the camera’s automatic exposure, use exposure compen-
sation to fine-tune the exposure. The following list describes some common 
lighting problems and the recommended exposure compensation for each: 

 For a side-lit subject: Increase exposure by one-half of a stop.
 For a backlit subject: Increase the exposure by one stop. Or step in close 

and meter directly on the subject, step back and recompose, and then 
shoot at the reading you took on the subject. You can also switch to spot 
metering.

 For a small dark subject against a bright background, or any subject in 
a very bright scene: Use exposure compensation of +1 to +3, or increase 
exposure by one to two stops, for example, from f/8 to f/5.6 or f/4.5.

 For a small, light subject against a dark background: Use exposure 
compensation of -1, or decrease exposure by one stop, for example, from 
f/8 to f/11.

Planning for the 
imperfect
Learning to nail the 
exposure takes a lot 
of experience, and 
no one gets it right 
with every shot. If you 
suspect the lighting 
might make it difficult 
to nail the exposure, 
you can increase your 
chances of success 
by bracketing, as 
explained in tip #7.
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3. Capture a Moment in the Story
Consider driver’s license and passport photos. We think of these photos as 
uninteresting and unrepresentative of how people usually look. Why are these 
photos dull?

One problem with these photos (but certainly not the only problem) is that 
they capture people out of their element, without context or a story. There are 
no interesting details in the background to draw in the viewer, and the subject 
often looks impatient or uncomfortable.

When you are the photographer, you can strive to capture people, events, and 
places that tell a story. In addition to having your subject look natural and not 
posed, details in front of the subject or in the background can stimulate the 
imagination to re-create the story of the photo. 

This photo captures the destruction of an earthquake just hours after the event. Since the 
photo was taken before the rubble was cleared away, the photographer was able to capture 
the many details of the scene that tell the story.

With enough of these details, and a strong relationship between your subject 
and the other elements, the photo can suggest ideas that are not even in the 
frame. You can take the old cliché “A picture is worth a thousand words,” and 
make it your goal to paint more than a thousand words with your photographs.     
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4. Look for the Light
Many of the best photographs are taken early in the morning, late in the after-
noon, and at twilight. At these times the lighting is most dramatic.

Many photographs are shot in bright or moderately bright sunlight. This type 
of light produces photos that closely match the way we remember seeing the 
scene. That is part of the reason we respond to them with a positive sense of 
familiarity.

However, colors photographed in the cooler light at twilight or in overcast 
conditions, or in the warmer light of sunrise and sunset, offer a new perspective 
on familiar colors and subjects, and provide a more creative backdrop for pho-
tographs. Overcast and after-the-rain conditions, in particular, produce richer, 
more saturated colors. For example, red leaves photographed against a twilight 
backdrop, instead of in daylight, create a moody interpretation that suggests a 
sense of mystery or drama.

In the dim light of a rainy day, the red leaves in this photo look especially vivid.

For interior photographs, look for strong sources of natural light, as from a win-
dow or a skylight. The glow of light coming from one direction can illuminate 
your subject dramatically.
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5. Follow the Rule of Thirds
When composing a photograph, many beginning photographers always center 
their subject directly in the middle of the frame. While this technique may be 
the easiest way to get the subject in focus with a point-and-shoot camera, it is 
not always the most interesting way to present the subject. 

Most advanced photographers follow the rule of thirds when composing the 
space inside a picture frame. The rule of thirds divides the frame into thirds 
both horizontally and vertically, and places the point of interest on one of 
the four spots where these dividing lines intersect. The rule of thirds is used 
throughout the graphic design world, because it helps to create balance between 
the subject and the background.

To apply the rule of thirds, divide your scene into three sections horizontally and vertically. 
Place the focal point of your photo on one of the intersections of the dividing lines.

Following the rule of thirds, the bicycle in this photo lies right on the of the points where the 
dividing lines intersect. The top of the dock also roughly follows the horizontal line that runs 
one-third down from the top of the frame.

Recomposing a 
photo with Digital 
Image
After a photo has 
been transferred to 
your computer, use 
the crop tool in Digital 
Image to change 
the composition. By 
clipping away the edges 
of the photo, you can 
reposition your subject 
to comply with the rule 
of thirds. 
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If you have a person or animal in your photo, you can place the subject’s face 
on one of the four points, looking toward the center of the scene. If the horizon 
is in a photo, it should run about one-third from the top or one-third from the 
bottom, depending on whether the terrain or the sky is the center of focus.

The rule of thirds is not an absolute law, and there have been many great 
photographs taken that don’t abide by it. But the rule can be a great way to add 
balance and interest to your photos.

6. Find a Unique Perspective
You can challenge yourself to take original photos that convey unique perspec-
tives. Rather than just pressing your shutter button as soon as you have the urge 
to capture a scene, take some time to assess your shooting angle, proximity to 
your subject, and background elements. You may transform your composition 
by taking one or more of the following simple steps:

 Get closer to your subject, to show more detail and eliminate distractions 
in the background.

 Include just a portion of your subject in the frame.
 Take your original subject and place it in the background. Find a new 

subject that adds context to the object in the background.
 Get lower to the ground, and point the camera up toward your subject.
 Move to a higher location, above your subject, so you are pointing down 

when you take the photo.

For example, if you are traveling, your natural instinct might be to take 
straightforward photos of local monuments. But with this approach, you might 
wind up with the same lackluster photos taken by scores of other tourists before 
you. And there would be a good chance that a nearby souvenir shop would sell 
superior, professionally photographed prints and slides of the same monuments. 
For that matter, you could have just stayed home and ordered the professional 
photos from a catalog.

Use your imagination to compose some original, creative photos that you won’t 
find anywhere else. Capture some of the local color by photographing a lively 
food vendor stationed near the monument, and the monument can be the back-
drop in your frame. Or use the self-timer to capture you and your companion 
sampling the local fare that you’ve bought from the food vendor in front of the 
monument.  



156 Chapter 12: Taking Great Pictures

Microsoft Digital Image Suite User’s Manual

157Chapter 12: Taking Great Pictures

Microsoft Digital Image Suite User’s Manual

7. Bracket
The term bracket means to create exposures that are both lighter and darker 
than the camera or light meter indicates. The idea is to second guess the purely 
mechanical exposure meter, so that you get the right exposure. 

If you’re taking photos of a sunset, a scenic vista, or a plant, you have the time 
to bracket. With these subjects, you’re also likely to have a wider range of tones 
to record than your camera can handle, especially if your subject is brightly lit. 

So how do you bracket with an automatic camera? Most digital cameras, and 
many automatic cameras, have an exposure compensation feature, sometimes 
called the EV setting. If you set the exposure compensation for -1, the shot is 
one stop underexposed (darker than normal). If you set the camera for +1, the 
shot is one stop overexposed (lighter than normal). So you can bracket by tak-
ing three photos, one each at the -1, 0, and +1 settings.

Some cameras offer an automatic feature, which takes a range of photos, each 
with a different exposure setting.

Even if your camera doesn’t permit you that much control (or if you don’t want 
to take the time to change the exposure settings), another technique will give 
you results similar to bracketing. To get a lighter exposure, aim your camera at 
a darker portion of the subject, and then press the shutter button partway down 
(until you begin to feel a little resistance). Next, without releasing pressure on 
the shutter button, reframe your photo to include what you want, and then push 
the shutter button all the way down to take the photo. 

Depending on your camera, pressing the shutter button halfway down may lock 
in the exposure and the focus. If this is the case, you need to set the exposure on 
an object that is exactly the same distance away from the camera as the subject. 
Otherwise, your subject will not be in focus when you take the photo.   
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8. Analyze and Shoot Again
Photography takes practice. And you will progress at a faster rate if some of 
your practice time is focused on developing specific skills. One way to do that 
is to analyze your photos, and then go shoot them again.

When you get a chance to look at your photos on a computer or as prints, you 
can assess their quality of composition, lighting, exposure, and white balance. 
Upon close inspection, you might realize that you placed your subject too close 
to the center of the frame, or that incandescent lights caused an orange glow. 
On your next shoot, go out and take this same photo again, and make adjust-
ments for the problems you encountered before. 

When you look at the results of your second round of photos, you may find that 
you got excellent results, or you may find that one of your adjustments disrupted 
something else in the photo. Or maybe the different lighting conditions of the 
different day made it more difficult to nail the exposure.

To continue the exercise, shoot the same subject or scene on a regular basis. 
You must always compensate for the differences in lighting each day, but you 
can try new approaches to the composition. Learning to shoot the same subject 
under different conditions or with a different approach gives you valuable 
experience and ideas when you encounter new situations.

9. Shoot Every Single Day
To become a talented and confident photographer, make photography part of 
your daily routine. Fortunately, digital cameras have made it much more conve-
nient and inexpensive to shoot lots and lots of photos. Once you’ve purchased 
your digital camera, you can take as many photos as you want. The only cost is 
for batteries and storage for your photos.

The more you practice, the more confident you’ll become in your skills and in 
your equipment. You’ll also develop the habit of keeping your camera close by, 
and having it ready for photo opportunities. Train yourself to look for these 
opportunities, and take advantage of them when they come to you. Some of 
the world’s most memorable photos were taken by amateur photographers 
who happened to be in the right place at the right time. So to be ready to take 
that once-in-a-lifetime shot, know how to use your gear, have your equipment 
handy, and be on the lookout for great photo material.

A quick check with 
the LCD
One of the benefits of 
digital photography is 
that you can get a look 
at your photos on the 
LCD preview screen 
right after you’ve taken 
the shot. This feature 
is great for a quick 
analysis of the photo’s 
composition, exposure, 
and color tone. Just be 
aware that since the 
preview screen is so 
small, it often does not 
reveal problems with 
focus.  
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10. Show Your Photos to Other People 
Even when you are making great progress with your photography skills, it’s 
easy to overlook the shortcomings in your own work. To continue improving 
your abilities, show your photos to other people. Getting others’ opinions is an 
invaluable learning experience. 

Good photos should be visually exciting to people, eliciting a “Wow, this is 
great!” response. If you find that people are not very excited by your photos, ask 
them what they think is missing, and what you could do to make them better. 
You’ll be surprised what some people like and do not like about your photos.

Find other photographers in your community. You can look at each others’ work 
and give feedback. This kind of mutually beneficial arrangement also helps you 
to develop your critical eye.

While it’s important to show your photos to others, remember that you are the 
ultimate judge of your own work. Photography is an art, and as an artist you 
should establish your own voice and style. You don’t have to listen to every 
piece of advice, and you may produce your best work by taking chances and 
following your own instincts.

That said, photographs are made to be seen! As you improve your photography 
skills, showing off your photos can be the best part.  
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A scanner is a useful tool for your digital photography projects. A scanner 
generates a digital image from whatever you scan—a document, a photo, a 
leaf, and so on—enabling you to manipulate the image on your computer. Even 
if you take all of your photos in digital format, scanners allow you to digitize 
things such as old photos, pages from books, negatives, and slides.  Once 
scanned, the digital images are rich raw material that can be edited, incorpo-
rated into composites, printed, or posted on the Web.

Types of Scanners
If you’re thinking about buying a scanner, consider the two primary types 
that are available for working with photographs. Flatbed scanners convert 
photographic prints or other flat opaque objects into digital files. Film scanners 
convert film negatives or 35mm slides into digital files. 

Flatbed Scanners
For general-purpose scanning, a flatbed scanner gives you the most flexibility. 
You can scan virtually any two-dimensional object: photographic prints, text 
documents, kids’ crayon drawings, even leaves or feathers. If you have a flatbed 
scanner, you can buy a transparency adapter, an accessory that allows you to 
scan slides, negatives, and transparencies with your flatbed scanner. 

Flatbed scanners with transparency adapters scan at lower resolutions than 
dedicated film scanners. However, flatbed scanners are usually adequate 
for occasional scanning of snapshots or amateur photos. If you plan to scan 
only prints and other flat artwork, a 1200-dpi (dots per inch) flatbed scanner 
should meet your needs. More information about scanner resolution and dpi is 
available in the section later in this chapter titled “Setting Resolution and Bit 
Depth.”

Scanning with 
Digital Image
For information on 
using your scanner with 
Digital Image, see the 
scanner section in the 
“Opening and Importing 
Pictures” chapter.

Quick multi-page 
scanning
If you plan on scanning 
multi-page documents, 
look for a scanner with 
an automatic document 
feeder (ADF), which 
can save you a lot of 
time on bigger scanning 
jobs.  
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Film Scanners
If you need to scan negatives or slides on a regular basis, a film scanner is the 
best option for the sharpest high-resolution results. Film scanners generally 
have higher resolutions than flatbed scanners, producing images at 2,000 or 
more dpi. Since slides and negatives are so much smaller than photographic 
prints, it’s crucial to be able to scan at a high resolution, especially if you plan 
to make larger-size prints from the scans. If you scan a slide at low resolution, 
you’ll have relatively few pixels to work with, limiting you to making small 
prints of the scans.  

If you don’t have a scanner that accepts film, you can pay a photo lab to scan 
your best negatives or slides onto a CD-ROM. Negatives and slides can be 
scanned to various sizes, from 128 x 192 pixels to 2048 x 3072 pixels. The lat-
ter is adequate for making a good 8" x 10" print. Paying for scanning services 
can be expensive, so if you have a lot of slides or negatives, you’ll save money 
by buying a suitable scanner.

Automatic dust 
and scratch 
removal
Some high-end film 
scanners include 
automatic dust- and 
scratch-removal 
software. This option 
can save a great deal of 
time later, eliminating 
the need to fix most 
defects. 
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Preparing Pictures for Scanning
The single biggest problem with scanning is poor scans caused by contami-
nants, such as lint, dust, and other specks on your photos or flatbed scanner’s 
glass plate. Some of these particles are barely visible before the scan, but 
become noticeable spots in the digital image. You can remove these spots with 
Digital Image, but eliminating the contaminants before scanning is much faster 
and more effective. 

You should regularly clean a flatbed scanner’s plate with an antistatic cloth, 
which neutralizes static electricity that attracts tiny particles. Dedicated 
film scanners are more complex and can be difficult to clean, so follow the 
manufacturer’s suggestions before you try cleaning the inside of a film scanner. 

Make sure that your original image is also spotless. You should clean prints, 
slides, and negatives with an antistatic brush, which is specially treated to repel 
dust and dirt. You can find antistatic products at a well-stocked camera store, or 
by searching the Web. Antistatic accessories are far more effective at removing 
dust than other products are. Cleaning with compressed air, for example, may 
remove all visible dust, but leave behind small particles that might show up in 
the digital image. 
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Setting Resolution and Bit Depth
When scanning a photo or other artwork, consider what you want to do with the 
image file. As with taking photos with a digital camera, you’ll need to weigh 
the benefits of image quality versus file size. 

Resolution, usually expressed in dpi (dots per inch) with scanners, is the main 
factor to consider. For superior images that will make large, exhibition-quality 
prints, consider scanning at 1200 or even 1600 dpi. However, scanning large 
images at such a high resolution can make very large files, which might be a 
concern if your computer lacks sufficient random access memory (RAM) or 
hard-disk space. 

For scanning everyday prints that you do not plan to enlarge or crop, set your 
scanner to scan at a lower resolution. Scanning at 300 dpi should give good 
results for images that you want to print. For images that you want to send in e-
mail or post to the Web, 72 dpi is adequate resolution. Just remember that if you 
plan to crop or enlarge, you will need more pixels to work with, so you should 
increase your scanning resolution accordingly.

Many scanners allow you to adjust the bit depth (sometimes called color depth). 
Bit depth is the range of colors the scanner is able to capture per pixel. Scanner 
bit depths range anywhere from 8-bit on older models to 48-bit on some newer 
models. A high bit depth, such as 24-bit, ensures that the scanner captures the 
wide range of colors in your photos. 

Setting the bit depth higher than 24 bit requires longer scanning time, and may 
make image files larger  than necessary. Most image-editing programs (includ-
ing Digital Image) cannot work with bit depth higher than 24 bit. If you scan 
an image at the 32-bit setting, and then open it in Digital Image, the photo is 
converted to 24 bit automatically. The 24-bit level supports 16.7 million distinct 
colors, which is usually more than adequate.  
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Scanning Large Pictures
Scanning a large picture at high resolution requires a lot of RAM, or memory, 
on your computer. The larger a picture is, the longer it takes to scan, and the 
more memory your computer requires to open it. If you are having trouble 
scanning a large picture, try the following: 

 Scan at a lower resolution. If you don’t plan to crop or enlarge the image, 
300 dpi should be sufficient.

 Scan a smaller portion of the picture. See your scanner’s documentation 
for specifics on controlling the height and width of the scan.

 Close programs that you’re not using to make more memory available for 
the scanning task.

Adding RAM for 
faster scans
If you repeatedly have 
trouble scanning 
larger images, you 
might want to consider 
adding more RAM to 
your computer. At least 
128 MB of RAM is 
recommended. Adding 
RAM can be fairly 
inexpensive. Depending 
on the configuration of 
your system, you may 
be able to increase 
performance by 
upgrading to 256 MB or 
even 512 MB of RAM.
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Five Tips for Buying the Right Scanner
When buying a scanner, consider these factors to find a model that suits your 
needs. 

1. Get the Best Resolution You Can  
A flatbed scanner’s optical resolution (the number of pixels that a scanner 
“sees”) includes two numbers, such as 1200 x 2400 dpi. The first number is the 
most meaningful, and the most useful when comparison shopping. The first 
number indicates the number of lines the scanner can see vertically, which is 
the highest resolution the scanner can achieve before interpolating (generating 
extra pixels). The higher the resolution the scanner can achieve before it 
interpolates, the better the resulting scan.

2. Look for USB Connections  
New scanners offer USB (Universal Serial Bus) connectivity, which makes 
them easier to connect to computers. When compared to the older serial port 
connection, USB data transfer is significantly faster, which is especially impor-
tant for the large files created by high-resolution scanning. If your computer 
does not have a USB port, consider adding one. Some newer scanners also sup-
port FireWire (IEEE 1394) connectivity, which is faster than USB but requires a 
FireWire card on your computer. 

3. Check the Dynamic Range
Dynamic range (or D-range) refers to a scale of brightness values from pure 
white to black. Dynamic range is indicated with a number from 0 to 4, with a 
larger number indicating a wider range.  A scanner with a wide dynamic range:

 Captures more detail in bright areas of an image. 
 Differentiates between various shades of black.
 Creates less digital noise (pixels with inaccurate color information) in 

shadow areas.

If you want a scanner for digitizing prints, a D-range of 2.3 is adequate. But if 
you plan to scan negatives, you need a scanner with a range of at least 3. For the 
best results from slides, consider a scanner with a D-range of 3.4 or higher.
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4. Scan by the Batch  
If you’re considering a dedicated film scanner, check out models that allow you 
to load a batch of at least four slides or six negatives at one time. Batch scan-
ning can save a lot of time.

5. Be Realistic About Scanning Speed  
When reviewing the specs for various scanners, remember this: The quoted 
scanning speeds are always optimistic. Expect much longer actual scan times. 
Use the specs only for comparison purposes.
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Five Tips for Successful Scanning

1. Keep Your Scanner and Originals Clean
Dust or lint on the scanner glass or on a photo will be picked up by the scanner. 
An antistatic brush does a good job fending off even tiny particles that you 
can’t see.

2. Preview and Correct the Scan
Scanner driver software generally allows you to adjust color, contrast, high-
lights, shadows, and other factors. Most scanner programs offer an automatic 
enhancing feature that may improve brightness, contrast, and color balance. 
Preview your scan after using that control. If it seems perfect, you may be ready 
for the final scan. However, think about cropping in the preview to scan only 
the part of the picture that you need. This helps keep the digital file size to a 
minimum.

3. Scan at a High Resolution 
Any scanner can be used for quickly digitizing photos into small, low-resolu-
tion files. These are fine for online display or other Internet use. High-resolu-
tion scanners can produce much larger image files, a valuable feature for 
making or ordering oversized prints.

4. Choose the TIFF Format
Save any scanned image in TIFF format, as opposed to JPEG format. JPEG 
format compresses files to a small digital footprint, but you lose information 
every time you edit and resave a file. The TIFF format does not discard any 
information, and also supports more color data. If you have limited hard-disk 
capacity, you can transfer large TIFF files to a CD-RW disc, and then delete the 
files from your computer.

5. Convert Large TIFF Files to JPEG
If you’ve scanned a high-resolution picture in TIFF format, the file may be 
too large to upload to the Web in a reasonable amount of time. Open the file in 
Digital Image and save the file with slight compression. The compressed copy 
may be small enough to upload quickly enough. Or try changing resolution, 
from 300 dpi to 150 dpi, for example. If the photos are viewed online and not 
printed, a resolution of 72 dpi is adequate. 

Lossless 
compression
Digital Image can save 
files in TIFF format 
using a compression 
type called LZW, which 
makes image files 
smaller without losing 
data. 
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When working with digital photos on your computer, you rely on the monitor 
to accurately display a photo’s colors, brightness, and contrast. But just how 
accurate is your monitor? Unless you have recently calibrated your monitor 
(that is, configured the monitor to display colors correctly in ambient light), it 
may not be performing at its best. Even though the monitor can display digital 
information, it is ultimately an analog (that is, nondigital) device and occasion-
ally needs adjustment. If the monitor is not properly adjusted, edits could 
actually make a photo look worse.  

Imagine a monitor that is too dim. When you view a perfectly corrected photo 
on that monitor, the brightness level appears too low. You could use Digital 
Image or other software to manually adjust the photo’s brightness to a level that 
looks good to your eye. But when you print that photo or send it to a friend to 
view on another computer, the image appears too bright, since your adjustments 
compensated for the inaccuracies of your monitor. To avoid this problem, adjust 
and calibrate your monitor so that it is accurate and optimized for photo view-
ing and printing. 

Setting Screen Resolution
Screen resolution is the setting that determines the level of detail displayed on 
your monitor. A screen resolution of 800 by 600 pixels is usually the lowest 
resolution available on a monitor. But you can adjust screen resolution to show a 
higher level of detail. When using Digital Image, a higher screen resolution lets 
you see more of your photos in the workspace; less of the screen is covered by 
elements like the Stack and the Files palette.

The best screen resolution for a computer system depends on the limitations of 
your monitor, the amount of VRAM (Video RAM) you have installed, and your 
personal preference. You can experiment with different screen resolutions to 
find the one that works best for you.

To change the screen resolution on Windows 98, Windows Me, or 
Windows NT 4.0 or later:

 1 Save any open projects and close all programs except Digital Image. 
 2 On the Tools menu, click Display Settings. 
 3 Click the Settings tab. 
 4 Under Screen area, move the slider to change the screen resolution, and 

then click OK. 
 5 If prompted, restart your computer. 

Expanding your 
workspace
If you have an older 
or small monitor, the 
default setting may 
be 800 by 600 pixels. 
Increasing the screen 
resolution increases 
the size of the Digital 
Image workspace.
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To change the screen resolution on Windows XP:

 1 Save any open projects and close all programs except Digital Image. 
 2 On the Tools menu, click Display Settings.  
 3 Under Screen resolution, move the slider to change the screen resolution, 

and then click OK. 
 4 If prompted, restart your computer.

When you adjust the screen resolution, you may notice that the viewable area 
becomes de-centered, too narrow, or too short. To center or expand the view-
able area on the screen, use the monitor controls. These controls are usually 
located on the front of the monitor directly below the screen. The controls 
can adjust the width and height of the screen directly, or, on many models, the 
controls open a graphical control screen with menu commands. 

Setting Monitor Color Quality
The monitor color quality setting affects the number of colors in your photos. 
When viewing photos, it’s optimal to have a high-color quality setting, such as 
24-bit color, which can display more than 16 million unique colors.

With a low-color quality setting, such as 256 colors, a monitor cannot display 
all of the colors found in most photographs. Such a monitor badly renders a 
photo containing a section of gradient color, such as a sky that becomes brighter 
toward the horizon. The color transition from dark to light appears  uneven and 
jagged, because the monitor cannot display the fine variations in color.

A monitor with a low-quality color setting cannot show the complete range of colors found in 
most photographs.

For more 
information
For more information 
about changing 
display settings, 
see your Windows 
documentation.

Adjusting your 
monitor’s controls
Refer to your monitor’s 
documentation 
for instructions on 
adjusting the monitor’s 
viewable area.
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Increasing the color quality setting on your monitor can significantly improve 
the way photos look on your screen. As with the screen resolution, adjusting the 
color quality may be limited by your monitor type and the amount of VRAM 
installed on your computer. Increasing screen resolution and increasing color 
quality both require VRAM, so you may have to decrease screen resolution if 
you want to increase color quality. 

To change the color settings on Windows 98, Windows Me, or 
Windows NT 4.0 or later: 

 1 Save any open projects and close all programs except Digital Image. 
 2 On the Tools menu, click Display Settings. 
 3 Click the Settings tab. 
 4 Under Colors, click a color quality, and then click OK. 
 5 If prompted, restart your computer. 

To change the color settings in Windows XP: 

 1 Save any open projects and close all programs except Digital Image. 
 2 On the Tools menu, click Display Settings. 
 3 Click the Settings tab. 
 4 Under Color quality, click a color quality, and then click OK. 
 5 If prompted, restart your computer. 

If you try to adjust your display properties to a color quality setting that 
requires more VRAM than is available, the screen resolution may automatically 
be decreased to allocate VRAM for the increased color quality. Experiment 
with adjusting color quality and screen resolution to find settings that work 
for you. If you cannot adjust both the resolution and color quality settings to 
adequate levels, you may want to have more VRAM installed on your computer 
by a computer technician. 

Color quality in 
Windows XP
If your computer is 
running Windows XP, 
the default color quality 
setting is at least 16-bit 
color.

How many colors 
do you need?
Some monitors allow 
you to adjust the color 
quality to 32-bit, but 
that level may be higher 
than you need. Digital 
Image and most other 
image-editing programs 
convert 32-bit images 
to 24-bit color. But with 
more than 16 million 
colors, the 24-bit 
setting is adequate for 
most circumstances.
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Calibrating for Brightness, Contrast, and RGB 
Values
When you adjust screen resolution and color quality, you are telling your 
computer’s video adapter (sometimes called a video card or display adapter) 
how to send the signals to the monitor. But to adjust brightness, contrast, and 
RGB (red, green, and blue) values, you make the adjustments on the monitor 
itself using the monitor’s controls. These controls are usually located on the 
front of the monitor directly below the screen. 

The monitor’s controls can make adjustments directly, or, on many models, the 
controls open a graphical control screen with menu commands. If you get stuck, 
check your monitor’s manual for instructions on making these adjustments.

The simplest way to calibrate your monitor is to print photos on your home 
printer, and then adjust your monitor to match the prints. This method works 
well if you print most of your photos from your home printer.   

To do a simple monitor calibration:

 1 Make sure that there is no bright light or reflective glare on your monitor 
screen. 

 2 Set your monitor’s brightness and contrast controls at exactly the halfway 
point. Do not reset these controls until specified in this procedure. 

 3 Open a picture in Digital Image that’s familiar to you, preferably an 
image with skin tones and a large area of medium gray. 

 4 Follow the instructions in your printer manual for printing a picture at the 
best quality. If your printer allows, choose RGB as the printing method. 

 5 When the ink has thoroughly dried on the print, place it next to the image 
on the monitor. 

 6 Use the brightness, contrast, and RGB controls on your monitor to make 
the image on the monitor look as close to the print as possible. 

Repeat this process each time you change printer settings, printing inks, paper 
manufacturer and surface, or printing resolution, since all of these variables 
can affect your printing output. Also note the changes for each combination of 
variables.

Adjusting the video 
adapter
Some video adapters 
allow you to make 
adjustments to 
brightness, contrast, 
and RGB values 
through the video 
adapter dialog box.

Let your ink dry 
before calibrating
Some printer inks 
change color slightly 
during the drying 
process, which can 
take as much as eight 
hours. If this is the case 
with your printer, let 
the print dry overnight 
before using it to 
calibrate your monitor. 
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The simple monitor calibration described above assumes that the printer is 
calibrated correctly. This assumption is fine if you always view your pictures 
on the same monitor and print on the same printer. But when you upload your 
pictures to a Web site for printing, or if you send your pictures to be viewed or 
printed on other computers, you may find that the colors are not as accurate. 

For greater color accuracy, you may want to invest in specialized calibration 
instruments and software. Available in camera shops and on the Web, calibra-
tion tools help you get precise calibration for your monitor, so you can generate 
pictures that look equally good on other systems. 

Controlling Ambient Light
After you’ve gone through the trouble of calibrating your monitor, you can 
also regulate the lighting in the room where you use your computer. Without a 
consistent lighting system, the same picture on the same monitor looks different 
in different lighting conditions. Sunlight, fluorescent light, and incandescent 
light all affect how your eyes perceive the light coming from the monitor. To 
get the most consistent results, ensure that you have the same amount and type 
of ambient light in the room when you calibrate your monitor and use Digital 
Image to adjust your pictures for brightness, contrast, and color. Decreasing light 

for best results
If you’re working in 
a room with bright 
ambient light, the photo 
on your monitor seems 
to be less vivid and 
have less contrast, 
especially on flat panel 
monitors or laptop 
computers.

Preserving your 
settings
If you share your 
computer with other 
people, you might want 
cover your monitor’s 
controls with tape to 
keep them in place 
after you’ve calibrated 
the monitor. Tape might 
help the settings from 
being unintentionally 
changed. Just don’t 
make it impossible to 
change them when you 
need to.
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When you’re looking to jump-start your photography, visit the Tips & Tricks 
section of the MSN Photos Web site. Tips & Tricks features articles, interviews, 
industry news, and tips about photography, as well as plenty of dynamic, inspir-
ing photographs.

In this section of the User’s Manual, we’ve selected some of the best articles 
currently running on Tips & Tricks. You can find these articles on the Web site, 
photos.msn.com, along with full-color versions of the accompanying photos. 
The online versions of the articles also contain helpful links to related articles, 
manufacturers’ Web sites, and other sites featuring great photos.

If you enjoy the articles here, check Tips & Tricks regularly for the most recent 
articles, news about the latest gear, and photo tips for current seasons and 
holidays.
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How Photo Savvy Are You?

Online Mini-Course on Photography Basics  

Text and photos by Charlotte K. Lowrie

Knowing the basics of photography is the key to getting the kind of photos you want. For a 
quick review of the basics, take this quiz and test your photographic mettle. (Photo taken at 
f/8, 1/100 sec., zoom lens set to 35mm on a digital camera.)

When was the last time you found yourself “in over your head” during a 
discussion about photography? For most casual and occasional snapshooters, 
the answer may be “every time the subject of photography comes up.” Most 
people don’t want to think about the technical details of making pictures until 
they begin tossing more images into the trash than they paste into the “brag 
book.” This is when many people realize that they need know at least the basics 
of cameras and photography to get consistently good pictures.

Or you may have had an introduction to photographic concepts at some point 
along the way, but the fine points have faded over time. 

Whichever camp you fall into, now’s a good time to see how photo savvy you 
are. Just take the following quiz by matching the term to the correct definition. 
Don’t worry if you don’t already know the fine points of exposure. The answers 
give you the basic information, and, at the end of the quiz, you’ll learn how all 
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of the elements combine to create good exposures, and how you can use them 
creatively.

What is ISO?
a) An abbreviation for Industry Standard Optics that determine the 

resolution of your camera’s lens.
b) I am clueless. Should I care?
c) It indicates how sensitive the film is to light.

Correct answer: C.  ISO and ISO equivalent settings on digital cameras are 
numbers that indicate the film’s or digital image sensor’s sensitivity to light. In 
other words, the amount of light required to make an accurate exposure. The 
higher the ISO number, the more sensitive the film or sensor is to light, or the 
less light will be needed to make a picture. 

The ISO is encoded on film canisters. Most cameras automatically read the code and auto-
matically set the ISO for you.

The ISO sequence runs as 20, 25, 32, 40, 50, 64, 80, 100, 125, 160, 200, 250, 
320, 400 and so on up to 6400, although not all of these numbers are currently 
in use. An easy way to think about ISO is to know that ISO 200 film (or the 
equivalent digital setting) is twice as sensitive to light as the ISO 100 setting. If 
you use ISO 200, the film or image sensor requires half as much light to make 
an exposure as ISO 100 film. Photographers refer to film or settings as being 
slow (under ISO 200), fast (ISO 400 to 800), and very fast (over ISO 800).

Films in the ISO 50 to 100 range are very slow, or they are the least sensitive to 
light. Hence, they require a long exposure, or a “slow shutter speed,” to produce 
a well-exposed image. For example, on a gray, overcast day using ISO 50 film, 
you may need to use a 1/8 sec. shutter speed to photograph a landscape at f/16.

Examples of very fast film include those with an ISO of 1600 and 3200. 
Because these films and settings are very sensitive to light, they require shorter 
exposure times, or a faster shutter speed. On the same overcast day, you could 
switch to ISO 1600 film and take the same landscape picture at f/16 with a 
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shutter speed of 1/250th sec.

Trivia  The ISO numeric rating scale was established by the International 
Organization for Standardization, which combined the older DIN, ASA/ANSI 
systems for international use. 

When you’re shooting with a fast film, you or the camera can select fast shutter 
speeds that reduce the risk of a blurred image caused by subject motion. This 
also allows you to make sharp pictures in low-light situations while hand-hold-
ing the camera. During the short exposure time, blur from movement does not 
have time to register in the image.

On manual cameras, you set the ISO using a ring or dial on the camera. On digital cameras, 
you can set the ISO equivalent setting using an electronic menu.

What are the tradeoffs of using a fast film or setting versus a slow film or 
setting?  The tradeoffs include reduced sharpness and detail, less saturated 
color, and increased grain. Virtually all digicams have higher ISO settings too; 
some set it automatically while others require you to set it. 

In the case of digital cameras, a high “ISO equivalent” setting provides greater 
sensitivity to light just as it does with film. At ISO 400 and higher settings, 
image quality degrades especially by the increased signal noise, which appears 
in pictures as digital grain.

How to set the ISO  The vast majority of newer film cameras automatically read 
the ISO code from the film cartridge, so you don’t have to set the film speed. 
On older cameras, the ISO is set by rotating a dial on the camera’s “shoulder.” 
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This dial generally offers the full range of common ISO numbers from 25 to at 
least 1600.

On a digital camera, the ISO equivalent is usually set using one of the camera’s 
electronic menus or submenus. Some models set the ISO automatically, select-
ing a higher ISO equivalent in low light for faster shutter speeds.

High-speed film, such as the ISO 3200 film used for this photo, tends to exhibit noticeable 
grain, as shown here.

What is aperture?
a) The button you press to take the picture.
b) The size of the lens opening that determines the amount of light that 

strikes the film or image sensor.
c) A technical term that has always confused me even when it’s been 

explained to me, so I just ignore it.

Correct answer: B.  The lens aperture, or opening, determines the amount of 
light that strikes the film or digital image sensor to make the image. Either you 
or the camera’s automatic system can control the size of the lens aperture, or 
opening, by setting an f-stop. Changing the f-stop increases or decreases the 
size of the lens opening. 

Aperture is shown as f-stop numbers, such as f/2.8, f/4, f/5.6, f/8, and so on. 
The smaller f-numbers, such as f/2.8, set the lens to a large opening that allows 
more light to enter the camera. A large opening is often referred to as “wide” 
aperture. 

A small opening is referred to as a “narrow” or “small” aperture and is indi-
cated with large f-numbers such as f/16. As you would expect, a small aperture 
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allows less light to enter the camera. To get a good exposure with a small 
aperture, the amount of time the shutter stays open to let light into the camera 
must be increased. Most cameras automatically adjust the shutter speed when 
they are set in program or semi-automatic mode. If you’re shooting in manual 
mode or with a manual camera, you set a longer shutter speed using a dial on 
the camera or an electronic menu.

Although I shot with a narrow aperture (f/11) the telephoto lens (zoom lens set to 200mm on a 
digital camera) reduced the depth of field in this photo.

Learning the jargon  Switching to a wider aperture is also referred to as 
“opening up.” Switching to a narrow aperture is referred to as “stopping down.”

How to change the aperture  On fully controllable cameras, you can change 
the aperture using the f-stop ring or a dial on the camera body that allows you 
to select an f-stop. Very few compact cameras have a control that allows you 
to select an f-stop. The camera automatically selects an aperture based on the 
available light and the mode, such as a portrait or landscape program. A few of 
the high-end compact cameras allow you to set the f-stop.

On cameras with interchangeable lenses, you set the f-stop using an aperture ring.
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With fully controllable and manual cameras, you can choose among a range 
of apertures. You first select an f-stop (aperture), and then you set the correct 
shutter speed to get a good exposure. The camera’s light meter provides a signal 
in the viewfinder that indicates when you have set the correct shutter speed.

In automatic modes—a shiftable program or aperture-priority semi-automatic 
mode—you select the f-stop (aperture) and the camera sets the shutter speed to 
get the correct exposure.

Which aperture, or f-stop, should you choose?  Your choice depends on two 
factors. First, you want to select an aperture that gives you the right shutter 
speed. For example, if you want to avoid blur from camera shake or subject 
motion, you need to choose a wide aperture (smaller f-stop numbers) so that 
you get the faster shutter speeds. Likewise, if you’re using a telephoto (long) 
lens and hand-holding the camera, you need a very fast shutter speed for sharp 
pictures.  

Second, by intentionally selecting a wide or a narrow aperture (f-stop), you can 
control the “depth of field” in your pictures. For more on that topic, go on to the 
next question.

Choosing a narrow aperture (in this case, f/10) and using a wide-angle lens (zoom lens set to 
17mm on a digital camera), created sharpness throughout the image.

What is depth of field?
a) A term that indicates how much of a scene will be in reasonably sharp 

focus.
b) The size of the area is that’s included within the scene.
c) The focal length of the lens that you’re using.

Correct answer: A.  Depth of field is the zone of acceptably sharp focus in 
front of and behind a subject. For example, a picture in which the background 
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is a soft blur has little depth of field. In another picture, both foreground and 
background elements appear to be in focus; this indicates more extensive depth 
of field. Aperture is the main factor that affects depth of field.

In some situations, you want to increase the depth of field. For example, in a 
scenic photo, choose a narrow aperture; a large f-stop number such as f/16 or 
f/22 so that much of the foreground and background will seem sharp in the 
photo. For other situations, you’ll want to decrease depth of field. For example, 
in a portrait where you want the background to be blurred, choose a wider 
aperture, or a smaller f-stop number, such as f/2.8, f/4, or f/5.6. The subject will 
be in sharp focus, but the background will be “soft,” and less distracting.

Tip  Remember that large numbers enlarge and small numbers shrink. In other 
words, large f-numbers, such as f/22, enlarge the range of acceptably sharp 
focus. Small f-numbers such as f/4 shrink the range of acceptably sharp focus 
and help to blur the foreground and background.

When you choose a small aperture such as f/16, a longer shutter speed is 
required to ensure that enough light reaches the film or sensor for a correct 
exposure. With slower shutter speeds, however, camera shake or subject motion 
can result in blurred pictures. If the shutter speed is slow, use a tripod, or switch 
to a faster film or ISO equivalency setting that allows for faster shutter speeds. 
If you want to “freeze” a moving subject, you’ll need to use a high ISO film.

While aperture is the most important factor that affects the range of acceptably 
sharp focus in a picture, other factors also affect depth of field including:

 Camera-to-subject distance  At any aperture (f-stop), the further you 
are from a subject, the greater the depth of field will be. If you take a 
scenic photo of a distant mountain, the foreground, midground, and 
background may all be in acceptably sharp focus. If you take a head-and-
shoulders portrait, however, only your subject will be in very sharp focus. 

 Focal length of the lens  In simple terms, focal length determines how 
much of a scene the lens “sees.” From the same shooting position, a wide-
angle lens sees more of the scene than a telephoto lens. In addition, a 
wide-angle lens produces an extensive depth of field provided you are not 
extremely close to the subject. In more technical terms, a wide-angle lens 
or zoom setting has a 110-degree angle of view while a telephoto lens 
may have only a 23-, 12-, or even 4-degree (narrow) view of the scene. 
Because a long (or telephoto) lens or zoom setting (any lens or zoom 
setting over 50mm), magnifies the subject, the depth of field is shallow so 
that only the subject is in very sharp focus.
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To blur the background in this photo, I opened up to f/2.8. (Photo taken at 1/100 sec., zoom 
lens set to 200mm on a digital camera.)

Telephoto lenses have a narrow range of view, and they compress perspective as shown in this 
photo. (Photo taken at 1/160 sec., f/14, 300mm prime lens on a digital camera.)

What is shutter speed?
a) How fast a camera takes a picture.
b) How long the light is allowed to enter the camera.
c) How fast light travels from the lens to the shutter.

Correct answer: B.  Shutter speed controls how long the curtain in the camera 
stays open to let light from the lens strike the film or the digital image sensor. 
The longer the shutter stays open, the more light reaches the film (at the 
aperture you set). 

Shutter speeds are shown in fractions of a full second. Common shutter speeds 
(from slow to fast) are: Bulb (the shutter stays open until you close it by releas-
ing the shutter release button), 1 second, 1/2, 1/4, 1/8, 1/15, 1/30, 1/60, 1/125, 
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1/500, 1/1000, and so on. 

How to set the shutter speed  On fully controllable and manual cameras, you 
can set the shutter speed using a dial on the camera, or by selecting it from an 
electronic menu. With single-use and compact cameras, the camera automati-
cally selects the shutter speed based on the available light and the mode you’ve 
chosen. If your camera offers several program modes, for example “sports 
program” mode, it will select the fastest shutter speed to freeze subject motion.

On manual cameras, the shutter speed is set using a dial, such as the one shown here. 

When you increase or decrease the shutter speed by one full setting, it doubles 
or halves the exposure. For example, twice as much light reaches the film at 
1/30 sec. as at 1/60 sec. To assure correct exposure, you need to change the 
aperture (f-stop) as you change to a longer or faster shutter speed. If you shoot 
in program or automatic mode, the camera automatically adjusts the shutter 
speed.

Shutter speed affects your ability to get a sharp image in low light while hand-
holding the camera, and to freeze motion or show it as blurred in a picture.
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To freeze motion, I used a faster shutter speed, in this case, 1/100 sec. (Photo taken at f/4.5, 
zoom lens set to 112mm on a digital camera.)

 Hand-holding limits  As a guideline, never hand-hold a camera at a 
shutter speed slower than the inverse of the focal length of the lens. For 
example, if you’re shooting at a 125mm setting on a zoom lens, you want 
a shutter speed of 1/125 sec. or faster to ensure a sharp picture. Another 
helpful rule is to never hand-hold a camera at shutter speeds slower than 
1/30th of a second. 

 Freezing or blurring subject motion  Shutter speed determines whether 
you can freeze a moving subject or allow it to be blurred in the picture. 
For example, you may want to freeze a basketball player in mid-air, but 
show the motion of water cascading over a waterfall. As a very general 
rule of thumb, to stop motion set the shutter speed to 1/125th of a second 
or faster. To show motion as a blur, try 1/4 sec. or slower and be sure to 
mount the camera on a tripod.

Equivalent exposures
Film or digital image sensors require a certain amount of light to make a 
good exposure. As we’ve seen, two factors determine the amount of light that 
makes the exposure: the size of the lens opening (aperture or f-stop) and the 
shutter speed. Set a wide aperture and you can use a fast shutter speed. Enough 
light will reach the film or image sensor to expose the image. But switch to a 
small aperture (f-stop), and you must use a slower shutter speed to get a good 
exposure. 

Many combinations of aperture (f-stop) and shutter speed produce exactly the 
same exposure; in other words, the same amount of light will expose the image. 
For example, an exposure setting of f/22 at 1/4th second is equivalent to f/16 at 
1/8th second, f/11 at 1/15, f/8 at 1/30th of a second, and so on. That’s because 
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you are decreasing the amount of exposure time as you change to a larger 
aperture.

Although this photo was taken at midday, the shaded area allowed me to reduce the shutter 
speed enough to show the motion of the water as a blur. (Photo taken at 1/30 sec., f/5, zoom 
lens set to 200mm on a digital camera.)

If you use a fully manual camera or operating mode, you must change the shut-
ter speed each time you change the aperture (f-stop). Or you must change the 
aperture each time you change the shutter speed.  

The light meter indicator in the viewfinder will remind you to adjust the set-
tings appropriately. In an automatic mode, the camera will take care of that step 
for you. 

All in-camera light meters read the amount of light reflected from the subject. 
They use this information to calculate the necessary exposure depending on the 
ISO, aperture size, and the shutter speed. If you change the aperture, the cam-
era recalculates the amount of time needed for the exposure. Change the shutter 
speed, and the camera’s meter determines what aperture (f-stop) is required 
for a correct exposure. In a manual operating mode you set both factors, using 
guidance from the light meter. You can try different apertures and shutter speed 
combinations to create different effects in your pictures.

Tip  Many people prefer to shoot in a semi-automatic mode such as aperture-
priority mode. This mode gives them creative control over depth of field and 
eliminates the need to constantly make manual adjustments to the shutter 
speed. In this mode, you set the aperture (f-stop) for the depth of field that you 
want and the camera automatically sets the appropriate shutter speed. Note that 
in shutter-priority mode, you set the shutter speed and the camera automatically 
set the appropriate aperture (f-stop). In either mode, the exposure always 
remains the same or “equivalent.”

These equivalent exposures give you control over the depth of field in your 
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photo, and freeze or blur motion. For example, choose a wide aperture and a 
fast shutter speed combination, and the picture will have a shallow depth of 
field and motion will be frozen. This is often an ideal setting for sports shots. 
With a small aperture and a slow shutter speed combination, depth of field is 
increased but any subject motion will be shown as blurred in the image. You 
can use this combination for creative effect or for pictures of subjects that are 
not moving. For sharp pictures at long shutter speeds, mount the camera on 
a tripod. Depending on your camera, you can choose from among different 
exposure modes ranging from fully automatic to aperture and shutter speed 
priority modes.

For this photo, I chose to use f/5.6 with a zoom lens set to 80mm which allowed me a shutter 
speed of 1/500 sec.

Putting it all together
When you combine film speed, aperture, shutter speed, and the amount of light 
in a scene, you have the essential elements of an exposure. On a bright, sunny 
day you can select from many different f-stops and still get fast shutter speeds 
to prevent image blur. There is little need to switch to a fast film for fast shutter 
speeds at small apertures. A high ISO film is necessary only if you’re using a 
telephoto lens and need very fast shutter speeds.
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Choose an aperture that helps convey the story you want to tell. In this case, I didn’t want 
the background to blur completely because it provided context for the photo. (Photo taken at 
1/250 sec., f/6.3, zoom lens set to 175mm on a digital camera.)

As it begins to get dark, your choice of f-stop will be very limited with slow 
films such as ISO 100 or ISO 200. You’ll need to use wide apertures (f-stops) 
such as f/4 to get a fast shutter speed. Otherwise, your images will show some 
blur from camera shake or subject movement. Switch to a fast ISO 800 film, 
however, and your options increase. Now you can select smaller apertures 
(f-stops) such as f/8 or f/11 for greater depth of field. The fast film allows you to 
shoot at fast shutter speeds to reduce the risk of blurred images.

While many people prefer to shoot in a semi-automatic mode, I typically use manual mode. 
This picture was taken at 1/400 sec. at f/5.6 using a zoom lens set to 17mm on a Nikon D1X 
digital camera.
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While the basic elements of exposure and using them together may seem like 
a lot to digest, you may find it easier to choose one aspect, say aperture, and 
experiment by changing the f-stop to achieve different effects. Your camera 
will tell you what shutter speed to set or it will set it for you. Keep a log or look 
at the shooting information displayed with many digital images to see how 
changing the aperture affects the final image. Then move on to experiment with 
different shutter speeds. If you have a digital camera, it’s the greatest single tool 
you can have to learn photography quickly and inexpensively.

Regardless of what type camera you have, the more pictures you take, the more 
you learn; and the more you learn, the better your pictures will be.

Using a wide-angle lens helped increase depth of field in this photo. (Photo taken at f/6.3, 
1/80 sec., zoom lens set to 35mm on a digital camera.)
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What Makes a Photo Good?

A Short Checklist for Evaluating Photo Quality

Text and photos by Charlotte K. Lowrie

What makes one or two photos rise to the top in a stack of 20, 30, or even 100 
photos? The answer, despite what beginning photographers may imagine, is not 
a secret known only to seasoned photographers and photo editors. Nor is there 
a single element that makes a photo “good.” Rather there is a not-so-secret 
checklist of criteria commonly used to evaluate images.

Having said this, I hasten to add that evaluation checklists vary by person, and, 
like other judging criteria, there are always exceptions to the rules. Further-
more, the lines separating the criteria very often blur. Photography is, after all, 
subjective. 

Despite these disclaimers, knowing the commonly accepted evaluation criteria 
can give you a roadmap to getting better day-to-day photos, and a guide for 
evaluating the final images.

Following is the evaluation list that I use when I review my images and evaluate 
images for the MSN Photo of the Week images. In addition, I’ve included 
sample questions for each checkpoint that you can use or adapt for evaluating 
your photos.

By having a clear center of interest along with subordinate elements that complement the 
subject, the viewer knows immediately what the photo is about.

Is there a clear center of interest? 
In a strong photo, the viewer can immediately identify the subject. While this 
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sounds like a no-brainer, a surprisingly high number of photos fail to clearly 
identify the main subject. Instead, a complex montage of elements compete for 
the viewer’s attention.

In a strong photo, the subject should dominate the image and form the viewer’s 
first impression. If the subject is strong, the viewer’s eyes may move to explore 
other areas of the image, but the eyes are drawn inevitably back to the subject. 

Great examples of this point are pictures of sunsets, an ageless and popular 
photo subject. While the colors and cloud formations of a sunset are dramatic, 
they are seldom enough to create a compelling image. Beyond a quick, though 
perhaps appreciative first glance, most sunset photos are quickly forgotten. And 
in large numbers, they quickly become “ho-hummers.” 

However, when the photographer adds an element that gives the sunset context 
and interest, you have a sunset photo with impact, and one that is far more 
likely to capture and retain the viewer’s interest. The sunset photo here includes 
the activity of people enjoying the last moments of the day against the backdrop 
of the dramatic late-day color.

To evaluate your own photos for a strong center of interest, try asking yourself 
these questions. Or show the picture to a friend and ask your friend to honestly 
answer the questions.

 When you look at the photo, what is the first thing you see? If you’re 
evaluating your own image, is what you see first the subject you had in 
mind for the photograph?

 What holds your eye the longest?
 Do other elements in the image compete with the subject for attention?
 Do technical aspects such as light and the direction of light, depth of field, 

focus, and so on add to or detract from the subject?
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The activity of people on the piers adds interest beyond the colors of the sunset.

Is the image composed well?  
In a strong photo, there should be a sense of overall organization. While entire 
books are written on composition, at the most basic level, composition is the 
process of establishing a sense of order for the elements within an image. 

The lines in this image not only create organization, but also lead the eye through the image.

Note  Composition rules or guidelines are a helpful starting point, but they are 
useful only as long as they enhance the overall image.

As a quick review, here are a few basic composition pointers.

 Fill the frame  Filling the frame helps establish the center of interest, 
and, simultaneously, it helps exclude competing background details. You 
can fill the frame by moving closer to the subject or by using a longer 
focal length (or zooming in).

 Organize elements  In composition, the rule of thirds is often used to 
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organize elements in a composition. This rule is derived from the Golden 
Section or Golden Rectangle that divides a space, such as a photographic 
frame, into equal segments to create pleasing proportions. In simple 
terms, if you apply the rule of thirds in photography you simply imagine 
a tick-tac-toe pattern on the viewfinder. Then, when you place the subject 
of the photo at one of the intersection points, the result is a pleasing sense 
of order. 

 Control the background  A non-distracting background is a compo-
sitional tool to help bring attention to the subject of the photo. You can 
control the background by moving your position or moving the subject 
to avoid background distractions and by using a wider aperture (smaller 
f-stop) to blur the background. It’s a good practice to review the entire 
scene and, when possible, eliminate or rearrange as many distracting 
background elements.

 Keep it simple  The fewer the elements in a photo, the stronger the 
statement the image makes. Simplicity also helps prevent the viewer’s eye 
from being distracted.

To evaluate the composition of your images, try asking these questions.

 Is there a sense of order and balance in the image that helps lead the eye 
through the composition?

 Are elements included that do not contribute to the subject of the image?
 Are elements excluded that, if included, would have enhanced the subject 

of the image?
 Do the depth of field, focal length (lens or zoom setting), lighting, angle, 

and perspective enhance the composition?
 Does the crop enhance the composition?

Is the focus crisp and is the exposure appropriate?  
With the exception of photos that either intentionally show motion or are taken 
as soft-focus images (such as a portrait), tack-sharp focus is one of the first 
things that everyone notices first about an image. Going a step further, the 
center of focus should be on the center of interest of the subject. In other words, 
if the picture is of a person, the focus should be on the person’s eyes. The sharp-
est point of the picture should pinpoint what the photographer sees as the most 
important aspect of the image.

The exposure (the combination of focal length [lens or zoom setting], aperture, 
shutter speed, and ISO) should also enhance the intent of the photo. For 
example, in a scene of an old building, did the photographer use exposure 
controls to emphasize the age of the structure and perhaps the starkness of the 
surroundings? To create this sense, a photographer can choose a moderately 
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wide-angle lens or zoom setting, use black-and-white mode, choose a higher 
ISO (or use a high-ISO black-and-white film) set a narrow aperture (larger 
f-stop number), and choose a fast shutter speed (depending, of course, on the 
light). This combination would produce sharp detail, visible grain or digital 
noise to enhance the sense of antiquity, and increased depth of field to empha-
size the sense of loneliness.

On the other hand, if the image is a portrait of a person, I would look for quite 
different exposure settings, for example, a low ISO, a wide aperture (small 
f-stop number), and, depending on the light, a slower shutter speed. In this 
case, the portrait would have little or no grain or digital noise and the narrow 
depth of field would blur the background to emphasize the subject. (Of course, a 
photographer might choose the opposite setting to achieve an entirely different 
look.) The question is whether the exposure settings were planned to enhance 
the image “design.”

Questions that can help you evaluate whether focus and exposure settings are 
appropriate for an image include:

 Is the sharpest point in the image on the center of interest of the subject of 
the photo?

 Does the depth of field enhance the subject, mood, or look of the image or 
does it distract from it?

 Does the focal length or zoom setting enhance the subject and message?
 Does the image have good overall contrast for the type image the photog-

rapher intended?
 Does the color appear natural and/or does it help set the mood of the 

image?
 If the image is in color, would it be stronger in black and white, or vice 

versa?

The sharpest focus should be on the most important aspect of the subject. For pictures of 
people, the sharpest focus point should be on the subject’s eyes.
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Does the photo tell a story? 
Most often, the difference between a photo you remember and one that you 
quickly forget depends on whether the photo tells a story. As a viewer, I want to 
see the story, and this is one of the most important evaluation points I look for 
in other photographer’s images. It is also the element that I always try to include 
in my images.

In strong photos, the story is revealed at first glance, and it is self-contained. 
In the best images, the story evokes an emotional response from the viewer. I 
believe it’s that emotional response that ultimately makes the image memorable.

Try asking these questions as you evaluate images to decide if the image tells a 
story.

 At a minimum, does the photo make a statement that you can articulate?
 Does the photo elicit an emotion? In other words, can you relate to the 

subject or the situation?
 What could be changed in the image to give it a stronger story or mes-

sage?

Photos that tell a story are always strongest, even if they fail to meet some of the other criteria.

Does the lighting enhance the subject and message?  
Like the composition, lighting is a subject that is worthy of book-length 
discussions. Whether in shooting or evaluating photos, light should be used to 
its maximum potential to reveal what’s important in the image and to set the 
overall tone of the photo.

In masterful hands, lighting is used selectively to focus attention on specific 
areas of the subject while simultaneously de-emphasizing less important areas, 
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to guide leading the eye through the composition, and to establish the overall 
mood and tone of the image by taking advantage of the different temperatures 
(colors) of light.

Light is another “design tool” that can be used to enhance the overall mood and 
intent of the image and subject. For example, when taking a portrait of a man, a 
strong, unfiltered white side light may be appropriate because it emphasizes the 
man’s rugged and angular features. On the other hand, a soft, warm-color dif-
fused light is more appropriate for a portrait of a woman because it mirrors the 
delicate features of these subjects. And, of course, there are few photographers 
who fail to take advantage of the superb colors of light during sunrises and 
sunsets.

When evaluating the lighting merits of a photo, ask:

 Is the intensity and color of light appropriate for the subject?
 Is the light too harsh, too contrasty, or is it too soft and too flat?
 Are all important aspects of the subject well lit, or could the lighting be 

improved by using a flash, fill flash, reflector, or auxiliary light?
 Does the light help convey the overall message of the photo? 
 In a color photo, is the color balanced or corrected for the light tempera-

ture (in other words, the overall color should be natural-looking). And if 
it isn’t, does the color cast contribute to the photo?

The right angle and quality of light can transform everyday scenes and objects into photo 
opportunities.

Is the approach creative?  
In broad terms, I define “creative” as an image that goes beyond predictable 
techniques and treatments. In more specific terms, the best creative images 
show subjects through the photographers’ eyes and perspective. In other words, 
the photographer reveals the subject in extraordinary ways: ways that the 
viewer otherwise would not have seen.
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Creative techniques and subjects can range from bringing abstract ideas into a 
visual form, taking a concrete idea and making it abstract, relating or associat-
ing unrelated concepts into a visual space, or, in short, taking a fresh look at 
and lending the photographer’s unique thinking and vision about any subject.

When evaluating the creativity of a photo, ask yourself:

 Does the photo disclose more about the subject, or show it in unexpected 
ways?

 Does the photo relate visual elements in unusual and intriguing ways?
 Is the photo interesting and fresh, or is it just too weird for words?

A creative approach reveals the subject in uncommon ways.

Depending on the day, and depending on the photo, I may add other criteria to 
my evaluation checklist, but I seldom delete one of these basic six points. In the 
real world, I also know that if 10 people look at the same photo, approximately 
five may give it good marks and five may give it low marks. Photography is, of 
course, as subjective as individual taste.

But when everyone has had their say, the bottom line is that you now have 
evaluation criteria so that you can evaluate your own work. If an image is your 
best so far, enjoy the image and your achievement. Then go back in a month or 
two and evaluate the image against the six basic criteria again. If it still passes 
the test, frame it and hang it on the wall, and then go out and shoot a better 
picture. 
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Photo opportunities can pop up anytime and anywhere. If you have your camera with you, you 
can take advantage of scenes such as this.
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Photo Challenge: Tell a Story

Take a Picture That’s Worth a Thousand Words  

Text and photos by Charlotte K. Lowrie

The toughest challenge in photography is to tell a story in a single image. 

In “Beyond Pretty Pictures,” an article that we ran earlier this year, profes-
sional photographer Paul Liebhardt describes what makes pictures truly great. 
According to Liebhardt, if a picture doesn’t have meaning—if it doesn’t tell a 
story—the image is just another pretty picture. And to tell a story, you must 
know the subject well. For Liebhardt, this means spending time with the people 
and places he photographs. “You have to give the viewer something that he 
sees that makes him understand it all,” he explains. Even little things, no matter 
where they are, can set the picture off, Liebhardt says.

Photographs are a powerful way to tell a story. Last week I chatted with Leslie 
Fratkin, a professional photographer based in New York City, who echoed 
Liebhardt’s sentiments. Recently for Fratkin, telling the story has meant helping 
those who know the subject best tell their story.
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This shot is symbolic of the Seattle earthquake aftermath. 

Fratkin felt so strongly about the stories told in the images taken by Sarajevo 
photographers during the Bosnian war that she committed the last five years 
to getting their stories told—in images. She created the book and exhibition in 
which the images taken by nine Sarajevo photographers tell the story of war 
from their intensely personal perspective. 

The hardest part
This challenge—shooting the story in a single shot—isn’t easy. By comparison, 
it makes perfecting the technical aspects of an image look like child’s play. But 
I’ve spent the past few months trying it anyway. And I continue to try.

This photo challenge has the potential for changing the way you shoot every 
image, whether it’s pictures of your children, of your family, of nature, or of 
still-life scenes. If you’re like me, you’ll think a lot about what telling the story 
means. Remember that the key is to convey the meaning to viewers, to help 
them understand what you understand about the subject. 

Lessons along the way
Here are some of the things I’ve learned about using my camera to tell a story:

1 Most often, what you see in front of you is a pretty picture, but it isn’t the 
story.

2 To understand the story, whether it’s small, large, humorous, or profound, 
you have to contemplate, research, watch, and talk—but mostly listen. 
I’ve spent time thinking, reading, and asking about the “meaning” of 
people, trees, rivers, places, and my cat. I’ve gone back to the same 
place over and over and gotten better and better (read: more meaningful) 
images with each successive trip.
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Children often present the best opportunities to tell visual stories. 

3 Every so often, if you’re persistent enough, fate presents you with 
“gimme” picture stories. This article features some of my “gimme” 
images. To take advantage of the “gimme” shots, you have to have a 
camera in your hands, and you have to react quickly. It is entirely possible 
to miss the shot if you’re fumbling around getting ready to shoot.

4 Unlike pretty pictures, pictures that capture the essence of a subject can 
have technical flaws and still be keepers. Though you may wish you 
had every technicality nailed, it’s okay if the image is less than perfect 
because it has the strength to stand on its own merit. In other words, 
being off by an f-stop doesn’t diminish the story.

5 Shooting meaningful images is tough. Once I committed to this shooting 
philosophy, I found myself making “deals” with myself—reminiscent of 
the deals I make with myself while I’m on a diet or trying to stop smok-
ing. I tell myself that nature’s beauty tells its own story, and so it’s okay 
just to shoot a pretty stream. And I still photograph beauty, but I know 
that if I studied the stream, if I followed it to its source, there would be a 
story—and there would be a very different picture.

6 There should be rules for shooting stories. I didn’t know the rules, so I 
made up my own. For example, I consider it cheating to set up shots by 
using unnatural props. In other words, if adding an object to a scene helps 
tell the story, the object is only okay if it is part of the subject’s natural 
context. But it’s not okay to carry props, like stuffed animals, in the car 
and add them to a scene, such as a park bench. 

7 Instead of shooting right away, I look around, get to know the place, 
understand what’s happening, and look more closely at what I’m seeing. 
I take as many pictures as always, but most of them are taken later rather 
than sooner.
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Waiting to find the story—to understand the story—is certain to frustrate 
anyone who is inherently impatient or anxious to get images in the canister or 
on the memory card quickly.

Your turn
If you have trouble getting started, start with your own story. Take pictures that 
tell about you—what you do, what matters to you, or what you want to be or do.
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Weekend Photo Ideas

What Else Is There to Photograph?

Text and photos by Charlotte K. Lowrie

Having trouble finding photo subjects? Try borrowing flower arrangements from your manager, 
as I sometimes do, or try some of the ideas in this article.

When it comes to photos, there’s a pecking order in our group at the office. 
Those with children, especially young children, are at the top of the photo peck-
ing order. Why, you might ask? The answer is that this group is the enviable 
enclave with live-in photography subjects. 

Next in the hierarchy are people with pets, preferably docile pets, trained or 
caged pets, or pets with interesting personalities or habits—in other words, pets 
that give you half a chance to get a few good shots.

On the third rung in the hierarchy are people involved in interesting sports. 
With some sports—volleyball and baseball, for instance—it’s hard to partici-
pate and take pictures simultaneously, but the result can be exciting images. 
The downside, especially with slower-paced sports such as golf, is that pictures 
can be dull and predictably repetitive. But any sport is better than having no 
photo subjects at all.

The rest of us in the group sink ignominiously to the bottom of the heap. We’re 
the ones who often drift aimlessly through the hallways in search of something 
interesting to shoot.
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The search for subjects
Finding photography subjects is a big challenge. In repeated attempts to cope 
with this challenge, I have sent myself flowers to photograph, borrowed floral 
arrangements from my manager, and begged coworkers to bring in their kids. 

This is an example of photo subjects I recruited at the grocery store.

In fact, on rainy days, I sometimes go to buy groceries, but forget to pick up 
what’s on the shopping list because I become engrossed in finding prize fruits 
and vegetables to photograph. I carefully select each piece, rejecting specimens 
with bruises or deformities, and walk away with three prize mushrooms, half a 
dozen peppers, and a handful of well-chosen chilies. The checkout people have 
stopped looking quizzically at the odd assortment of groceries, and, long ago, I 
stopped feeling compelled to explain.

But I’ve recently learned that those of us at the office who have no on-location 
photo subjects are not alone. There are other subject-less readers with cameras 
in hand wondering, “What else is there to shoot?” Beyond the obvious and 
easy-to-shoot subjects like relatives, friends, and local tourist attractions, what 
do you shoot? In the best of all worlds, you would hope that whatever “it” might 
be would also be interesting and inspiring. 

Give yourself an assignment
The approach I described earlier of going to the grocery store is, admittedly, 
a bit random. But randomness aside, my grocery-store, hardware-store, and 
garage-sale approaches have forced me to “see” things more carefully than ever 
before. I have spent hours photographing grocery-store mushrooms. Because 
I have no built-in subjects, I’ve learned to look very closely at the things I’ve 
found to photograph—even mushrooms. 
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However, if mushrooms don’t appeal to you, then one of the best ways to solve 
the dilemma of what to shoot is to give yourself an assignment. For example, 
shoot everyday objects and people from the perspective of a child. Do some 
research for the assignment and find out how tall a three-year-old child is, and 
then shoot from that height and that mental and emotional viewpoint. With 
every assignment, work on techniques such as perspective, depth of field, and 
macro photography. Experiment with different shutter speeds and focal lengths.

Here are some more ideas for finding interesting and inspiring photography 
subjects.

People and things  Public parks are ideal for photographing people and their 
playthings. For example, parks are a great place to get shots of details on 
a bicycle, sports equipment in a heap on the basketball court sidelines, the 
silhouette of a child playing on the slide, or a boat floating lazily on the lake. In 
the park and in public, always ask permission before you photograph people and 
children—and even pets.

The park is a great place to find photo subjects.

Use your time in the park to work on techniques, such as low-light shooting, 
panning, action shots, and cutaway shots. This is also a good place to use a long 
lens, or to switch to telephoto mode, so that you can remain unobtrusive to the 
activity going on in the park.

Still life  Virtually anything you have around the house is fair game for a great 
still-life photograph, from cut crystal to old brooms to nuts and bolts. Try pho-
tographing a wine glass, a sandwich, fruits and vegetables, a piano keyboard, 
musical instruments, game tables, and a meal on a platter. Portray life on a 
miniature scale by photographing old dolls and toys. Arrange the subjects as an 
artistic composition, and then experiment with using window light, a flash, a 
flashlight, or household lamps. You’ll find that every subject presents different 
shooting challenges such as lighting, composition, and texture.

Real life  Tell a story. There is no more powerful use for a camera than for 
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telling a story. Photojournalists travel thousands of miles to tell stories of 
international import. But you don’t have to go that far to tell the story of your 
life, or the life of someone close to you. For example, one reader recently had 
a photo epiphany—she decided to use her camera to tell the story of her aging 
mother. Stories of life are close by, and they are powerful, compelling subjects 
for photographers of all skill levels.

Controlling depth of field and using selective focus can produce interesting images that convey 
information about the subject, such as the remoteness of this cabin in the woods. 

Childhood memories  Recall the activities and symbols that were special to 
you during childhood, and try re-creating those memories photographically. For 
example, if you had a tree swing, find a local tree swing, and then photograph 
it in a way that evokes the emotions you recall feeling when you were a child. 
Or, go back to a familiar place from childhood, and photograph it from your 
childhood perspective. The hardest thing about making these images is infusing 
them with the emotion and meaning you want to express.

Choose a single subject and photograph it repeatedly to help develop your technique and 
personal style.
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A word  Pick a word and photograph it. For example, what does “lonely” look 
like photographically? How would you photograph happiness, sadness, beauty, 
energy, imagination, creativity, hope, or productivity? Use the palette of light to 
help express the word—the golden quality of sunset, the rich pastels of sunrise, 
and the harsh flat light of midday can all help characterize the word you’re 
illustrating.

One just like that  Find a picture from a book, magazine, or Web site that you 
wish you’d taken, and then try to re-create the image. This is another good way 
to learn about technique. Try to duplicate the light, the tone, or the perspec-
tive—whatever it is that makes the image appealing. Then branch out and 
create a similar composition of your own. 

Whether you’re photographing mushrooms from the grocery store, or a 
slice-of-life story, just taking pictures continually and consistently pays huge 
dividends—not the least of which is to help you define your style and voice as a 
photographer.
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Six Easy Ways to Improve Your Photography

Fixing What New Gear Can’t

Text and photos by Charlotte K. Lowrie

Spending time figuring out what it takes to get better pictures can make a noticeable differ-
ence in the quality of your photography.

In photography, there are two basic kinds of “stuff”: thinking stuff—the 
way you take your photographs (planning, composing, and shooting)—and 
gear stuff (cameras and accessories). While either kind of stuff can improve 
your photography, most people like to think that new gear will be the magic 
bullet that turns ho-hum shots into blue-ribbon winners. You know the kind 
of rationale I’m talking about: “Get the latest and highest-megapixel camera 
or scanner, and you’ll get better pictures.” That reasoning may work for truly 
antiquated equipment, but new gear won’t fix how you take photographs.

I speak from experience. I just bought new gear stuff, and, sure enough, the 
image quality—the resolution—jumped to astounding heights (and image file 
sizes), but the kinds of images I got—the quality—didn’t change. Despite my 
spending enough money to support a small third-world nation for a year, the 
bottom line was that to get better pictures, I had to get better at taking them. 
It sounds simplistic, but in the rush for new and better technology, it’s a point 
easily overlooked.

So I spent two weeks of vacation figuring out the thinking stuff and came up 
with a personal list of improvement techniques. The list evolved over the two 
weeks, so some of these techniques have been more fully explored than others. 
Although this is my personal list, I suspect you’ll find one or more of these 
techniques useful in your photography.



212 Chapter 15: The Best of Tips & Tricks

Microsoft Digital Image Suite User’s Manual

213Chapter 15: The Best of Tips & Tricks

Microsoft Digital Image Suite User’s Manual

Pushing the hand-holding limit at slow shutter speeds is one of the patterns I determined to 
resolve.

1. Stop making the same stupid mistakes
Identify the problem  I spent a reflective afternoon sorting through image 
archives. Patterns emerged. Whether a result of time pressure or old habits, 
I found that my lousy shots were all lousy in the same old, tiresome ways. 
Granted, there is a lot to remember before pressing the shutter release button, 
but, I finally had to ask, how many ways could I find to screw up what should 
have been a good photo? 

For example, one embarrassing pattern was my persistent “snapshot” tendency: 
taking the obvious shot without exploring alternatives that could give the image 
more impact and interest. Other patterns I noticed included:

 Obvious floundering with mixed-lighting scenes and scenes that com-
bined extreme lighting (very dark and very light areas in the scene). 

 Pushing the limit on hand-holding the camera at slower shutter speeds, 
and, what’s worse, routinely trying to rescue marginally sharp images on 
the computer. Dumb, really dumb, since I own an adequate (though heavy 
and cumbersome) tripod. 

 Managing to either botch in-camera cropping (sort of the same thing as 
not seeing the “real” picture) or focus to one side or the other of where the 
focus should have been. I hate it when that happens, especially when it 
happens on a regular basis.

Solve the problem  I did some research on how to solve problems such as 
mixed lighting and extreme lighting differences. I made a list of my problem 
patterns on an index card, and then I put the index card on top of my camera 
in my camera bag. I hate having little pieces of paper floating around, so I 
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knew this card would irritate me, which would force me to handle it—and read 
it—before I began using the camera. 

Now I try to see things in ways that give the viewer a sense of the subject or experience.

2. Compare your shots to those you wish you’d taken
Compare work with other photos  The next afternoon I went through a stack 
of magazines, books, and brochures that I’d been collecting. I found pictures 
like the kind of shots I most often take, and then tore out the pictures or flagged 
them. Then I got out my photo archive and matched up pictures by category. 
For example, I stacked my nature shots alongside professional nature shots, 
my still-life images next to professional still-life images, and so on. Then I 
compared them side by side. 

Try new approaches  The goal of this exercise was to determine ways in which 
I can improve my approach to specific types of photographs. Because I hate 
copying anyone’s work, whether it’s a personal style or a standard technique, 
I studied the differences between the shots I’d collected and my shots, looking 
for variations that would give my photos more creative punch without copying 
someone else’s methods. For each category of shots, I made an initial list of 
impressions and ideas. I waited a couple of days, and then revised the list of 
ideas. (For me, the waiting time is incubation, the time it takes me to refine 
ideas.) 

I chose one of the categories and experimented with the approach I envisioned. 
In some cases, I realized quickly that I needed to do more research and experi-
mentation. In other cases, the approach just didn’t work. As of this writing, I 
continue to test and revise the new approaches.
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By the time I began shooting, I had a sense of the everyday activity of the market, including 
this routine of throwing ice on the fish throughout the day.

3. Wait a long time before you start shooting
Understand why it’s good to wait  The idea of waiting to shoot is something 
I’ve known but haven’t practiced regularly, as was clear in some of my photos. 
Taking time to get to know the subject, whether it is a location or a person, 
almost always produces better photos than pointing and snapping a picture of 
the first subject that crosses the viewfinder. 

Be patient  To break my pattern of taking obvious shots, I went to Pike Place 
Market in Seattle one morning. Although I had the camera ready, I forced 
myself to walk around and sit in various areas of the market and watch the 
activity. I chatted with market vendors, munched a bagel and drank coffee, and 
watched some more. By lunchtime, I had a sense of the market activity and 
flow, not to mention that, to my delight, the light had changed from dull gray to 
moderately sunny. 

I met people who allowed me to shoot from vantage points that I wouldn’t have had access to 
otherwise.
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Instead of randomly shooting as I learned the scene or subject, waiting to shoot 
gave me a clear sense of where and what the best pictures were. During the 
getting-to-know-you time in Pike Place Market, I made new acquaintances 
who were willing to let me shoot from vantage points that I wouldn’t have had 
access to otherwise. Furthermore, I found that while I took the same number of 
pictures, I concentrated on fewer locations and got better results.

Training myself to shoot quickly is still work in progress, but instinct produced this shot of girls 
playing in the surf.
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4. Shoot instinctively and quickly
Point and shoot now  Although this seems to contradict my previous guideline, 
I think of it as the complementary flip side of waiting to shoot. In any scene, 
there are shots that I see in an instant from the corner of my eye or over my 
shoulder as I walk away. There are also those “just right” shots that demand 
no-hesitation shooting. 

Shoot quickly  Quick, instinctive shots are bread-and-butter images for news 
and sports photographers, but instinctive shooting doesn’t come naturally to 
me. To capture the spontaneous moments, I realized that I had to teach myself 
to literally point and shoot, doing the best I could with settings and composition 
without missing the shot. The results of my first instinctive shots were a mixed 
bag. Certainly the images needed more work on the computer than my other 
images. To get good quick shots, I have to know the camera controls inside 
and out, backward and forward. While I’m still not good with quick shots, I 
am practicing at home with a puppy who offers endless instinctive shooting 
opportunities. 

A third trip to the same location was the charm: The interesting lighting was the element that 
had been missing in earlier shots.

5. Reshoot
Be your own critic  As I reviewed my photos, I would look at a picture and 
instantly know how I would shoot the image differently. While I regularly go 
back to scenes to reshoot, it’s usually to get different lighting or to shoot from 
a different vantage point or perspective. In reviewing my images, I most often 
thought I’d like to change the composition, or focus on more specific aspects of 
the scene or subject. In my self-review, I realized that time, experience, and an 
evolving personal style all factored into my evaluation of how I’d reshoot the 
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picture.

Keep going back  If the subject was worth shooting the first time, chances are 
good that it’s worth shooting again, with and from a new perspective, from a 
different angle or vantage point, and in different light. But more important, the 
more often you go back and reshoot, the more you familiar you are with the 
subject, and the better your images of it are.

6. Get a second opinion
Get input  I’m fortunate to have at the office a number of avid photographer 
friends who also have a great eye for photography. We regularly share photos 
and exchange critiques. Through this ongoing exchange, I see images through 
their eyes and look at each image more objectively. We discuss all aspects of 
our images, such as different ways an image might be cropped for more impact 
or how a different aperture would better convey the message.

This instinctive shot became one of my favorites.

Decide whom to ask  If you have friends who enjoy photography, arrange a 
time when you can go through a stack of each other’s photos and give honest 
feedback and ideas. Or just ask around: Anyone with an eye for design, com-
position, and style can give you valuable feedback. Even untrained friends and 
family will see elements in your photos that you may not have noticed. Almost 
all feedback provides valuable insight and ideas.

Has this self-evaluation made a difference for me? It has, even in the short 
term. And I expect it will make a more noticeable change in the long term. You 
may not want to spend vacation time (like I did) analyzing your photos, but 
these ideas can be tried in an evening or a weekend. Whatever time you have, 
invest it in your photography. I think you’ll find that it’s well worth the time. 
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Six Digital Photo Problems

And How to Avoid Them

Text and photos by Charlotte K. Lowrie

Learning the peculiarities of a digital camera, such as setting the white balance correctly, can 
save lots of computer time when you try to correct an image later. 

You finally got a digital camera. Gut-level, you know that photographic nirvana 
is now within your grasp. Now you have the power. You can see and correct 
lousy shots on the spot. You can correct the flaws in your digital darkroom. You 
smirk, thinking that you’ll never again pay for 36 weirdly tinted glossy prints 
from the local lab. Never again will you slink out the door convinced that you 
are the world’s only perpetual walking photographic failure.

But as images begin rolling off the camera and onto your computer’s hard disk, 
the reality fairy appears, and nirvana’s glow begins to fade. Regardless of how 
you shoot, some images have stark-white highlight areas. On other images, the 
focus lists somewhere to the right of crisp. And on others it’s clear that you have 
single-handedly invented previously unknown categories of bizarre color tints. 
You become deeply depressed.

Okay, maybe not deeply depressed, but at least way frustrated. But get a grip. 
The message the reality fairy is trying to get across is that digital cameras, like 
their film counterparts, present a unique a set of challenges. And nirvana is, 
after all, elusive at best.

The truth is that, with a digital camera, you do have more power over your 
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images both when you take them and when you correct them. But unless you 
want to spend long hours at the computer correcting problems, it’s prudent to 
modify some of your shooting techniques for digital images.

Here are a few of the characteristic problems associated with digital cameras, 
and tips on how to avoid them.

Getting to know the peculiarities of your digital camera is the key to getting the best digital 
images.

1. Bizarre colors happen
Too green, too yellow, or too blue images most often mean that you didn’t set 
the white balance before you took the picture. What, you may still be asking, 
is a “white balance setting”? The white balance setting tells the camera the 
type (specifically, the color temperature) of the light you’re shooting in. In 
turn, the camera looks at the setting you chose, and adjusts colors so that white 
objects appear white in the final image. White balance settings are the digital 
equivalent of choosing daylight versus tungsten film, or using color-compensa-
tion filters.

For example, if you take a picture under fluorescent lights, and you neglect 
to set the white balance to fluorescent, the picture will have an unattractive 
green cast. If you take a picture under common household (tungsten or other 
incandescent) light, the picture will have an equally unattractive yellow cast.
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In this picture, the white balance was set to tungsten, and the color balance in the image is 
accurate. Photo taken with an Olympus Camedia D-230.

How to avoid it  Many cameras have white balance settings that cover the 
spectrum of different color temperatures. If you don’t already know, learn how 
to set the white balance on your camera. Usually the white balance setting is 
displayed on the LCD as part of the current exposure information. You can 
change it using the camera menus (for example, under the recording menu) or 
camera settings. Once you know how to set the white balance, the trick is to 
remember to set it to match the light before you take a picture.

Alternatively, you can set the white balance to automatic, and let the camera 
calculate the temperature for you. Set to automatic, the camera will get it right 
sometimes, and sometimes not.

Some cameras also offer manual white balance settings. To manually set the 
white balance, you point the camera at a white object that fills the entire frame, 
and then press a button. The camera adjusts the color balance for the specific 
scene. This is the most accurate method, and the one to use when you need the 
assurance that colors will be accurately reproduced in the final image.

Note  If your camera offers RAW mode, and you shoot in RAW mode, white 
balance settings may or may not be recorded. However, white balance, along 
with other exposure settings, can be set or adjusted after the fact using the 
manufacturer’s postcapture software.

2. Focus is fuzzy

Digital cameras, perhaps even more than conventional cameras, can produce 
images with less-than-tack-sharp focus. Because many digital cameras are very 
lightweight, holding them steady in even the best light can be tricky.

A few models still have the bothersome problem of shutter lag, the interval 
between the time you focus and press the shutter release button, and the time 
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the exposure is complete. In that interval, the subject can move, or you can 
inadvertently move the camera, thinking the exposure is complete, either of 
which results in fuzzy, out-of-focus images.

In some otherwise hopeless images, you can, of course, claim the result was intentional, along 
the lines of flexing of your creative muscles.

How to avoid it  Some of the newer digital cameras have image stabilization 
features to help overcome this problem. If your camera has this feature, be sure 
to use it. 

If your camera doesn’t have image stabilization features, look for ways to 
steady the camera. For example, take pictures using the viewfinder instead of 
the LCD. Placing the camera up to your eye and having your arms close to your 
body helps stabilize the camera. You can also use a lightweight monopod or 
tripod, or you can sit the camera on a solid surface to take pictures.

Remember that what looks sharp in the LCD may not be sharp when you see it 
at full size on the computer screen. Many cameras allow you to zoom the image 
in the LCD. Get in the habit of using the LCD zoom to confirm whether the 
focus is sharp.

Taking the time to zoom in the LCD image is impractical while you’re shooting 
a rapid sequence of shots,for example, a child blowing out candles on a birthday 
cake. For a quick sequence of shots, try using the burst or “best of the series” 
option, if your camera offers it.

In addition, keep in mind that virtually all autofocus systems have difficulty 
focusing on certain subjects. These include smooth and continuous tone 
subjects, finely patterned objects, subjects with objects in front of them (such as 
animals in a cage), and subjects that have little contrast with the background.
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3. Don’t blow the details
White areas in the image that have no detail are called blown highlights. While 
this problem isn’t confined to the digital camera arena, it is more prevalent with 
digital images than with film. Blown-out highlights are most common in flash 
pictures where the photographer was too close to the subject. But highlight 
blowout can happen with almost any well-lit subject. 

And just as with film images, if the camera does not record detail in an area, 
highlight or shadow, no amount of image-editing (in this case, burning in) can 
put in detail that was never recorded. 

Highlight blowout is evident on the upper area of the train in this picture.

How to avoid it  Some cameras offer a playback mode that highlights blown-
out areas as flashing areas. If your camera has this feature, use it. If you see that 
the image has blown-out highlights, retake it, metering on the lightest area in 
the scene.

If your camera doesn’t have this functionality, make it a habit to meter on the 
lightest area of your primary subject, for example, a place where the light is 
striking a surface directly. Then take the picture at the meter reading you get 
for that area. Then take at least two more shots, decreasing the exposure in each 
one.

There will always be scenes in which the lighting differences are too great for 
both the light and dark areas of the image to be accurately exposed. In those 
types of scenes, try to change your shooting position to lessen or eliminate the 
amount of very light area or very dark area included in the frame.

For example, if you’re shooting a landscape scene that has a bright sky and a 
darker foreground, tilt the camera up to have more sky in the frame, or down 
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to include more foreground (depending on which area is your primary subject). 
Then meter for the area that is your primary subject.

Although this picture was taken on a sunny day, I avoided blowing out the highlights by meter-
ing for the lightest areas.

4. Size does matter
If you have a limited supply of memory cards (and who doesn’t?), you may 
choose to shoot at the medium- or low-resolution setting on the camera and 
use high compression. This tactic certainly allows you to get more shots on 
a memory card, but it doesn’t guarantee that you’ll be able to get the quality 
enlargements you may later want from the images.

How to avoid it  My approach is to set my camera on the highest resolution and 
to review pictures frequently as I shoot, deleting pictures that I’m (absolutely) 
certain I don’t want. However, if I’ve bracketed a series of shots, I make a 
mental note to not delete any of those images. Also, since the price for memory 
storage media is declining, it makes sense to pick up an extra card or memory 
stick as the budget allows.

5. Flash causes hot spots
The flash, onboard or external, can be either your best friend or your worst 
enemy. The latter is most often the case. But because a digital camera offers 
you unlimited free testing, there is no longer any reason to perpetuate this 
problem.
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Besides obliterating details you might like to maintain in the picture, built-in flash units also 
cause hot spots, as shown in the area in front of the puppy, that are time-consuming and 
frustrating to fix.

How to avoid it  First, find the manual that came with the camera, and look up 
the flash range the manufacturer recommends. Then test the flash range to get 
a personal feel for the recommended distances. Instead of subjecting your child 
or pet to the flash test shots, sit a household object like a pillow or a basket on a 
chair, turn on the flash, and then take test shots standing at different distances 
from the subject.

If images are too light, note how close you were to the subject and step back. If 
the images have dark outer edges, or “flash fall-off,” step in closer to the sub-
ject. Also look for obvious hot spots, and determine whether you need to dial 
down the flash unit’s power (if your camera offers this option) or use a diffuser 
(either homemade or commercial) on the flash unit.

6. Eerie patterns emerge
Moiré, (pronounced mwah-RAY ), is a pattern of wavy or rippled lines created 
when repetitive elements intersect. You can see this effect by looking through 
two wire screens, and then rotating one slightly. You also can sometimes see a 
moire in newspaper photographs when the printer’s halftone screen intersects at 
an angle that creates an eerie pattern.

The image sensors in most digital cameras are composed of a grid of light-sen-
sitive cells. When you photograph repetitive patterns (bars, stripes, plaids, and 
so on), an interference pattern, or moiré, can result. In addition, most autofocus 
systems do not perform well with repetitive subjects.

What to do  The most important step is to be aware that this can happen when 
you take pictures of subjects that include repetitive patterns. You can vary the 
focal length (zoom in and out), and vary the angle from which you’re shooting. 
If you still get moire in the image, try using the blur tool in Digital Image.
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While these tips may not instantly transport you to digital photography nirvana, 
chances are good that you’ll be closer than you were before.
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Winter Camera Care Tips
Text by Charlotte K. Lowrie

For anyone who braves the frigid temperatures of winter to photograph some 
of Nature’s spectacular winter scenes, it pays to ensure that you have adequate 
protection for both you and your camera. 

Here are a few tips to help you prepare for a winter photo session.

 The care and feeding of batteries  Cold weather can shorten the life 
of batteries anywhere from a barely noticeable reduction in power to a 
sharply shorter life. Lithium batteries and the rechargeable Ni-MH cells 
last longest in cold temperatures. Be sure to carry spare batteries and 
keep them warm by stowing them in a warm, inside coat pocket. If you 
opt to carry a chemical warmer, be aware that the warmers can reach 
temperatures as high as 150-degrees Fahrenheit—far too high a tempera-
ture for virtually all film and camera gear. 

 Dress in layers, with a roomy, warm, weather-proof coat as the outer 
layer. A roomy coat is a bonus because it allows you to tuck the camera 
inside your coat as you move from one location to another. 

 Wear gloves  Besides keeping your fingers warm, gloves will prevent 
your fingers from sticking to the camera lens or tripod/monopod legs in 
very cold temperatures. You can layer gloves with a thin glove or glove 
liner as the inner layer with heavier mitts over the liners. I sometimes 
wear fingerless leather workout gloves as an inner glove in moderately 
cold conditions. Also consider checking sporting goods stores for gloves 
that feature fold-back fingertips. 

 Buy or make a weather-proof cover for your camera  Winter weather 
conditions can range from fog, rain, and sleet, to blowing snow whether 
it’s wet or dry snow. Various companies, including Domke, make weath-
erproof covers for cameras. They are large enough to accommodate the 
large SLRs and lenses, and they have an opening for the lens with a pull 
tie to secure the cover. If you don’t want to invest in a ready-made cover, 
you can fashion one from a heavy-guage plastic freezer bag. To secure the 
bag or bags around the camera and lens, you can use Velcro straps sold at 
many grocery stores, or rubber bands. Between shooting sessions, protect 
and warm your camera by putting it inside your coat or gear bag. If you 
have a lens hood, use it in blowing sleet or snow to help protect the lens. 

 Protecting film  In low-humidity conditions (around 45 percent relative 
humidity), static electricity can build up on the camera’s pressure plate 
and discharge when you advance the film. Film can be streaked or fogged 
in these cases. To avoid static electricity, be sure to shoot in single-frame 
mode. If your camera offers the option of switching from automatic to 
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manual film advance, switch to manual mode, and then advance the film 
slowly.  

 Rely on a zoom lens  In cold conditions, you want to avoid handling icy 
cold lenses. In extremely cold weather, a metal lens case can stick to your 
fingers, and a plastic lens case could potentially break. Instead, mount a 
zoom lens with the most versatile range to avoid changing lenses. 

 Transition the camera between temperature changes  As Peter Burian 
recommends in The Joy of Winter Photography, when you first go out-
doors, allow your gear to cool down. Once you’re in the field, Burian cau-
tions against taking cold photo equipment into a warm or humid vehicle 
or building for short periods. “If you do so, condensation will form on 
the exterior of the camera and this moisture will freeze when you return 
outdoors,” he says. “When you must take cold photo equipment indoors, 
keep it inside a camera bag with the zippers closed tight,” he adds. 

In addition to these tips, be sure to follow general safety precautions and that 
includes having the following:

 Fully charged cell phone, spare battery, and car charger cord 
 Compass 
 Flashlight 
 Bottled water 
 Map 
 Notepad and pens 
 Blankets in the car 
 Small tool set 
 Nonperishable snacks 
 Masking tape or duct tape 
 Identification, passport, driver’s license (as appropriate) 
 Watch

Winter offers some spectacular opportunities for photography that you can 
enjoy even more when you are prepared for the weather. While this seems to be 
a long list, as I’ve learned from experience, it’s better to know everything you 
can take, and pare down the list based on the circumstances.
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Tips for Online Auction Photos
Text and photos by Charlotte K. Lowrie

Photos for online auctions may not win photo contests, but they should be winners in the eyes 
of potential buyers. By following a few simple tips, you can make your photos stand out on 
cyberspace auction sites.

There is a hard-to-resist primal appeal to the idea of having a stranger pay real 
money for stuff that is stacked to the rafters in guest-room closets, attics, or 
garages. This appeal alone may explain the phenomenal growth of online auc-
tion sites in the past few years. After all, who hasn’t whiled away a few hours 
browsing through other people’s closet-stuff on the cyberspace equivalent of the 
world’s largest garage sale?

Whether you’re buying or selling items, you know that pictures of the items 
will maximize the appeal. Never mind that since potential buyers can’t examine 
items, providing a descriptive photo can make or break the sale. Another reason 
to include photos is that many auction sites will allow you to advertise your 
item on additional areas of the auction site, such as the photo gallery. 

You don’t have to be a pro to take pictures of the items you want to sell. In fact, 
you don’t even have to have a digital camera. Just take pictures with your film 
camera and have the film scanned at a photo lab or scan them yourself. With 
some smaller items, you can place the items on a flatbed scanner to create the 
image.

While you don’t have to be a pro to take the pictures, it is a good idea to keep 
the following basic shooting tips in mind as you take the pictures.
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Basic tips for taking pictures that sell
Auction photos do not have to be works of art. But they do need to answer 
questions that a potential buyer might have, such as what the item looks like 
in accurate detail, reflect the color and condition of the item, and show the fine 
points, such as handcrafted details or the interior of the item. Sounds relatively 
easy, right? It can be easy with a little preparation and a few tips.

Here are four basic guidelines to follow. 

Use simple, uncluttered backgrounds  To show off the item you’re selling, 
create a makeshift studio next to a window or outdoors on a table, stand, or 
chair. The area you choose should provide enough room for you to work com-
fortably. Clear any items from the area that will not be included in the photo.

Then use a cloth, a roll of inexpensive craft paper, or poster board for the base 
and backdrop. From experience, I’ve learned that if you photograph items 
outdoors, try to set up the table and backgrounds in an area where there is little 
or no wind. Then tape the paper to the edge of the table to avoid having gusts of 
wind turn over small items you’re photographing. 

A clean, uncluttered background is easy to set up in a makeshift studio.

When you create the background, choose colors that will show off the items 
you’re photographing. For example, if you’re photographing a crystal wine 
glass, choose a background other than white.

Use even, diffuse lighting  The goal of lighting in this case is to provide soft, 
even light on the subject. Consider setting up your photography area next to a 
window (for small items) or outside on an overcast day or in the shade. If the 
area you’re working in has natural light coming from one direction, the oppo-
site side of the item may be dark and lack detail. You can bring a small lamp in 
to fill in the darker area. 
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An on-camera flash can overexpose the subject, obliterating details that a potential buyer 
would want to see.

You may be wondering why I haven’t mentioned using the on-camera flash. In 
most cases, an on-camera flash creates harsh shadows around the subject, may 
overexpose the details you want to show, and can create distracting reflections 
as the light from the flash bounces back to the lens. If possible, use natural or 
household lights to light the object.

Ensure tack-sharp focus  The advantages of sharp focus are obvious, yet 
many auction photos are blurry enough that it’s hard to tell what the item really 
looks like. To get tack-sharp photos, the most important thing to know is the 
focusing range of your camera. Be sure to read the manual before you begin 
shooting to learn the focusing range, and then stay within the camera’s focusing 
range when you take the photos. If the range doesn’t allow you to get close 
enough, switch to the close-up mode on the camera, and then move in as close 
as the focusing range allows.

To ensure crisp focus, stay within the focusing range of your camera.

Remember that the photos will be displayed on a low-resolution computer 
monitor. That means you crop the image to make it larger using your image-
editing program and the loss of resolution won’t be noticeable. 



232 Chapter 15: The Best of Tips & Tricks

Microsoft Digital Image Suite User’s Manual

233Chapter 15: The Best of Tips & Tricks

Microsoft Digital Image Suite User’s Manual

Note  Many companies offer accessory lenses for digital cameras. If you often 
sell items—especially small items such as stamps or coins—on auction sites, 
you may want to invest in a close-up accessory lens. The lenses typically 
require an inexpensive adapter ring that fits onto the camera’s built-in lens, and 
then the close-up lens attaches to the adapter ring.

The most important point in getting crisp focus is to check the camera’s 
in-focus indicator. Just because you pressed the shutter release half-way down 
doesn’t mean the picture is in focus. Look for the in-focus indication in the 
viewfinder before shooting. 

Show color accurately  If you’re selling bone china, you don’t want a strange 
green or blue color tint in the photo. To avoid unwanted color tints, be sure you 
set the white balance on a digital camera to match the type of light. If you’re 
shooting with film, buy film that is balanced for the light you’re shooting in, or 
use the appropriate color-correction filter. While you can make color correc-
tions on the computer later, it saves editing time if you shoot using the correct 
settings, film, or filter.

Additional tips  Here are a few other tips you may find helpful.

 If you are using a digital camera, check your pictures on the computer 
before you dismantle your studio. This saves time if any photo needs to be 
retaken. 

 If you’re using a digital camera, always meter for the lightest (highlight) 
area in the scene. This means you should point the camera to the lightest 
area, press the shutter release button halfway down, and then note the 
exposure settings (the f/stop and shutter speed). Then use that exposure 
setting to take the final picture. Except in instances when you use a flash, 
this technique helps avoid highlight areas that appear white with no vis-
ible detail in the final picture. 

 To record small, fine details, put the camera on a copy stand (sold at photo 
stores) or on a tripod and be sure to switch to macro mode.
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 If you don’t set the white balance appropriately on a digital camera, or use film or a filter ap-
propriate for the light, the image may have an unnatural color tint. This photo was taken under 
household light with the white balance set to “shade.”

Image editing
To edit the images in an image-editing program such as Microsoft Digital 
Image Pro, begin by adjusting the overall tone and contrast. If the image has 
an unwanted color tint, you can correct it in any of several ways. If you used 
a white backdrop, setting the white point on the lightest area of the white 
background can sometimes correct the color instantly. For example, in Digital 
Image Pro, choose Adjust Tint from the Touchup menu. Click an area in the 
picture that should be white, and then click the lightest or brightest white area 
in the image. Then click Done.

Or you can use the Tint Auto Fix option in Digital Image Pro. 

In this photo, the white balance was set to incandescent to match the light. Minor color adjust-
ments were made in Digital Image Pro.
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If your image-editing program offers Level or Curves adjustment tools and a 
brightness and contrast tool, use the automatic or manual adjustments to tweak 
the brightness and contrast of the image.

Then use the cloning tool to delete small imperfections such as dust, or use 
the cloning tool to eliminate unwanted or distracting objects from the image. 
If you clone large sections, be sure to resample, or set a new starting position, 
frequently as you work. Frequent resampling gives the cloned area a more 
realistic look.

Next, use the crop tool in your image-editing program to crop the image. You 
can crop to eliminate empty space or distracting objects in the image. You may 
want to leave a little space around the object as a visual frame.

Before you begin the final step in the process, be sure you check the guidelines 
of the auction site. Many auction sites set a 50KB file size limit to ensure quick 
page viewing for visitors. Depending on the image-editing program you’re 
using, you can resize the image so the image file meets the file size require-
ments of the auction site, or you can use the option to save the image for the 
Web. The latter option takes the guesswork out of the sizing process because 
it shows you, as you work, what the final file size will be for each of the size 
options. 

If you’re using Microsoft Digital Image Pro, just choose Save Special from the 
File menu, then choose Save as a Web-ready Picture. Under Click a picture 
size, choose an option that results in a file size (shown below the dropdown 
box) that falls within the auction site’s guidelines. If you are not using Digital 
Image Pro, look for the Image/Size or Resize command. 

Storing auction photos
A picture, especially for an online auction, is certainly worth a thousand words. 
If you’re selling a closet full of items online, you may quickly find that you 
have hundreds of photos to store and track. For a list of sites that offer hosting 
services, go to the auction site and search for a Help topic on submitting auction 
photos.

If you feel overwhelmed by the thought of overstuffed closets, attics, or 
garages, consider how easy it is to sell the items on the auction sites. With a 
little luck and some good pictures, you can be only days away from clutter-free 
closets and a few extra dollars.
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The Fast Track To Better Photos
Text and photos by Charlotte K. Lowrie

No time to study the fine points of photography? One or more of a few fast-track ideas can net 
noticeable results in your photos. In this example, strong color can make a big visual impact.

If you’re one of the millions of overscheduled, overwrought people who loves 
photography but barely has time to read your mail much less time to read tomes 
of technical information on the fine points of photography, take heart. You 
can make an appreciable improvement in your photos with one or more simple 
techniques that don’t require lots of reading or memorization.

Note  I’m not suggesting that technical details such as precise exposure aren’t 
important. I am suggesting that simple shooting techniques can make a big 
difference in photos for those who are time-challenged.

So, if you fall into the ultra-harried category, just pick one of the following 
suggestions and try it. Or pick two, or try them separately or together. The ideas 
in this article are abbreviated for easy use. If you find a topic you particularly 
enjoy, be sure to explore more on the subject in photography books, magazines, 
and, of course, on MSN Photos.

1. Look for the light
When the subject of light is brought up, people expect to hear again the 
advantages of shooting in the early morning hours or sunset and twilight hours. 
Both of these times of day typically offer stunning light. However, you can use 
this rule of thumb at any time of the day because “looking for the light” means 
seeing unique compositions that are created by the way light illuminates a 
scene and subject.
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Practice noticing how light can play on objects. Light often creates patterns such as in this 
photo where the eye is lead to a vanishing point by the light canopy, artificial lights, and the 
lighter areas on the floor.

To use this technique, think of it as a guide. It will almost always show you a 
vignette that is perfect to photograph. Once you see the vignette, watch how the 
light paints the scene, revealing some detail here and concealing other details 
elsewhere. Then notice how the shape and direction of light direct the eye, 
and use this in your composition to move the viewer’s eye through the photo. 
Of course, the color (or temperature) of light will also define the colors of the 
scene. Move around to see how the light separates and outlines the subject 
against the background. Watching how light plays on parts of a scene is a good 
habit that can often result in a worthwhile photo.

Tip  If you’re shooting with a digital camera, take the meter reading on the 
highlights in the scene and shoot using that exposure. If you’re shooting with 
film, take a meter reading on a shadow area, and take the picture using that 
exposure.
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In this photo, I looked for light in an otherwise shaded scene. At the last minute, I saw the thin 
shaft of light falling across the musician’s straw hat. The direction of the light conveniently 
provided a subtle path leading to the musician’s face.

2. Look for color
If you want to make a visual impact, look for bold color and make it the 
primary element of your photo. Further, use color with intent in your photos. 
All you need is a little background in color basics.

The three primary colors are red, yellow, and blue. These are saturated, domi-
nant colors that make a big visual statement. And, quite obviously, a brilliant 
blue sky makes a great backdrop for pictures.

Secondary colors are green, orange, and violet. Tertiary colors fall between 
the primary and secondary colors. For example, yellow-orange falls between 
yellow and orange, blue-violet falls between blue and violet, and so on. 

To create eye-stopping photos, use complementary colors. Complementary col-
ors are opposite each other in the color wheel, such as red/green, blue/orange, 
and yellow/violet. When you place complementary colors next to each other, 
they make each other appear brighter. And because these colors are equal in 
value, combining complementary colors creates strong color contrast.
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Bright, dominant colors, in this case, red and blue, not only create visual appeal, they also cre-
ate their own composition.

Given that color has strong appeal, you might think that a photo with many 
strong colors would create a more powerful photograph. That’s not usually the 
case, however. A photograph with many strong colors can be distracting, draw-
ing the viewer’s eye from one color to the next. Instead, compose the photo so 
that one color dominates, and then use the dominant color to help organize the 
photo and focus attention.

Related colors are next to each other on the color wheel, and a series of three 
or four adjacent colors is called analogous colors. Related and analogous colors 
create harmony and are often used to lend a sense of atmosphere. 

Colors can set or enhance the mood or atmosphere of an image and make 
objects appear to advance or recede in the image. Colors such as red, orange, 
yellow, red-violet, and yellow-green are warm and inviting, and they come 
forward visually. Conversely, violet, blue, and green, are cool colors, and they 
tend to recede visually. Color intensity can also complement the subject. For 
instance, pastel colors suggest tranquility, bright colors suggest activity, while 
dark, shadowy colors suggest a somber tone.

As you probably know, light at different times of the day has different tempera-
tures, or colors. For example, the early evening hours produce a much warmer 
color of light (3,000 to 4,500 degrees Kelvin) than midday sun (5,500 to 7,000 
degrees Kelvin), and artificial light (a 100-watt incandescent bulb is 2,900 
degrees Kelvin) creates even different color variations. You can use the color 
variations of light creatively to enhance your images. 

Tip  To get saturated details in foliage or in a rich blue sky, and to help reduce 
bright highlights when shooting into the light, use a polarizing filter. To balance 
the bluish color found when shooting in open shade, try using a warm-up filter 
such as an 82A or 82B. If you’re shooting with a digital camera, you’ll get the 
best color by setting the white balance to match the light in the scene.
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3. Just don’t say “cheese.”
If there is a universal photo convention, it must be having photo subjects say 
“cheese” to get them to smile for a picture. While smiling is a good thing to 
have subjects do for, say, a family portrait, almost all adults and children past 
the age of crawling have perfected a “cheesy” camera smile that satisfies the 
photographer but that lists far to right of genuine. 

If you photograph people, try not to ask them to smile. Instead, photograph 
them with natural expressions. Emphasizing “natural,” of course, means that 
you’ll need to spend some time putting them at ease first. 

Tip  Natural expressions are fleeting. If you’re not prepared to shoot and you 
say “wait, don’t move,” your subject may become self-conscious trying to hold 
an expression or pose. Instead, just shoot whether you’re ready or not, and keep 
shooting as you make the necessary camera adjustments. It’s much easier to 
delete a bad digital picture or throw away a film print than it is to recapture 
spontaneity and keep the subject engaged.

4. Avoid clichés
Cliché means a trite or overused expression or idea and, in this case, a “been-
there-seen-that” photo. This means you have to ditch the “I-want-to-take-a-
picture-just-like-that” mentality and break new visual ground both in the way 
you look at scenes and in the way you use your photo gear.

To get the effect of the water almost engulfing the girls, I used a telephoto lens and shot from 
a high vantage point.

Take the obvious shot, if you must, but don’t put the camera away. It’s often 
only with time and patience that you discover different ways to “see” the 
subject or scene. Walk around, think about how to put the scene or subject in a 
more meaningful or interesting visual context for the viewer of the photo. 

Certainly your camera gear gives you a world of creative options for going 
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beyond the obvious. For example, the subject matter of the photo of two young 
girls playing in the surf is easily a cliché. However, because the compressed 
perspective makes it appear as if the water will engulf the girls, the shot 
escapes the mundane category. To get this effect, I used a telephoto lens and 
shot from a high vantage point.

Tip  Develop your own cliché meter. If you see a picture and think, “this looks 
just like...”, then look again and ask yourself how you could express the scene 
from a new point of view.

5. Do it with style
If you slavishly follow all the rules and guidelines for making good pictures, 
you will doubtless end up with lots of nice photos. If, however, you want 
something that sets your photos apart from others, then find and fine-tune 
your personal style. Like your voice, your photographic style will make your 
images immediately recognizable by those familiar with your work. For anyone 
unfamiliar with your work, your personal style will distinguish your images 
from those of other photographers.

While style admittedly is difficult to explain, it is perhaps the one characteristic that ultimately 
pays the biggest dividends.

Developing a personal style is one of those things that is easier to write about 
than it is to create. Style can be what you specialize in, your characteristic 
approach to any subject, an element that you include in virtually every image, 
a guideline you consistently and successfully break, a personal point of view, 
humor, juxtapositions, a penchant for extreme simplicity, a passion for a 
subject, or a stylized darkroom treatment.

Each suggestion in this article could easily merit its own article. However, if 
you have limited time, any of these ideas should provide a jump-start to make 
noticeable and positive changes in your photographs. 
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Photo Ops in the Most Unusual Places

Alleys and Other Worthwhile Detours

Text and photos by Charlotte K. Lowrie

Hidden from the incessant human need to clean up, alleys provide surprising photo opportun-
ties as nature and emerging artists use the space for artistic endeavors.

Are you bored going to the same places, taking the same monotonous pictures? 
If you are, then it’s time to swerve off the beaten path and explore some 
unlikely places and events that offer photo opportunities. Weekends are a great 
time to take detours, because detours often take you out of the mainstream 
crowd crush and give you space to do some creative exploration and shooting.

If you plan to detour at random, be sure to pack your camera bag with a full 
complement of gear. Often the lighting and space you have to work in will be as 
unconventional as the location. So at a minimum, pack the speedlight, a tripod 
or monopod, and, if you’re shooting with a camera with interchangeable lenses, 
a full focal range of lenses.
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Alley art
Beautiful things can happen in alleys. Those narrow, dark, less-traveled 
passageways provide a studio in which nature finds asylum from the incessant 
human need to clean up. And left to her own devices, nature often draws exqui-
site three-dimensional vignettes on canvases woven by time. Wherever nature 
works undisturbed, there are bound to be photo opportunities.

On an overcast day in a dim alley, a flash added the extra light needed to make the faded 
colors pop in this shot.

But why risk life and camera gear to schlep down dark alleys to photograph 
nature? Why not go to a park or nature preserve? The difference between 
photographing in alleys and, say, a meadow or woodland, is the unique juxtapo-
sition of man and nature. In alleys, nature works on abandoned structures and 
objects to create photo opportunities that are far less predictable than you’d get 
taking photographs in an arboretum or park.

More often than not, however, nature does not work alone in alleys. For aspiring 
artists, alley walls provide expansive and affordable canvases. And predictably, 
alleys have that “underground” appeal that nourishes the iconoclast’s creative 
expression. It’s a sort of 21st century twist on Michelangelo’s Sistine Chapel 
that today’s impassioned artists spend quiet, tireless predawn hours transform-
ing dingy brick walls into memorable and photogenic compositions. And if 
you’re fortunate enough to find an alley where nature, artists, and impassioned 
idealists have been very busy expressing themselves, consider your detour to be 
a real find. 

Location tips and notes  Depending on the city, you may more readily find 
this type of photo opportunity at highway underpasses or along the walls of 
failing areas within large downtown cities. Exercise caution and good judgment 
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when entering alleys and other potentially unsafe locations. If you choose to 
photograph the location, stay alert to activity around you, and always have your 
cell phone handy.

Shooting tips and notes  Because the lighting is often poor in alleys and 
other out-of-the-way locations, use either your tripod or flash to ensure crisp 
sharpness. If you’re shooting film, choose a high-speed film. In fact, this is the 
perfect time to try out some of the new 1600 ISO films. Consider either shoot-
ing black-and-white film or switching to black-and-white mode on your digital 
camera.

Because the rusty gate provided enough context, I could use a tighter framing to isolate the 
most interesting elements of this scene.

Think like a photo editor who wants to tell a story in three or four succinct 
shots. This means you’ll want to look both for the detail and the overall context 
the scene provides. Before you shoot, ask what you want the photo to tell view-
ers. If the telling aspect of the scene is the contrast of the overall location with 
the art or object, shoot from a wider perspective that includes the surroundings 
in context. Then look closely for arresting details that can complete the story, 
for example, a single broken door knob overgrown with vines, a cat in the 
window, or a stray, discarded object that tells of former lives and activity.

Image-editing suggestions  Once you have your favorite images on the 
computer, experiment with converting color images to black-and-white or sepia 
tone. Some images just seem made for this type of treatment. Always make a 
copy of the original picture first, and save it in a lossless format, such as TIFF. 
Then work on the copy—never on the original image. In addition, try splitting 
images into sections to emphasize depth or repetition of shape or pattern, or to 
simulate a panoramic perspective.
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Relics and old stuff
Cities and towns choose to keep old stuff in both predictable and unpredictable 
places. For example, old farm implements may be unceremoniously parked in 
parking lots or abandoned cars by the roadside. Look for those places and think 
of them as opportunities to create photos reminiscent of bygone eras.

A predictably great place to find relics is in antique shops. Abandoned farms, 
run-down gasoline stations, and historical sites are usually good choices. 
But always ask permission before you photograph in any store or on anyone’s 
private property.

Strong side lighting from a nearby window created the warm atmosphere that I wanted for this 
image.

Once you find the location, spend a few minutes walking around thinking: 
about the time and place associated with the object, who might have owned 
it, and how the object was used, what made it special or prized. Then look for 
ways to translate your imaginings about the object into the image. Antique 
stores often group objects from approximately the same period together. 
Consider using nearby objects to convey a sense of time and context.

Shooting tips and notes  The light you use to photograph antiques and relics 
can help convey the sense of antiquity and enhance the atmosphere you’re try-
ing to create. You will likely have three lighting choices: flash, natural light, or 
available (outdoor sunlight, or indoor tungsten or fluorescent) light. 

If you’re shooting indoors and you decide to use a flash, be sure to use a bounce 
flash. Direct flash almost always creates a harsh effect, along with deep shad-
ows. Also, if you’re shooting indoors, natural window light (if it is available) is 
the best option. Try to shoot using side light—the light falls on the subject from 
one side. If you choose to use available indoor light, be sure you use your tripod 
to ensure rock-steady crisp sharpness. In tungsten light, the warm tint often 
helps create the atmosphere you want. 
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Outdoors, consider using your flash to fill in shadow areas and add pop to what 
may be dull, faded colors. 

In almost every case, you’ll want to move in close to the subject to isolate it 
from the contemporary surroundings. Try to frame the shots carefully to avoid 
cropping later.

Whether you’re photographing alley art or antiques, veering off well-traveled 
roads almost always provides nice rewards—including honing your eye for 
unexpected photo opportunities, and adding some unexpected and interesting 
photos to your collection.
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Fall Photos: Sharpen Your Eye for Color and 
Composition

Limiting the number of colors and keeping the composition simple can help make fall photos 
more vibrant. 

As fall inevitably creeps across the summer landscape, it brings color changes 
vibrant enough to motivate even the most languid photo buffs into recording at 
least a few frames of nature’s brilliant displays. 

“Yeah, right,” you may say, yawning, “that’s what we need—yet more sweeping 
landscape shots of red, yellow, and orange trees.”  

Granted, anyone who’s been through more than a few autumns knows that 
given the stunning show nature provides, colorful, postcard-like landscape 
shots are a gimme. If you’re thinking “been there, done that,” then it’s time to 
think about fall as an opportunity to develop your eye for color and composi-
tion. If you want fall images that resonate beyond the predictable fall landscape 
shots, then you’ll have to get creative and use fall color in less predictable ways.
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Look for details within the scene.  

Color contrast
To go beyond the obvious ho-hum tree-changed-color shot, learn to use 
color contrast to its maximum potential. You can choose to use high or low 
color contrast, but use both with intent. High color contrast is achieved by 
using complementary colors in a composition. By definition, colors are 
complementary if they form gray when combined in equal amounts. On a color 
wheel, complementary colors are opposite each other. So the primary colors 
of light—red, blue, and green—have complementary colors: cyan, yellow, and 
magenta, respectively. 
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Using complementary colors with intent creates striking images. 

Using the complementary colors together creates images with striking contrast 
or “pop.” This shot pops because it uses the complementary red-cyan colors. 
The same shot against green foliage in the background would have much lower 
contrast, and would become one of those nice, put-it-in-the-back-of-the-drawer 
shots. 

On the other hand, images with low color contrast use either a single color or 
colors in the same family in the composition. Using low color or harmonizing 
contrast creatively and intentionally creates visually soothing, tranquil images. 
For example, a macro shot in which the frame is filled with a single fall bloom-
ing plant or berry is a low-contrast image, as is a frame filled with billowy 
grayish-white fall clouds, or distant multihued blue mountain ranges. 

For low-contrast images to be effective, it’s important to have a strong focal 
point in the composition, and to look for or create tonal differences that provide 
depth and definition. For example, if you’re shooting a single-color subject, 
create or emphasize tonal differences by using side lighting and by playing up 
shadows.
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Color and light
Many typical fall photographs are shot in bright or moderately bright sunlight. 
This type of light produces images that closely match the way we remember 
seeing the scene. That is part of the reason we respond to them with a positive 
sense of familiarity.

However, fall colors photographed in the cooler range of light at twilight or in 
overcast conditions, or in the warmer light of sunrise and sunset, offer a new 
perspective on familiar colors and subjects, and provide a more creative back-
drop for photographs. Overcast and post-rain conditions, in particular, produce 
richer, more saturated colors. For example, the same red leaves photographed 
against a twilight backdrop create a more moody interpretation that suggests a 
sense of mystery or drama. 

Fading afternoon light provides just enough frontal lighting for the leaves.

Color and composition
Looking at the spectacular array of fall colors, it’s often difficult to isolate 
elements for a composition. And that’s where some fall pictures fail. As a 
textbook rule, using more than two bright colors in a composition creates visual 
confusion. (Okay, so no one tipped off Mother Nature to this rule.) 

While grand, panoramic shots of colorful scenes may seem obligatory for fall 
photo collections, images can be much more effective if you choose a single 
color as the focal point. Of course, this approach requires more time and study 
amid the multitude of colors. If the single color is not immediately obvious, 
walk around the area for a while to study the colors and shapes. Soon, you’ll be 
able to identify the most striking and interesting aspects of the scene that you 
can then use as the primary compositional element in the image. 
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As you study a scene, progressively focus on the smaller details: Look for 
what I call “designs within the design.” These smaller designs or arrangements 
are microcosms of the overall scene, and they can provide endless shooting 
opportunities. As you walk around, remember that when you emphasize color 
as a focal point, the overall composition should be simple. Find an area or 
subject where you can eliminate competing and distracting elements from the 
composition by zooming in (and, consequently, compressing perspective), 
reducing depth of field by choosing a wider aperture (a smaller f-number), or 
changing your shooting position.  

The repetition of red in this photo helps unify the composition.

After you have a good sense of the composition you want, experiment with 
different angles, focal lengths, and positions until you find the framing and 
perspective that is most effective. Then, as you settle on a final composition, 
observe how the primary color is distributed or repeated throughout the entire 
frame. Try to find an angle and framing that allows color repetition to become 
the unifying element in the composition. 

Also, remember to try vertical formats. Because cameras are easier to hold in 
a horizontal position, it’s easy to overlook the possibilities offered by a vertical 
composition.  

Last composition checklist
Before you take the picture, look at everything within the frame again. Then 
ask yourself a series of questions.

 What more can you do to emphasize the textures, lines, and form of the 
subject? For example, if the day is overcast, can you use a fill flash or an 
off-camera side flash to enhance the texture and create depth? 
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 Is the frame filled? Or is there dead space that will be distracting, or 
competing elements that add nothing to the image?

 Does what you see in the viewfinder communicate the message you want 
to share with viewers? 

This series of questions should provide enough of a pause to keep you clear of 
the “predictable” fall photo rut.   

A fill flash provided critical highlights in this shot. 

Additional shooting and technical tips
In addition to color and composition, standard shooting tips apply. Following 
are a few to keep in mind.

 Pick the right film  Choose a film that is known for reproducing rich 
and saturated colors. If you prefer to shoot transparencies, many pho-
tographers swear by Fujichrome Velvia for its sharpness and vivid color 
rendition. Kodak Ektachrome E-100S is also a favorite. When shooting 
with transparency film, exposure latitude is tight, so be sure to bracket 
your exposures. If you shoot negative film, many recommend Kodak 
Royal Gold and Kodak’s VC-rated negative films rated at ISO 50 or 100.

 Make adjustments for digital  Choose a slow (low) ISO value to mini-
mize noise (the appearance of “grain”) and to ensure sharpness and color 
saturation. Also, always set the white balance to match the conditions. 
For example, if you’re shooting in shade or overcast light, set the white 
balance accordingly. 

 Take advantage of filters  To eliminate reflections from water and glass, 
saturate colors, and cut through haze, use a polarizing filter. For land-
scapes with a bright sky and much darker terrain, use a graduated density 
filter to bring the sky exposure closer to the exposure of the terrain. 
Try an enhancing filter to increase the intensity of reds and yellows in a 
scene. Enhancing filters, unlike polarizing filters, cause an overall warm 
color shift throughout the scene. Try an 81A, 81B, or 81C warming filter 
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to enhance warm fall colors and to counteract the blue tint of overcast or 
shaded lighting conditions. 

 Provide depth, scale, and distance  For landscape shots, as well as other 
shots, include one or more elements that provide a sense of depth, scale, 
or distance. This may be as simple as including a rock in the foreground 
or a pine cone next to a seasonal cluster of berries.

 Maximize depth of field  To maximize depth of field especially in 
landscape photographs, choose the smallest aperture (larger f-number) 
possible and focus one-third of the way into the scene.

 Make red work for you  Red is a visually dominant color. If you include 
red in a photograph, use it with intention to enhance the composition and 
draw the viewer’s eye. If red is used unintentionally, it will, of course, 
draw the viewer’s eye from the focal point.

 Know the message  Know why you’re taking a picture. If you can verbal-
ize what’s compelling about the scene, chances are much better that you 
can communicate that message to the viewer.

 Carry a card for quick backgrounds  Carry a gray card or any neutral-
color card in your camera bag that you can use as a backdrop for macro 
shots.

 Meter with polarizing filters  If you use a polarizing filter to enhance 
color, be sure to take a meter reading from a midtone within the scene, 
such as green foliage or grass. Then use that meter reading as the expo-
sure for the shot. This can help avoid possible overexposure due to the 
polarizer.

 Add foreground elements  When you take photographs in the warm 
light of sunrise or sunset, try including shadowy foreground elements. 
The contrast of the cooler, bluish illumination of the foreground increases 
the contrast to the warm colors of the sky.

 Carry foul-weather gear  If you decide to shoot in changeable fall 
weather, be sure to carry foul-weather protection for you and your 
camera. 

 Be creative  Try multiple-exposure images, turn the camera at an uncon-
ventional angle, use a fast film, or crank up the ISO on a digital camera 
and shoot in low light to create images with coarse grain or noise. Then 
try adding a soft-focus or warm-up filter.

The most important tip
Okay, maybe I should have said this first, but it works just as well here. Before 
you go out to shoot, think about what autumn means to you. Knowing what you 
think—how you feel—is as important as the camera and gear you use and how 
much you know about photography. Why? What you think translates directly 
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into what and how you take pictures. And, ultimately, what you think is what 
will be the key that sets this series of fall photographs apart from “yet more 
sweeping landscape shots of red, yellow, and orange trees.”  
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Digital Image Editing 101

Careful correction can make the difference between an image being a throwaway or a keeper.  

Taking the picture is half of the fun of photography. The other half of the fun is 
in the digital darkroom—getting that great finished image that you can’t wait to 
show off to everyone who’s willing to look at it. “Yeah, right,” you say, “but I’m 
not Ansel Adams, and I know nothing about editing pictures.” 

While digital image editing often mirrors traditional “wet” darkroom picture 
processing, you don’t have to have traditional darkroom experience to perform 
everything from minor fixes to minor miracles in a short time with digital 
images. And in many cases, you can save pictures you would have otherwise 
thrown away. 

Notice that I said “many,” not “all” cases. Regardless of the small miracles you 
can perform, there will be some images that no amount of computer editing will 
fix. Image-editing software is good, but, alas, far from perfect. For example, if 
the detail is blown out of highlight areas, no amount of editing will put detail 
into the area. You can use a cloning tool to paint in detail from a similar area, 
but the process is tricky, tedious, and the results can look artificial. 
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Tone and color adjustments made this image a standout for color and contrast.

But, if you follow good darkroom process and practices, my bet is that you’ll 
get more keepers than you thought possible. And, what’s more, you can polish 
those exceptional images into a portfolio of “personal best” pictures that you’ll 
be proud to share and print. 

Following are tips and a suggested process for correcting digital images.

Before you start editing pictures
The first two best steps in image editing begin before you sit down at the 
computer. From personal experience, I know that the most important image 
editing steps are to:

 Learn your camera gear inside and out. 
 Use your camera correctly when you take pictures.

Regardless of how much fun image editing is, you don’t want to spend time 
on the computer correcting something that could have been corrected during 
shooting. Rather, ensure that you use your image-editing time to perfect and 
polish good pictures rather than salvaging images discolored because the white 
balance, ISO, or mode was incorrectly set.

Another important point is to know what you are correcting “to” or “for.” In 
other words, what does a well-corrected picture look like? The following list 
provides some of the basics for correcting photos. Not every item in the list will 
apply to every picture, and, of course, there will be exceptions such as high 
visual impact pictures in which many of the guidelines should be ignored, but 
you can use it as a starting place for image editing.  

 Good contrast. In black-and-white photos, this usually means white 
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whites and black blacks, and a good tonal range of greys. In a color photo 
that has no whites or blacks, then the goal is to have strong, vibrant color 
in the darkest colors and bright vibrant color in the lightest colors.

 Vibrant and/or realistic colors with no excessive color casts caused by 
improper settings for white balance or not using a color correction filter 
on film.

 Detail in both the shadows and highlights, or in the area (either highlight 
or shadow) that is most important to the image overall.

 Natural skin tones if people are in the picture.
 Cropping that enhances the composition.
 An appropriate sharpening level.

This picture has many of the elements you look for when editing images: a good tonal range, 
vivid colors, white whites, black blacks, and detail in the shadow areas.

The image correction process
For those new to image editing, the process of image correction generally 
follows a sequence of adjustments that build upon each other. Following this 
sequence often makes subsequent steps easier to complete, and it will help 
avoid time-consuming mistakes that result in artificial-looking pictures. 

A simple example is sharpening. In image-editing software, sharpening doesn’t 
magically fix blurry focus. Instead, it makes existing focus appear sharper by 
increasing the contrast of adjacent pixels typically where there are significant 
color changes, such as the edges.

Sharpening sounds like a good starting point for image editing, right? Not so. 
As it happens, if you sharpen an image first, and then make other adjustments 
such as burning (darkening an area) or dodging (lightening an area), the subse-
quent editing can create unnatural-looking edges and pronounced halo effects 
around objects in the picture. 

Following a sequence or workflow in the digital darkroom not only helps you 
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avoid time-consuming mistakes, but also ensures that you work with a copy 
of the image in as high a resolution as you can for as long as you can before 
making the final edits such as cropping or resizing for printing. 

Image correction process

 1 Save and correct a copy of the original.
 2 Adjust the tonal range.
 3 Adjust the color balance.
 4 Dodge and burn.
 5 Correct flaws such as dust, scratches, and red eyes.
 6 Crop the image.
 7 Size the image for printing, e-mail, and the Web.
 8 Sharpen the image.  
1 Save and correct a copy of the original.  Before editing an image, always 
save a copy of the original file in a lossless file format such as Tagged Image 
File Format (TIFF or .tif) and work on the copy. Although you may have taken 
the image in JPEG format, do not edit and continue to save the image in JPEG 
format. JPEG files are small because they are compressed to save space on the 
memory card and on your computer’s hard drive. However, during compression, 
some of the image data is discarded.

If you’re working on a JPEG image and you periodically save it as a JPEG 
as you work, the image will be recompressed, and bits of the image will be 
discarded each time you save the file. While you may not notice a degradation 
in the image on the screen, the more you save a JPEG, the more its resolution 
will decline. 

Instead, start by making a copy of the original image in a format such as TIFF. 
TIFF files are significantly larger than JPEG because TIFF does not compress 
files, and it does not discard bits of the picture. For this reason, TIFF is referred 
to as a “lossless” format. 

Also, keep your untouched original images, in whatever format you took or 
scanned them, in a separate folder. That way you can always go back to the 
original if image correction doesn’t go the way you want.  

Note  If you plan to use layers to make adjustments on your picture, you’ll prob-
ably want to save the image in the image-editing program’s native file format. 
For example, if you’re using Digital Image Pro, the file format is .png. Saving in 
the image-editing program’s format preserves the layers so you can go back to 
them and make adjustments.  



258 Chapter 15: The Best of Tips & Tricks

Microsoft Digital Image Suite User’s Manual

259Chapter 15: The Best of Tips & Tricks

Microsoft Digital Image Suite User’s Manual

In this image the water has a greenish color cast and the visual impact is diminished by the 
wide-angle view.

2 Adjust the tonal range.  The tonal range of an image is the distribution from 
light to dark pixels within the image. In an average exposure the tonal distribu-
tion will have a fairly even distribution of dark, midtone, and light pixels. You 
adjust the tonal range of the picture to get the sharpest detail throughout the 
image. 

Most image-editing programs offer automatic and/or manual tonal-level adjust-
ment tools. Using the automatic option, the program typically chooses the light-
est and darkest pixels and distributes the midtone pixels proportionally. This is 
a generalized approach to tonal adjustment, and it usually works best on images 
that have average tonal ranges. However, on overexposed or underexposed 
images, automatic tonal correction can not only overdarken or overlighten 
pictures, but it can also introduce unwanted color shifts or tints.

Color correction renders a truer color for both the water and the boy’s clothing, and cropping 
focuses the viewer’s attention on the boy watching the fountain.
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First try the automatic tonal adjustment. In Digital Image Pro, click Levels 
Auto Fix or Contrast Auto Fix on the Touchup menu. If the automatic adjust-
ment isn’t what you want, then adjust the tonal levels manually in the Adjust 
Levels task by adjusting the sliders for Shadows, Midtones, and Highlights. 

Tip  Try the automatic levels and color adjustments first, because if the results 
are good, they can save time in processing images. If you don’t like the results, 
you can undo the changes and make the adjustments manually.

This original image was too dark overall. Adjusting the tonal range brings out the 
details and makes a more acceptable image.

Another good starting point for tonal adjustment is to set the white point. 
Setting the white point maps the lightest pixels in the image to white. Some 
image-editing programs allow you to set both white and black points. Setting 
the black point maps the darkest pixels to black. When you set a white and/or 
black point, the program adjusts the intermediate levels proportionally.

In Digital Image Pro, you set the white point by clicking Adjust Tint on the 
Touchup menu. Then click a place in the photo that is white. If there is no white 
in the picture, try the Tint auto fix button, or adjust the Color and Amount 
sliders.  

3 Adjust color balance.  In most image-editing programs, making a single 
adjustment to a color in the image will affect all of the colors in the image. With 
a color wheel, you can predict how a color adjustment will affect the other color 
in the picture. Also, you can increase the amount of a color by decreasing the 
amount of the opposite color on the color wheel, and vice versa. For example, 
to decrease a reddish cast in a picture, try increasing the amount of green. To 
make the sky more blue, decrease yellow, its opposite color.
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Setting the white point was the starting point for making tonal corrections to this image. Be 
sure to click the lightest white in the picture when you set the white point.

For general purposes, remember that the opposite of red is cyan (green/blue), 
the opposite of green is magenta (bright pink), and the opposite of blue is 
yellow. Typically, very small adjustments can make a big difference. Watch the 
picture to see how the adjustment is affecting the entire image as you work.

Depending on the image-editing program that you use, there can be one or 
many ways to adjust color balance. For example, Digital Image Pro uses the 
Hue and Saturation and Brightness and Contrast tasks on the Touchup 
menu to change the overall color balance.

Although vivid colors are good, you can  Although it may be difficult to see
go too far. For example, this image is  at this size, adjusting the color balance 
unnaturally blue. creates more realistic color casts for both 
 the sky and the water.

Tip  The hue, saturation, and brightness options are especially useful in restor-
ing faded colors in old family photographs you’ve scanned. 

If your image-editing program allows you to make color adjustments by indi-
vidual channel, you can fine-tune color corrections by channel, a method many 
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professionals swear by. Or, if your program offers an automatic color-balance 
option, you can try that. Keep in mind, though, that the automatic adjustment 
changes all colors in the image, not just the ones you want to change. In other 
words, you may get more change than you wanted if you use the automatic 
option.  

4 Dodge and burn.  In traditional, or “wet,” darkrooms, standard image finish-
ing includes darkening specific small areas of the image by increasing exposure 
(burning in) or lightening other small areas by reducing exposure (dodging). 
Burning in areas often reveals more detail or de-emphasizes less important or 
distracting areas. Conversely, dodging can reveal details in overly dark shadow 
areas. 

In Digital Image Pro, on the Touchup menu, click Other Photo Repair, and 
then click Dodge and Burn Brush. Try using the Soft edge option and increase 
the Brightness level to lighten (dodge) deep shadows. Use the same method, 
but with an increased Contrast level, to darken (burn in) the lightest areas.

In this image, I used dodging and burning to minimize distracting reflections that appeared in 
the man’s sunglasses.

Regardless of which tools you use, it’s a good idea to start with a low-intensity 
setting and to choose a brush size that is smaller than the object you’re working 
on. Also, know that you can always click Reset in Digital Image Pro to imme-
diately undo any changes you make.  

5 Correct flaws.  Scratches, dust, and lens flare are only a few of the many 
flaws you can fix in an electronic darkroom. Some of the most affordable 
image-editing programs automatically correct many of these errors. However, 
if you’re willing to take the time, many such errors are better corrected by 
hand.
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The cluttered background is distracting. It draws the viewer’s attention away from the subject.

One of the best tools for fixing flaws by hand is the cloning tool. It allows you to 
paint one part of the picture into another part of the picture, or paint from one 
picture to another. For example, you can paint over unwanted elements such as 
light poles, or add elements such as trees or people. 

To use cloning in Digital Image Pro, on the Touchup menu, click Clone brush. 
Select the brush size you want, and then click the starting area, or the area 
you want to paint into another part of the picture. Each time you want to begin 
using a different starting area, make sure to click Set new start position.

Tip  When you use a cloning tool, take care to produce natural-looking results. 
Use short paint strokes and click a new starting position often. When you repeat 
the same starting point multiple times within an image, you are likely to create 
a very artificial-looking pattern. 

Other guidelines include matching the angle of light and the proportions for 
cloned and original objects. In other words, don’t paint a shrub from a shad-
owed area into a bright area of the image, and don’t clone a foreground area into 
smaller background shrubbery.  

Crop and size the image
6 Crop the image.  The upside of cropping is that you can discard portions of 
the image that you don’t want or that do not contribute to the image. You can 
also center attention on the subject. The downside of cropping is that it reduces 
the overall size (and, therefore, the resolution) of the image, thus limiting how 
much you can enlarge the image for printing. For this reason, it is always best to 
do as much cropping as possible in the camera as you take the picture.
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I cropped the image and cloned out the background distractions.

For example, if you crop out a third of an overall image, the resulting image 
may not have a high enough resolution to print larger than 5" x 7". To order an 
8" x 10" enlargement from MSN Photos, the image must be at least 1536 x 1024 
pixels. And it follows that to get a poster-size enlargement, it’s a good idea to 
avoid cropping the original image at all.  

7 Size the image for printing, e-mail, and the Web.   Assuming that by now 
you have a flawless version of a picture, you can make copies of the final image 
and size each copy for the medium in which you want to print or display it. 

The following table provides the minimum image dimensions needed for each 
print size available from MSN Photos.

Print size (inches) Min. width (pixels) Min. height (pixels)

4 x 6 800 600

5 x 7 1050 750 

8 x 10 1536 1024

11 x 14 1750 1375 

16 x 20 (poster) 2500 2000 

18 x 24 (poster) 2500 2000 

24 x 36 (poster) 2500 2000 

30 x 40 (poster) 2500 2000

36 x 48 (poster) 2500 2000
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For use in e-mail or on the Web  The size you choose for images displayed 
on a computer screen is determined by the size, settings, and resolution of the 
monitors on which the image will be viewed (unlike for images you are print-
ing). It is important to make sure that the pixel dimensions of your image are 
no larger than absolutely necessary for comfortable viewing. The only result of 
making a file any larger than necessary is slow download times or rejection by 
the receiving e-mail server.

People can change the resolution of their monitors to just about any of the 
following resolutions, regardless of the size of their monitors. However, for 
best readability of text, monitors most likely are set at a given resolution based 
on the size of the monitor. For example, monitors in the 12-inch to 14-inch 
range generally display 640 pixels horizontally and 480 vertically (640 x 
480). Fifteen-inch to 17-inch monitors are generally set to 800 x 600 pixels. 
Nineteen-inch monitors generally display 1024 x 768 pixels. Larger monitors 
can display different numbers of pixels, such as 1280 x 1024 pixels. 

If you have a Web site, and you size an image as 640 x 480 pixels, the image 
will fill the screen of a 13-inch monitor. Likewise, it will fill the screen of a 
15-inch monitor that is set at 640 x 480; however, the pixels—and therefore the 
image—will appear to be larger on the 15-inch monitor than on the 13-inch 
monitor. But if the 15-inch monitor is set at 1024 x 768 pixels, the pixels that 
make up the image—and therefore the image itself—will appear smaller. 

Today, Web designers generally plan for a screen size of 800 x 600 pixels as the 
most common denominator, which works for most monitors. 

To size an image for online display, make a copy of the finished image, and then 
change the size of the copied image to fit the screen. Set a size that will display 
the image without crowding out the browser controls or the rest of the Web page 
elements. For example, to size a picture to fit one-fourth of the total screen area 
of a 13-inch monitor set to 640 x 480 pixels, set the size at 320 pixels wide. 

Also remember that older computer monitors have a resolution of only 72 dots 
per inch (dpi) while newer monitors have a resolution of 96 dpi. So again, a 
high-resolution image does not necessarily mean a higher viewing quality on 
computer monitors. 

To size images for e-mail messages, the same principles apply, but remember 
that some e-mail services set a maximum limit on the size of embedded or 
attached files. The larger the picture, the larger the file size. As a general 
guideline, you can size images between 325 and 400 pixels wide, at medium to 
low compression, to have an acceptably sharp image and size within an e-mail 
message.
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8 Sharpen the image.  In many image-editing programs, sharpening increases 
the contrast of pixels around the edges of objects to increase the image 
definition or sharpness. You must be very careful not to overdo sharpening. 
Oversharpening produces a white or light-colored “halo” along highly contrast-
ing edges, resulting in a look that is harsh and unnatural. Since tasks such as 
cloning objects into an image affect the edges in the final image, sharpening 
is best done as a last step. More important, the original sharpness of an image 
is likely to diminish when the image is resized because the program has to 
“guess” at which pixels to add or delete. So it’s best to sharpen the image after 
all the retouching and scaling have been done.

An unsharpened image. Sharpening improves the image.

Also, the results of sharpening can vary between printed images and screen 
display. Experiment with your image-editing program to see what amount of 
sharpening works best for printed images and on-screen images. If you are 
going to print or output the same image to different destinations, make sure 
the sharpened image is a copy of the original that has been scaled to the final 
output size. Remember, never sharpen the original image.  

How a histogram can help
If your scanner or digital camera offers the option of viewing an image’s 
histogram (a snapshot of the tonal range of an image), you can tell from the 
histogram whether the image has enough detail in a given area to make com-
puter corrections. The y (or vertical) axis of the histogram shows the number 
of pixels assigned to any given brightness value. The histogram shows shadow 
(darkest) pixels on the left, midtones in the middle, and highlight (lightest) 
pixels on the right. The x (horizontal) axis shows the distribution of pixels from 
dark to light throughout the image. 

From Personal 
Experience
To make the most of 
your time in the digital 
darkroom, here is my 
personal advice:

  In a series of similar 
pictures, choose the 
picture with the best 
exposure, and work 
on it. Others in the 
series can be ignored 
or worked on as you 
have time. 

  Keep the original 
image open beside 
the image you’re 
working on so you 
can track your 
progress and the 
changes you make as 
you work. 

  Have a well-
corrected picture 
open or near the 
computer and refer 
to it as you work. 
It’s easy to look at a 
picture so long that 
you lose a ‘reference’ 
point for the color 
correction you want 
to achieve. 

 Save your work often. 

  Back up your pictures 
on CD or other 
removable, secure 
media.
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A high-key, or light, image will have the highest level of pixels on the right. A 
low-key, or dark, image will concentrate pixels toward the left. An average-key 
image will have the highest values toward the middle of the histogram. As you 
shoot, check the histogram to ensure that you have a large area of detail and 
good distribution across the range to make corrections later. 

If your picture does not have a good tonal range, you’ll generally want to edit 
the image to distribute the tones as evenly as appropriate for the type of image 
you’re working with.

Final advice
With this process, you should be well on your way to getting sparkling images 
that you’ll be proud to share and print. Keep in mind that you can overdo 
adjustments so that the final image looks unnatural. When making adjustments, 
try to remember the original scene, and then match your image to the colors 
and tonal range you remember. The first pictures you correct will be the most 
time consuming, but as you get the hang of it, you’ll find you spend less time at 
the computer and more time shooting.
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importing to Digital Image Library  
108

opening pictures from  14
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enhancing filters  251
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colors. See also painting pictures
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blending  74
digital camera tips  220
gradient color sampling  73
Magic Wand  67
mats  86
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monitor quality settings  172
photography tips  237
print lifespan ratings  102
red eye  41
scanning  164
text  31
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white balance  40, 141, 220
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color management, printer  101
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checklist  250
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compressed air  163
compressing files  125, 168
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contrast

ambient light  175
correcting  39
monitor adjustments  174
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converting bit depth  164
converting file formats  118
copying original versions  95
copying pictures. See scanners
copying picture features

blending brush  74
clone brush  73
Edge Finder  66

copyrights  21
CorelDraw files  16
Create a Project button  26
creativity, evaluating  200
cropping pictures  43, 64
currently open pictures  28
customizing picture viewing  111
cutting picture features  66
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dark pixels  45, 52
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grouping pictures by  114
viewing pictures by  111

daylight  132
default color quality setting  173
default photo editor  117
depth of field  136, 185

maximizing  252
reducing  250

detecting compatibile media  13
device compatibility  13
Diffuse Glow filter  147
digital cameras

action shots  144
automatic modes  142
battery life  129
blown highlights  223
burst mode  146
close-ups  143
colors  220
compression  125
file formats  126
flash  130, 224
focus  221
manual settings  133
opening pictures from  14, 17
overview  122
panoramic  148
photography tips  150, 219
portraits  147
removable media  128
repetitive patterns  225
resolution  123, 224
self-timers  149
sensitivity setting  140, 181
zoom  127
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Digital Image
file formats supported  16, 96, 126
installing  3

Digital Image Library
adding pictures  108
archiving pictures  116
editing information  115
editing pictures  117
folders  111
grouping pictures  114
keywords  110, 112
opening  107
overview  107
photo editors  117
printing pictures  99
Selection Preview pane  115
Thumbnail pane  113
viewing pictures  111

Digital Image Tour  34
digital photo card readers  14
digital zoom  127
digitizing prints. See scanners
discolored prints  102
displaying. See viewing
display adapters  174
distortion brush  75
dpi (dots per inch)  164
drawing (artwork) effect  69
drivers  100
DRW files  16
dust  50, 162
DVDs

importing to Digital Image Library  
108

opening pictures from  14
DXF files  16
dynamic range  166

E
e-mailed pictures  20, 98, 164
edge effects  85
Edge Finder  66
editing pictures. See also objects; special 

effects
blending  74
brightness  39
contrast  39
cropping  43
distorting  75
erasing  49
gradient colors  73
histograms  45
image-editing programs  233
Mini Lab  79, 118
opening  13
photo editor  117
red eye  41
selection tools  63
text  31
textures  73
tint  40
touchup tools  39
workspace area  27, 171

editing picture information  115
Edit Multiple Pictures button  25
emboss filter  69
EMF files  16
enhanced resolution feature  127
enlargements, ordering  103
enlarging picture features  75
EPS files  16
erasing picture features  49
evaluating photo quality  194
EV setting  156
expanding screen viewable area  172
exposure

bracketing  251

meter readings  252
multiple  252

exposures  52, 133, 151, 189, 197
exposure compensation  135, 151, 156
eye redness  41, 131

F
f-stops  136, 183, 185, 189
facial expressions  239
facial touch ups  51, 73, 147
fade-resistant paper  102
fade ratings  102
Files palette  28
file browser  14, 25
file compression  125
file formats supported  16, 96, 126
file format conversions  118
file management options  118
file size  123
file transfers

archiving  116
importing  13

fill flash  132, 250
films

brands  251
choosing  251
ISO  251
negatives  251

film cameras
action shots  144
aperture  136, 183
automatic exposure  134
automatic modes  142
burst mode  146
close-ups  143
exposure  133
exposure compensation  135
ISO setting  140, 181
overview  133
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panoramic  148
photography tips  150
portraits  147
self-timers  149
shutter speeds  138, 187
white balance  141

film protection in cold weather  227
film scanners  162
film speeds  140, 181
filter-enhanced pictures  69
filtering lighting colors  40
filtering pictures by

dates  111
folders  111
keywords  112
thumbnails  113

filters
enhancing  251
polarizing  251, 252

finding pictures. See locating pictures
Fix Red Eye tool  41
flash  41, 52, 130, 224
FlashPix files  16
flatbed scanners

cleaning  163
opening pictures from  19
overview  161

flattened PNG files  97
flattening objects  62
flat opaque objects, scanning  161
Flipbook animations  146
floppy disks  14, 128
focus, sharpening  197, 221
folders

grouping pictures by  114
viewing pictures by  111

fold styles, card  89
fonts  31
formats supported  16, 96, 126

formatting text  31
format conversions  118
foul-weather protection  252
FPX files  16
frames, adding  86
freehand brush  71
freehand tool  65

G
GIF files  16
glossy paper  102
gradient color sampling  73
graininess  140
graphical control screens  174
gray area, workspace  28
gray card  252
green values  174
greeting cards  89
grouping objects  61
grouping pictures  114

H
half-fold cards  89
hand-created artwork effect  69
hard drive, opening pictures from  14
Help links  26
Help resources  32
Hide button  27
hiding screen items  114
high-color quality settings  172
high-contrast images  247
high-quality printer settings  101
highlighted edges  85
highlights  45
high resolution pictures  101
high resolution scanning  164
histograms  45
historical information. See Digital Image 

Library

holiday cards  89
Home Publishing files  16
hot spots  224

I
ideas, discovering photography  207
identifying pictures  110
image-editing programs  233
images

high-contrast  247
low-contrast  247, 248
multiple-exposure  252

image cleaning tips  163
image sensors  124, 140, 189
importing pictures  13, 108
incandescent lights  40
index, online Help  33
information, picture. See Digital Image 

Library
ink drying time  174
ink options  102
Installation Wizard  4
installing Digital Image  3
Instructional Videos  35
Internet, opening pictures from  21
interpolation  127
invitations, personalized  89
irregular shapes  65
isolating picture parts. See selection 

tools
ISO setting  140, 181
italic formatting  31

J
JPEG files  16, 62, 96, 123, 168

K
keywords

grouping pictures by  114
overview  110
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viewing pictures by  112
Keyword Painter  110
Kodak Photo CD files  16

L
landscapes  251, 252
larger print sizes  101
large picture scanning  165
layers. See objects
LCDs  157
lenses, cold weather and  227
library. See Digital Image Library
lifespan ratings, print  102
light

side lighting  248
lighting

adjust levels tool  45
ambient  175
aperture  136, 183
automatic exposure  134
backlighting  53
blown highlights  223
bracketing  135, 156
colors  40
dark area adjustments  52
evaluating  199
exposure compensation  135
film speed  140, 181
flash  130, 224
incandescent  40
overview  133
photography tips  235
problems  39
red eye  41, 131
room conditions  175
shutter speed  138, 187
tips  153, 189, 223
white balance  40, 141, 220

light pixels  45, 53

linking objects  60
locating pictures

Digital Image Library  107
file browser  14
overview  13
TWAIN support  17
WIA support  17

locations, selecting photography  207
locked objects  58
long exposure shots  149
lossless compression  125
loss prevention  116
low-color quality settings  172
low-contrast images  247, 248
low-quality printer settings  101
low resolution pictures  20, 101
low resolution scanning  164
LZW compression  168

M
Macintosh PICT files  16
macro

shots  252
macro mode  143
Magic Wand  67
manual camera settings

aperture  136, 183
automatic exposure  134
exposure  133
exposure compensation  135
ISO setting  140, 181
overview  133
shutter speeds  138, 187
water glass analogy  134
white balance  141

manual Digital Image setup  3
manual Import Pictures Wizard starts  

14
marquee tool  64

mats, adding  86
maximum print sizes  123
media, storage  13, 128
memory cards or sticks  128, 224
memory considerations  164
menus  27, 32
meter reading  252
microdrives  128
Micrografx Designer files  16
middle gray  134
midtones  47
miniature storage cards  128
Mini Lab  79, 118
MIX files  16
moiré  225
monitors

24-bit vs. 32-bit color  173
ambient light  175
brightness  174
calibrating  171
color quality settings  172
contrast  174
overview  171
preserving settings  175
resolution  171
RGB values  174
VRAM  173

month, viewing pictures by  111
More Files button  26
mosaic effect  69
motion photography  144
moving picture features  59
MSN Photos Web site  103, 179
multimedia cards  128
multiple

keywords  110
objects edited  61
objects flattened  62
objects selected  60
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pages scanned  161
pictures edited  79, 118
pictures printed  100
pictures selected  115
pictures taken in succession  146
picture versions  95

multiple-exposure  252
My Pictures folder  108

N
naming batches  118
naming pictures  110
natural facial expressions  239
natural light  40
negatives, scanning  161, 166
noise  140, 251, 252
numbered lists  31
number of pixels  123

O
objects

combining  60
consistently colored areas  67
displaying separately  57
Edge Finder  66
flattening  62
freehand tool  65
grouping  61
handles  59
locked  58
marquee tool  64
moving  59
multiple selected  60
overview  57
preserving layers  62
selection tools  63

object tool  59
odd-sized pictures, mats for  86
one-month calendars  91

one-week calendars  91
online auction photos  229
online Help  32
online print and gift ordering  103
online tutorials  35
opaque objects, scanning  161
opening pictures

cameras  17
e-mail  20
file browser  14
overview  13
photo editor  117
scanners  19
troubleshooting  18
TWAIN support  17
Web pages  21
WIA support  17

opening Startup Window  25
Open from Camera button  25
optical zoom  127
ordering prints and gifts  103
organizing pictures. See Digital Image 

Library
outdoor photo sessions  207, 212, 227, 

241
outside edges, photo  85
overcast conditions  249, 250, 251
overexposure  53, 133
overriding automatic exposure setting  

135
ozone  102

P
painting (artwork) effect  69
painting pictures

blending  74
distorting  75
freehand  71
gradient color sampling  73

rubber stamp effects  71
texture sampling  73

panoramic
shots  249

panoramic photography  148
paper options  102
partial picture selections. See selection 

tools
parts of pictures. See objects
PCD files  16
PCT files  16
PCX files  16
PC Paintbrush files  16
permanent object links  62
personalized cards  89
photo. See photo quality; pictures
photographic prints, scanning  161
photography basics  180, 212, 235
photography subjects and locations  207
photo card readers  14
photo editors  117
photo paper options  102
photo projects  89
photo quality

aperture  136, 183
automatic camera modes  142
automatic exposure  134
compression  125
evaluation checklist  194
exposure  133, 151, 189
exposure compensation  135, 151
file formats  126
film speed  140, 181
flash  130
lighting  189
long exposures  149
manual camera settings  133
minimizing noise  251
overview  121
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red eye  41, 131
resolution  123
self-timers  149
shadows  132
shutter speeds  138, 187
storage media  128
story telling  199, 203
tips  150, 179
water glass analogy  134
white balance  141
zoom  127

PHP files  16
pictures. See also photo quality

archiving  116
color effects  70
editing  117
filter-enhanced  69
formats supported  16, 96, 126
grouping  114
identifying  110
importing  13
opening  13
ordering prints and gifts  103
organizing  107
resizing  29
scanning  161
text  31
viewing  111

pixels
cropping  43
histograms  45
interpolation  127
noise  140
overview  122
picture resizing  29
print sizes  101
resolution  123, 164
scanning  162

playback mode  223

PNG files  16
PNG Plus files  62, 96
portrait photography  85, 147
positioning camera and subjects  150
precise editing. See also objects; special 

effects
blending  74
distorting  75
gradient color sampling  73
texture sampling  73

preserving monitor settings  175
preserving object groups  61
preserving object layers  62
previewing scanned images  168
printers

color management  101
drivers  100
options  102
quality settings  101

printing pictures
alignment on page  99
cropping  43
lifespan ratings  102
maximum sizes  123
multiple images  100
paper options  102
quality settings  101
resolution  123
single image  99
size  101
 Digital Image   99

prints, ordering  103
product tours  34
program modes. See automatic camera 

modes
projects, creating photo  89
proportional cropping  43
proportional resizing  59
PSD files  16

Q
quality enhancements. See editing 

pictures
quality ranges, printer  101
quarter-fold cards  89

R
RAM  164
ratings, grouping by  114
RAW mode  221
real life photography  209
rearranging objects  28
rechargeable batteries  129
rectangles  64
reducing photo size  125
red eye  41, 131
red values  174
reinstalling Digital Image  5
reminders, archive interval  116
removable media  128
removing

blemishes  50
Digital Image  5
picture features  66
scanner dust and scratches  162
spots  50
wrinkles  51

renaming batches  118
reordering objects  57
repetitive patterns  225
resizing

batches  118
Digital Image workspace  171
picture cropping  43
picture features  59
picture size  29
thumbnails  112

resolution
adjusting  171
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cropping  43
digital cameras  224
e-mail quality  20, 98
monitor color settings  173
optimal  166
overview  123, 164
picture resizing  29
print size  101
recommendations  168
scanners  161
Web quality  98

RGB values  174
room lighting conditions  175
rotating picture features  59
rubber stamp effects  71
rule of thirds  43, 154

S
safety precautions, photography  227
sampling picture features

blending brush  74
clone brush  73

saving pictures  95
scanners

automatic enhancing  168
batching  167
bit depth  164
cleaning  163
dynamic range  166
film  162
flatbed  161
large pictures  165
multi-page scanning  161
opening pictures from  19
optimizing performance  168
overview  161
preparing pictures for  163
previewing image  168
purchasing  166
resolution  164, 166

speed  167
TIFF format  168
types  161
USB  166

Scan a Picture button  25
scratch removal  162
screen settings

ambient light  175
brightness  174
color adjustments  174
color settings  172
contrast  174
overview  171
preserving settings  175
resolution  171
RGB values  174
viewable area adjustments  172
VRAM  173

searching online Help  34
Selection Preview pane  115
selection tools

described  28
Edge Finder  66
freehand  65
Magic Wand  67
marquee  64
object  59
overview  63

self-timer features  149
sending prints or gifts  103
sensitivity camera setting  140, 181
sepia tones  70
series, photo  146
setting

white balance  251
shadows  45, 132, 248
sharpening pictures  69
sharp prints  101
showing screen items  114
Show button  27

Show on startup checkbox  26
shrinking picture features  75
shrinking picture to show edge  85
shutter lag  144
shutter priority mode  139
shutter speeds  138, 187
side lighting  248
single picture printing  99
size

batches  118
Digital Image workspace  171
e-mails  98
file compression  125
flattened PNG files  97
odd-sized pictures, mats for  86
picture cropping  43
picture features  59
picture resizing  29
prints  101, 123
storage media  128
text  31
thumbnails  112

skewing picture features  75
skin touch ups  51, 73, 147
slides, scanning  161, 166
SLR (single-lens reflex) cameras  133
smaller print sizes  101
small aperture  136, 183
SmartMedia card  128
Smart Erase tool  49
smearing picture features  75
snapshots, scanning  161
soft edge effect  85
special effects. See also objects

colors  70
filters  69
freehand  71
stamps  71

speeds, scanner  167
splotchy color  125
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spots, removing  50
Stack  28, 57
stained glass filter  69
stamps, painting with  71
Startup Window  25
static electricity  163
still life photography  209
storage media  13, 128
storing information. See Digital Image 

Library
story telling with photography  199, 203
stretching picture features  59
subjects, selecting photography  207
sunlight  132, 249
sunsets  252

T
table of contents  33, 114
tabs  32
technical support  35
temperature changes, cameras and  227
temporary object links  60
text, adding to pictures  31
texture sampling  73
TGA files  16
thumbnails

Files palette  28
objects  57
rearranging order  28
resizing  112
viewing options  113

Thumbnail pane
grouping pictures  114
hiding/showing items  114
Selection Preview pane  115
view options  113

thumbnail slider  112
TIF files  16, 96
tiles view  113
time

archive intervals  116
monitor calibrations  174
print lifespan ratings  102
shutter lags  144
viewing pictures by  111

tint adjustments  40
tonal range  45
toolbar  27, 31
touching up pictures. See editing 

pictures
touchup tools  39
tracking information. See Digital Image 

Library
transferring files

archiving  116
importing  13

transparency adapters  161
tripod substitutes  149
tutorials  35
TWAIN  17
twilight  249
two-dimensional scanning  161

U
underexposure  133
ungrouping objects  61
unlocking objects  58
unprintable card areas  89
upgrading Digital Image  5
USB connectivity  166
USB Mass Storage Class devices  14

V
vertical formats  250
video adapters  174
Video player  35
viewable area, screen  172
viewfinder  251
viewing pictures by

dates  111

folders  111
keywords  112
overview  111
thumbnails  113

viewing picture information  115
viewing thumbnails  113
virtual drives  14
VRAM (Video RAM)  173

W
water glass analogy  134
weatherproofing camera gear  227
Web pages, opening pictures from  21
Web quality resolutions  98, 164
Web site photography articles  179
weight ranges, paper  102
Welcome to Digital Image Library 

window  108
white area, canvas  28
white balance  40, 141, 220, 251
WIA  17
wide aperture  136, 183
Windows Bitmap files  16
Windows Metafile files  16
winter photo sessions  227
wizards

Archive Pictures  116
Import Pictures  13
Installation  4

workspace area  27, 171
wrinkles, removing  51

Y
year, viewing pictures by  111

Z
zoom  127, 228
zoom lens  250








